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1. Introduction



11. Product evolution

The OfficeMaster Suite is an enhanced
logical development of the communication

classic “ferrariFAX” from Ferrari electronic.

With the product “ferrariFax” and the first
intelligent fax card, Ferrari electronic
detached the classic fax from fax machines
as early as 1987 and integrated it into
company networks.

In the vyears that followed, many deep
integrations were created both in telephone
systems (e.g. Avaya, Mitel, Auerswald),
groupware (e.g. Microsoft Exchange or Lotus
Notes) and in third-party systems (e.g. SAP,
Microsoft 365).

With the announcement of the
discontinuation of the ISDN telephone
standard in 2016, Ferrari electronic AG

already had the next technology available to
communicate directly on the new SIP trunks.

11. Product evolution

DirectSIP became an integral part of the
OfficeMaster Suite and enabled for the first
time - as a pure software solution - the
legally compliant exchange of documents in
IP networks.

As the next milestone, Ferrari electronic
introduced “Next Generation Document
Exchange - NGDX” in 2019, the next
generation of document exchange. With
NGDX, the classic fax was freed from the last
shackles of the “old” technology.

The classic fax became a digital document!

This document is no longer a 200dpi b/w
image, but a full color, searchable and
archivable PDF document that is fast
(approx. 150 pages per minute), dual
encrypted (both transport via TLS and the
document) and legally secure via a qualified
transmission report.



1.2. Office Master Suite 8

In version 8 of the OfficeMaster Suite, the
focus is on the one hand on robustness of
the IP worlds and the integration of new and
expanded communication channels into the
existing infrastructure without changing the
usual work processes or workflows. On the
other hand, in the optimal preparation of
received and sent documents for the new
requirements of the digital working world.

The core features of OfficeMaster Suite 8
include:

- Extended web interface for connecting
3rd party systems, e.g. electronic mail
letter (E-Postbrief in Germany)

- Integrated OCR (Optical Character
Recognition) on incoming documents

- Sending X invoices on the Peppol
network

- Integration with Microsoft Dynamics
365 CRM

- Document dispatch via cloud relay

1.21. Requirements

For detailed information on the
requirements, please refer to the
OfficeMaster Suite 8 data sheet. The

following table provides an overview of the
system requirements:

Parameters Value

Windows Server
2016/2019/2022

1.2. Office Master Suite 8

Parameters

Value

supported
operating systems
(server)

supported
operating systems

Windows 10 and

. Windows 11
(client)
min. number of 5
CPUs
min. main memory | 8GB RAM
min. hard drive
. 80GB SSD
capacity
Landline SIP trunk or ISDN
connection (OfficeMaster Gate)

Virtualization

ESX or Hyper-V

Depending on the scaling (>30 simultaneous
fax channels), more CPUs and more RAM are

required.

1.2.2. New functions

The following sections describe the essential
functional enhancements that have been
the OfficeMaster

implemented in
Version 8.0.0.

Suite



Better support for cloud
installations

Customers are increasingly installing the
OfficeMaster Suite for cloud usages (mostly
using the Azure Marketplace offer). In this
scenario, a SIP trunk, Microsoft 365 (Azure
AD, Exchange Online) and possibly a CRM are
connected. The entire environment runs in
the cloud.

To better support such use cases, a new
browser-based configuration utility was
created, a Web APl connector was added,
and  improvements were made to
AuthGateKeeper.

The configuration program can be accessed
from https://{msgSrvHost}/cfg. The new
configuration program does not support
functionalities that do not make sense in a
cloud environment (e.g. Notes, ISDN gateway
search, SAP). There are functionalities in
other areas (e.g. log analysis, dashboard)
that go beyond the previous configuration
program. Since the web-based configuration
program cannot yet register apps in Azure
AD, It is considered a technical preview. The
documentation for Web API Connector can
be found in https://{msgSrvHost}/webapi/
v2/doc/ (the Web API component must be
running).

Adaptation to changes in the IT
landscape

The Exchange Online Connector has been
completely redesigned to accommodate

1.2. Office Master Suite 8

Microsoft's originally targeted September 30,
2022 shutdown of Exchange Web Services
(EWS) app registration. The new Exchange
Online Connector uses the Graph API with
OAuth 2.0 authentication. Support for
Windows Server 2022 and Office 2021 is
provided with OfficeMaster 8.0.0 as well as
support for Windows 11 clients.

Improvements for fax
transmission

With the integration of Tesseract in addition
to the B&L OCR engine, the OCR function is
now available to all users of the OfficeMaster
Suite without additional license costs. By
default, if Tesseract is found on the system
and the OCR functionality is switched on, all
incoming documents will be provided with a
text layer, allowing users to easily extract
text (e.g. cut & paste).

An additional NGDX operating mode allows
file transfer via a cloud relay operated by
Ferrari electronic AG. The documents are
broken down into pieces (shards), these are
individually encrypted with a symmetric key
and the key exchange with the recipient is
encrypted again on the telephony route.

A line test function has been implemented.
When a special number is called, an
operating mode is adopted in which all
modem operating modes are carried out and
transmission errors are counted. As a result,
the user receives a PDF file with an error
report.

Sending faxes in geographically large VPNs
with poor quality of service or high latency
(round-trip time) is now possible if SIP2 and
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the fipMediaServer are used. Thereby the
media server should be placed close to the
telephone connection/SIP trunk and the
central messaging server will be able to
control the fax workflow even over relatively
“bad”  connections. This allows SIP
environments to increase the independence
of the quality of the network from the
OfficeMaster Gate-based solutions.

The robustness of the fax stack against
carrier losses due to packet losses on VolP
routes has been increased.

New transmission paths

The E-POST letter and the X-Invoice were
added as order types and their transmission
is supported by new sending components.

In combination with the web APl component,
faxes, SMS, print jobs, letters and X invoices
that can be sent from an ERP or CRM system.
Various scenarios are implemented here
after the release. The first will be the
connection of fax, SMS, letter, X-invoice to a
Dynamics 365 via the new web API connector
of an OfficeMaster Suite from the Azure
Marketplace.

Operational improvements

OfficeMaster Suite 8 includes the option of
emptying (draining) the server. No new
orders will be accepted, but orders that are
already being processed will still be
processed. On the one hand, this helps with
maintenance work or with a server move. On
the other hand, the server also goes into
drain mode if (configurable) an important

SIP trunk fails or the connection to a mail
system (e.g. Exchange Online) is interrupted.

An SNMP plugin for the Windows SNMP
service was created for server monitoring
and the OfficeMaster Suite was expanded to
include a large number of counters.

Each component configuration dialog has a
contextual online help page.

Internal changes

The unique ID (UID) of the job files used to
be 32 bits long. This could lead to collisions
when job files were migrated from one
messaging server to another (e.g. update,
server move). In version 8, the UID was
extended to 64 bits and a process for
migrating from 32-bit UIDs to 64-bit UIDs was
implemented.

The same library for regular expressions
(PCRE2) is used everywhere in OfficeMaster
Suite 8. From the user’s point of view, the
same regular expression syntax is finally
used everywhere. For backwards
compatibility, some expressions are now

modified on load.

In individual cases (redundant dispatch
routes), the calculated job routing in
previous versions could depend on the start
order of the transmit components operated
in parallel. Since this could vary from start to
start (race), the routing was correct in these
cases, but not deterministic. OfficeMaster
Suite 8 solves this problem by being able to
assign  routing priorities.  This
deterministic routing to be established.

allows
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The OfficeMaster Suite 8.0.0 is built with
Visual Studio 2022 and uses .Net Framework
6.

1.2.3. Removed or no longer
supported features

ISDN interfaces on OfficeMaster Gates
continue to work with OfficeMaster 8.0.0, but
are no longer recommended for new
configurations. The same applies to jcsim,
whose use cases can be adopted by
DirectSIP’s loop mode of operation.

The old converter conv was already replaced
by cmdconv in OfficeMaster 7; this time it
was completely removed in version 8.0.0.

OfficeMaster Suite 8 supports three SMS
sending methods:

- Landline SMS via DirectSIP (or
omcums)

- GSM modem with LAN interface (AT
commands via TCP) e.g. ConiuGo

- Provider SMS via SMPP

The other SMS variants (UCP, web interface,
modem via UART, etc.) are either outdated or
cannot be used in virtualized environments
and are therefore no longer recommended.
For updates from existing customers,
however, the function will still be retained in
OfficeMaster 8.0.0.

The OfficeMaster GateConfig, which s
required to configure OfficeMaster Gates, is
no longer part of the OfficeMaster Suite.
Customers who still use ISDN can install
them separately.
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2.1. NGDX, Fax, Voicemail and SMS

The OfficeMaster Suite is a communication solution for use in heterogeneous computer
networks. With the OfficeMaster Suite you can send and receive Documents and messages
electronically as NGDX, Fax, SMS and E-mail attachments.

NGDX, fax and SMS messages can be sent and received via ISDN or
via IP networks (mixed environments are supported).

The voicemail solution integrated in the OfficeMaster Suite takes calls and sends an e-mail to
the respective mailbox of the user with the recording as an attachment.

For all functions, special attention is paid to the integration of OfficeMaster into the existing
environment.

The OfficeMaster Suite provides special connectors for Microsoft Exchange Server,
Exchange Online / Microsoft 365, Notes/Domino Server and SAP. It also serves
customers without a mail system with an integrated web client for the users.

The following table compares the individual connectors of the OfficeMaster Suite. Features
marked as optional can be extended by additional software licenses or hardware to extend the
respective main product.

Table 21: OfficeMaster Suite product overview

General properties

SMTP Exchange  Notes SAP Web\ Connector
. ) SAP .
User Proprietary, Active Name and Lser Proprietary (SQL),
Management | LDAP Directory Address Book base using the AD users
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Fax features

SAP Web
SMTP Exchange Notes .
(optional) | Connector
Microsoft AP
Fax dispatch | mail client Outlook, OWA, | Notes client Web Client
R frontend
mail client
Microsoft AP
Fax Reception | mail client Outlook, OWA, | Notes client Web Client
I frontend
mail client
Anonymized Anonymized Anonymized Anonymized
circular fax circular fax circular fax Depending | circular fax
Bulk Fax and and and on SAP and
personalized | personalized | personalized |application | personalized
serial fax serial fax serial fax serial fax
Local Fax Calling Calling
Printer Driver | Microsoft Microsoft Calling Notes | - Web client call
(Windows) Outlook Outlook
Fax retrieval ISDN ISDN ISDN ISDN ISDN
Central
conversion of
Yes Yes Yes Yes Yes
file
attachments
File-based
S Yes Yes Yes Yes Yes
job interface
Print-based Line Printer Line Printer Line Printer Line Printer |Line Printer
job interface | Daemon Daemon Daemon Daemon Daemon
Connection to
network Yes Yes Yes Yes Yes
scanner
Character ) )
. Line Printer . ) . )
recognition optional optional optional optional
Daemon
(OCR)
Electronic fax
signature optional optional optional optional optional
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SAP Web
SMTP Exchange Notes .
(optional) | Connector
(mass
signature)
Short Messages/SMS
Web
SMTP Exchange Notes SAP
Connector
Optional Landline , Landline Landline .
. . Landline SMS, SMS Landline SMS,
transmit/receive | SMS, SMS . SMS, SMS SMS, SMS )
. via SMPP . . SMS via SMPP
hardware via SMPP via SMPP via SMPP
) Outlook,
Sending and L 4 Notes SAP .
o mail client | MicrosoftOutlook ) Notes Client,
receiving SMS client frontend .
Mail Client
interface for
. console console console console
alerting/ rogram console program rogram rogram rogram
monitoring prog pros prog prog
Split more than
160 characters
. ) Yes Yes Yes Yes Yes
into multiple
messages
email
Web
SMTP Exchange Notes SAP
Connector
. . Network Network Network SAP Network
E-mail delivery o o o .
Printing (lpd) | Printing (lpd) | Printing (lpd) | frontend | Printing (lpd)
E-mail receipt SAP
—_ | I - — - —
P frontend
Automatic ZIPing of
- - - Yes -
attachments
Electronic signing of . . . : :
optional optional optional optional | optional
attachments
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Voicemail
Web
SMTP Exchange Notes SAP
Connector
Voicemail dispatch Email Email Notes client - Web Client
Voicemail Quer PC and PCand PC and PC and
y Telephone Telephone Telephone Telephone
Message Waiting
. Yes Yes Yes - Yes
Indication

211. 1P and ISDN connection

OfficeMaster Suite is installed on a network computer running Microsoft Windows and provides
users with fax, SMS and voicemail communication services. For this purpose, ISDN/IP interfaces
are used from the existing telephone system or directly from a telephone service provider.

For the ISDN/IP connection, Ferrari electronic AG offers with OfficeMaster Gate offers a product
range, which consists of professional ISDN/IP\ hardware in different configuration levels. SIP
trunks and IP\ telephone systems will have a direct connection (DirectSIP) and therefore
recommended without additional hardware or middleware.

Short messages are sent and received as standard fixed-network text messages via the
available existing SIP trunks or ISDN connections. Since fixed line SMS from some providers via
call-by-call is not supported, sending and receiving can also be done via an Internet service
provider (via SMPP).

21.2. Integration with Microsoft Exchange Server 2013-2019

OfficeMaster Suite integrates with a special SMTP connector in Microsoft Exchange Server
2013-2019. All communication services are provided with a single connector recorded on any
server within the Exchange organization can be operated. An installation of OfficeMaster Suite
directly on the Exchange Server is under consideration additional installation steps possible.
But mostly thanks of the virtualization possibilities are avoided.

The OfficeMaster Exchange Connector uses the Active Directory Service Interface (ADSI) to access
the Active Directory to read stored user data. All relevant user parameters for fax, SMS and
voicemail are maintained in the Exchange Management console. Already existing AD fields are
used where possible to not need to extend the Active Directory schema.
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Communication between Exchange and the connector takes place via the Simple Mail Transfer
Protocol (SMTP), which is used worldwide as the basis for connecting independent mail clients
to different mail servers. Sent and received e-mails as well as status messages are recorded

transfer. For the personalized answering machine function the Messaging Application
Programming Interface (MAPI) uses, which provides uniform access to mailboxes guaranteed.
For Exchange 2013 - 2019 is used as an alternative to MAPI access to the Exchange Web Services
(EWS) set.

Note!

Since both the Active Directory and the Exchange Server access via ADSI resp. MAPI
and EWS resp. Graph is only granted if certain permissions are available when
starting up OfficeMaster. Please take special care with the service account that
needs to be set the use the connectors.

21.3. Integration with Notes/Domino

OfficeMaster Suite accesses the data stored in the Domino directory user data to all necessary
information for fax, SMS and voicemail for the respective user or user group. To use advanced
options, OfficeMaster reads information from defined Notes fields, whereby these can in turn be
integrated into any masks.

Fax messages are received as Notes mail to the respective assigned mailbox. By converting to
Notes mails are also Functions such as forwarding or retrieving mail-in databases supports.
Outgoing faxes are managed centrally by the OfficeMaster Suite converted with the Notes client.
In this way, all Notes documents can be sent by fax send without the need for user
adjustments. Within Notes, faxes and SMS are treated like e-mails - under Use of all Notes\
mechanisms. So is an integration of Workflow applications can be implemented in the sending
process.

A powerful answering machine is integrated into the computer network for the voice function of
the OfficeMaster Suite. The prerequisite for the use of it is a telephone system, that redirects
incoming calls to the voice server. Received voice messages are sent to the user in Lotus Notes
as Notes mail with an audio file attached. The user can listen to the messages either by routing
them to his phone, through sound card or Play PC speakers or listen to them remotely

21.4. Integration with various SMTP mail systems

The OfficeMaster Suite has the option of sending and receiving messages via SMTP. This means
that every e-mail server can be addressed and provided the appropriate permissions, messages
can be sent to different user mailboxes. One Integration into almost any mail system is
therefore possible with OfficeMaster.
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If a global directory service can also be accessed, the OfficeMaster Suite uses the user
information stored there for the administration of the phone numbers.

Without access to external directory services, both user data and messages can be stored in the
local user memory of the OfficeMaster Suite.

21.5. Integration into SAP R/3, S/4HANA or NetWeaver

Communication with SAP takes place via SAPconnect. This is the uniform communication
interface of SAP AG. SAP connect is based on Remote Function Calls (RFC) over TCP/IP in LAN/
WAN environments.

The OfficeMaster Suite receives the document to be sent via RFC with the associated recipient
list and sends it using from OfficeMaster Gate as a fax or forward it to the e-mail address in-
house email server. If the shipment has taken place, the status reported is assigned back to R/3,
where he was assigned to the Business Workplace located transmission document.

In SAP Version 4.7, SAPconnect was extended to include SMTP as the transfer protocol between
SAP and the communication partners. The send request is not sent via RFC, but via SMTP to
OfficeMaster. OfficeMaster takes care of the dispatch and informs the SAP system via e-mail
about the dispatch status. When starting up OfficeMaster it should be decided, depending on
the installation, whether the RFC interface is to be used or the SMTP interface (the SMTP
interface offers a smaller range of functions due to the concept).

OfficeMaster receives from R/3 for the central conversion of the Fax documents files in the
formats

Printer Common Language (PCL), Postscript (PS) or Portable Document Format (PDF). These will
be converted either with the internal PCL converter, with Adobe Acrobat Reader or with
Ghostscript into a supported bitmap graphics format.

With Connector for SAP, buyers can send orders directly from Materials Management (MM),
sellers can send offers from Sales and Distribution Processing (SD) and accountant notifications
from Financial Accounting (FI) without having to print out the documents beforehand. Through
the complete integration into SAP is the dispatch from almost every SAP application possible.
The business documents are either sent as graphics by fax or as a PDF by email.

Received messages and status reports are stored in SAP Business Workplace. An Alarm from
the Alert Manager (RZ20) can be automated when exceeding or falling below Thresholds.

21.6. Automatic document delivery via NGDX, fax and email

The fax and e-mail function of OfficeMaster can be quickly and easily be integrated via LPD
network printing into an existing ERP or other application programs. For this purpose, a control
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command is integrated once in the form used by the merchandise management or the
application for the printout, which contains the NGDX-, fax number or the e-mail address of the
recipient. The e-mail address of the recipient as it is stored in the master data of the
application. After OfficeMaster has received the document by print, the control command is

interpreted and send control command is interpreted and send job is sent.

Optionally, the document can be provided with an electronic signature before transmission.
After the document has been sent, the sender receives the final status message by e-mail in his
mailbox.

21.7. fax-on-demand server

Most fax machines offer two additional operating modes in addition to normal fax transmission:

- The targeted retrieval of documents that another fax subscriber has provided and
- the provision of documents for retrieval by another Attendees.

During fax polling, the fax number of the subscriber who is known to have provided a document
for polling is dialed. This document is transmitted after the connection is established. With
OfficeMaster, practically any number of documents can be made available for fax polling. Each
of the documents can be reached under a different fax number.

Note!
The fax-on-demand server only works with OfficeMaster Gate.

21.8. Web Connector and Web Services

With the OfficeMaster WebServices, Ferrari electronic AG provides an Interface for your own
applications to use the UM services of OfficeMaster Suite. It is possible to use both a
programming environment and a programming language that standardized protocols XML, SOAP
and WSDL. The WebServices are based on the same basis as the OfficeMaster Suite client. A
separate connector may be required for this.
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2.2. Architecture of the OfficeMaster Suite

OfficeMaster Suite consists of the Messaging Server, which is the basic technology of the
products of Ferrari electronic. This basic technology impresses above all by modularity, load
distribution, robustness, controllability, operating system independence and expandability. The
messaging server is not a single program, but a comprehensive but simple system, consisting of
a series of basic components, which ensure the basic process and operation. The basic
components are supplemented with transmission / reception and Connector components
according to the licenses acquired. Table 2.2 shows the currently available components.

All components communicate with the controller component (CTRL) via the network. To enable
load balancing, components can be started multiple times if they are sufficiently licensed. The
OfficeMaster Suite is configured via the supplied configuration program — Messaging Server
Configuration.

The Messaging Server Configuration can be started on any computer running Microsoft
Windows provided that the computers have network access and an IP connection to the
Messaging Server.

OfficeMaster Suite supports aspects such as Reliability, scalability, regional distribution and
virtualization in addition to its numerous Functionalities through the individual components.

These aspects are briefly described below. A detailed Explanation is beyond the scope of this
manual. Further questions can be answer in www.ferrari-electronic.de by reading the available
whitepapers or by consulting the technical product marketing of Ferrari electronic AG
(hotline@ferrari-electronic.de).
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Table 2.2: Overview of the components

Component

Component Name
Type

Starter (START), Controller (CTRL), Unique ID Server (UID), Configuration
Server (CFG), Distributed File System (SNFS), Converter (CONV), Message
Basic Control Outgoing (SPLIT) and Incoming (DIST), Undeliverable Messages
Components (UNDLVRBL), LUA Interpreter (LUA), Base Converter (baseconv), Advanced OLE
Converter (oleconv), Commandline Converter (cmdconv), Configurations
Proxy (CFGPROXY), Gatekeeper (fgatekeeper)

Sender /
receiver for fax | OfficeMaster Gate (OMCUMS), CAPI connection (JCISDN), DirectSIP (SIP)
and SMS

Sender /
receiver for E-mail sender (SMTPTX), e-mail recipient (SMTPRX)
email

Sender /
Receiver for Voice Server (VOICE)
Voicemail

Connector for
Microsoft UMS connector (MSX2KGATE) and (FMSXBCSGATE)
Exchange

Connector for ) .
, Domino Fax/SMS and Voice Gateway (NOTESCONN)
Notes/Domino

Connectors for . )
, Mail Gateway for Fax and SMS (MAILGW), Gateway for Voice (UNIVOICE)
mail servers

Connectors for

ap RFC connector (SAPCONN),(SAPCONNU), SMTP gateway (SAPSMTP)

Other

File interface (FILEGW), Web-API connector (webapi)
Components

Components

o Automatic printing (PRINTGW), network printing (LPD)
for Printing
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2.21. Reliability / high availability

A unified communications system is part of a complex embedded infrastructure from mail
servers, communication controllers and telephone systems. For assessing the availability of
these Infrastructure, the components must be considered individually and in their interaction.
The OfficeMaster Suite has built-in monitoring routines that check if all required programs are
running. If a program ended unexpectedly, it will be restarted accordingly.

There are installations where both the mail server and the computer on which the OfficeMaster
Suite was installed are designed to be fail-safe and where the Telephone systems are set up as
a fail-safe system network. In such concepts is either a corresponding number of SIP-Trunks
routed to the OfficeMaster Suite, or one or more OfficeMasters Gate are connected to the
telephone systems via ISDN/IP and via a network connection to the computer on which the
Office Master Suite is running.

If OfficeMaster Suite or OfficeMaster Gate fail, they can no longer be addressed by the
telephone system. The telephone system forwards all calls to another controller or server.

2.2.2. Scalability

OfficeMaster Suite consists of a larger number of components, too each of which owns a
configuration set. The components communicate among themselves via a network protocol
(based on TCP/IP), so that they can be installed on different computers.

The distribution on different computers (scalability) avoids Performance bottlenecks, can
increase availability through redundant Structures or can include multiple locations in one
installation.

2.2.3. Cross-site connection

Many companies and organizations are in more than one location active and have several
national or international branches. As a rule, there is an EDP network for these locations, in
which Employees from all locations can access central services and resources via an intranet.

For a unified communications system, it is desirable that its services are available at all
available at all locations and that the know-how for its administration is only maintained at
one central location. However, services such as voicemail and the exchange of documents are
bound to the local telephone systems in the branch, and it is necessary to integrate these
telephone systems into the central office to unify the communication system With OfficeMaster
Gate is this possible in an elegant way.

In each branch OfficeMaster Gate or a remote fipMedia server is connected via ISDN/IP to the
local telephone system (or the office), which is connected to the central OfficeMaster central
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OfficeMaster Suite. The entire system including the OfficeMaster gates is managed centrally. All
the stablished phone numbers will be retained for communication.

2.2.4. Security

The components of the OfficeMaster Suite communicate on the localhost address, so they

cannot be reached from outside. The following components bind server ports (usually after
manual configuration):

component bound ports

IS for WebUI 443, 80
authgatekeeper 3216

smtprx 587, 25

lpd 515

sip 5060+

rtp range UDP 50000-50999

Table 2.3: component types

2.2.5. Job Processing

The OfficeMaster Suite processes jobs that were generated by connected IT systems. The
controller plays the central role. It controls the communication with all components and also
calculates the processing path of each job depending on image format and destination address.

A component can read jobs from its “in” directory if it receives the corresponding job from the
controller. After processing (e.g. file conversion) a new job file is stored in the “out” folder and
the job is passed back to the controller.

The individual component types behave differently in detail:

component type Description

Components required to control job processing, these have already been

base component
created

converter Modifies the image files in a job

Connects the messaging server to an external IT system (Exchange, SAP,

connectors
Notes, ...)
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component type Description

sendrec Sending / receiving component, sending or receiving via
component telecommunications

File In/File Out component, used to integrate external processing steps

foff t
ofi componen (e.g. digital signature)

Table 2.4: component types
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2.3. System Requirements

2.31. Communication interfaces

The messaging server is required to run OfficeMaster Suite Access to the (public) telephone
network, e.g. via a telephone system or a SIP trunk (possibly behind an SBC). Most common is
the connection SIP, in which documents, faxes and voicemails can be sent and received.

service Required communication interface

NGDX, Fax, Landline SMS, Voicemail and Message

. o ) OfficeMaster Gate, SIP Trunk
Waiting Indication via VolP

Internet access of the OfficeMaster

SMS via Internet Service Provider )
Suite Server

Table 2.5: required communication interface

2.3.2. Server “hardware”, operating system and software

Please refer to the current server requirements data sheets.
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3.1. Graph API in Connector for Exchange

Online

The Exchange Web Services (EWS) is an
outdated protocol that is used since
Exchange Server 2007 In August 2018,
Microsoft announced that it would no longer
make any further technical investments in
EWS APIs for Exchange Online. The successor
APl recommended for use is Microsoft Graph.
Microsoft had meanwhile announced that it
would no longer be possible to register EWS
apps in Azure AD from September 30, 2022.
This shutdown of registration has now been
postponed indefinitely into the future, but
will occur in the foreseeable future.

Customers using the Connector for Exchange
Online should migrate to the Graph API with
version 8 before Microsoft discontinues
support for EWS in Exchange Online.

311. What are the benefits of
Microsoft Graph?

Security

Microsoft Graph has tighter security and
governance policies using OAuth and
granular scoping to restrict data access in a
mailbox as opposed to the all-or-nothing
access model in EWS.

Simplifications for developers

Microsoft Graph offers Graph Explorer to
easily and quickly explore and test APIs,
SDKs in various programming languages, and
an active developer community.

Efficiency

Microsoft Graph APIs are REST based while
EWS APIs are SOAP based. Benefits of using
REST-based protocols include faster JSON
serialization and reduced network usage.

31.2. What are the
disadvantages of using
Microsoft Graph?

Compared to EWS, some operations for
searching for several maintained user
addresses are missing. For example, it is no
longer possible to determine a maintained
fax address. Only SMTP addresses can be
read out. This meant that the addressing
procedures of the Exchange Online

Connector had to be adjusted.

The granular assignment of rights makes it
somewhat more difficult for administrators
to determine and set the right set of rights
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for their organization and the respective
application.
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3.2. Web APl component

In previous versions, the file gateway (filegw)
was often used for integration into various IT
systems operated by customers. However,
this approach can only be used in on-
premise environments. As IT landscapes are
increasingly hybrid and cloud usage is
increasing, the Web-API component was
developed. Here, the jobs are not transferred
to the API via a job file in a directory, but as
an HTTPS request. This allows documents to
be sent and received by fax, SMS, e-mail, as
an X invoice and to access printers.

There is an APl for the integration, the
documentation for which can be accessed at
https://{msgSrvHost}/webapi/v2/doc/ (the
web APl component must be running for
this). A test environment for eg. Postman
can be created automatically from the
OpenAPI description.

One usage scenario for the Web API
component is to be able to create Dynamics
365 flows for sending invoices by fax and
letter or as an X invoice.

In the default configuration, the Web API
component is linked to the localhost
address and is addressed via the
AuthGateKeeper (which acts as a reverse
proxy here). Therefore, the AuthGatekeeper's
certificate is also wused for the TLS

connection.

The setup of the Web-API component is
shown again in the “Configuration of the
individual components” chapter. This mainly
involves generating API keys to authenticate
access to the web APl component.
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The E-POST component allows letters to be
sent via Deutsche Post's APIl. PDF files and
address information are transferred here. In
8.0 this function is available via the Web-API
component, in subsequent versions it should
also be possible to generate these orders
from the client (eg. Outlook) via the
appropriate connectors.

The use of the E-POST component requires
registration with Deutsche Post.
Corresponding access data is generated,
which is required to configure the E-POST
component.

There is a test operation to set it up. If this is
active, the document is not printed and

3.3. E-POST component

enveloped, but sent as a PDF file to an e-
mail address specified in the test order.
When connecting to an IT system, it is
recommended to first use this test mode
(which also does not cause any postage
costs).

When connecting letter mail to CRM systemes,
for example, there is a risk of causing
significant  costs by  selecting an
unintentionally large number of recipients.
Therefore there is a parameter to limit the
maximum number of letters to be sent daily
(quota).

The setup of the E-POST component is
described in the chapter “Configuration of
the individual components”.
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3.4. Component for sending electronic
invoices (X invoice)

Peppol (Pan-European Public Procurement OnlLine) is a project that standardizes public
procurement procedures within the EU. Tendering, awarding and payment are supported. For
the latter, electronic invoicing has been standardized as an X invoice.

The X-Invoice format is XML-based and standardized in Germany by the Coordination Office for
IT Standards (KoSIT) on the basis of EN 16931-1. At the time of writing this document, v.2.2.0 was
the current version.

From November 27, 2020, suppliers of the federal government are obliged to issue invoices in
electronic form as part of public contracts. The federal states have their own regulations - while
in some federal states an obligation for suppliers was decreed (e.g. in Bremen on November 27,
2020 or in Baden-Wirttemberg on January 1, 2022), other federal states did not initially stipulate
any obligation for electronic invoicing.

The Peppol network is an association of Peppol providers who exchange electronic documents
(including X invoices) with each other. A list of Peppol providers can be found here.

Addressing in the Peppol network is via the Peppol Participant Identifier (Peppol-Participant-1D).
A distinction is made between sender ID and receiver ID. There are several methods of forming
this unique address. The structure is always there

Prefix:AddressInformation
where prefix specifies the address type and the address information must be unique.

The public sector in Germany uses the routing ID to address the invoice recipient within the X-
invoice. When handing over to the Peppol provider, however, the address is 0204:RoutelD. The
table shows a small selection of the possible addressing methods.


https://www.xoev.de/xrechnung-16828
https://www.xoev.de/xrechnung-16828
https://peppol.eu/who-is-who/peppol-certified-aps/
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Number

Peppol Peppol .
PP Address Type p;.) . Audience

address prefix Participant ID
Invoice recipient federal/state/

0204 Route ID 0204:Route ID L , .
municipal authorities/authorities

9930 VAT ID 9930:VAT ID German companies

Global Location L :
0088 0088:GLN Organizations with GL number

Table 3.1: Peppol addressing method (selection)

The first digits of the Leitweg ID roughly indicate where the invoice recipient is located in the
federal structure of Germany:

- 01 Schleswig Holstein
- 02 Hamburg
- 03 Lower Saxony

- 04 Bremen

- 05 North Rhine-Westphalia

- 06 Hesse

- 07 Rhineland-Palatinate
- 08 Baden-Wurttemberg

- 09 Bavaria
- 10 Saarland
- 11 Berlin

- 12 Brandenburg
- 13 Mecklenburg-Western Pomerania

- 14 Saxons

- 15 Saxony-Anhalt
- 16 Thuringia
- 99 Federal Government

° 991 - direct federal administration or a constitutional body and receives electronic
invoices via the ZRE.
0 992 - indirect federal administration or federal state and receives electronic

invoices via the OZG-RE.

o 993 - indirect federal administration and receives electronic invoices via its own
solution (neither ZRE nor OZG-RE).

If the invoice recipient can be reached via ZRE (central invoice receipt portal) or OZG-RE (online
access law-compliant invoice receipt platform) (route ID 991* or 992*), the Peppol web service of
the federal government can be used. However, this does not forward any invoices to other

recipients.
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A Peppol provider must be selected for a universal connection. A suitable Peppol provider takes
over the routing of the invoices to the correct Peppol access of the recipient.

Note!

The X invoice component has so far been tested with the federal government’s
Peppol web service. This means that compatibility tests with various (chargeable)
Peppol providers are still missing. Therefore, no recommendation for a provider can
be made at the moment.

It is planned to be able to use the X invoice component not only for sending but also for
receiving X invoices in the future.

Instructions for setting up the X calculation component can be found in the chapter
Configuration of the individual components.
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3.5. Line test

With the conversion of the telephone
network from circuit-switching to packet-
switching, a new problem arose for fax
communication: the influence of SBCs and
media gateways on the audio signal. Echo
cancellers, codec translation and audio
healers mainly play a role in connection with
packet loss. The functions can (often) be
controlled by SDP parameters or switched off
for fax communication. However, testing the
line quality has always been difficult and
was usually carried out by analyzing packet
capture files (pcap).

To simplify the setup, the OfficeMaster Suite
8 now has the Line test function. It can be
specified in the rules for processing
incoming calls (inbound routing) that a
phone number should be used for the line
test. If this number is then called by another

Direct SIP component, this connection is
renegotiated into a line test. All you have to
do is send a fax to this number. This can, for
example, be commissioned with the fax test
dialog that is new to the classic messaging
server configuration program.

During the line test, the quality of the
transmission is measured in both directions
as the modem speed increases. At the end,
the statistics are collected on the caller's
side and a report is created. This report is
sent to the person responsible as
confirmation for the fax dispatch.

If all tests are 100% successful, there is a
clear path between both participants - G.711
sample bytes are transmitted unchanged.

Ferrari electronic AG operates a remote
station for the line test on +49 3328 455380.
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3.6. Maintenance State / Drain Mode

Up to OfficeMaster Suite 7 there was the
problem that when the messaging server
service was stopped, jobs could still be
being processed and then remained in the
queue. With a restart (possibly also after an
update) these were of course then
processed. However, when the system was
relocated or reinstalled, the jobs had to be
transferred manually, which can sometimes
involve considerable effort.

In  OfficeMaster Suite 8 there is a
maintenance status or drain mode. The
messaging server is active in drain mode, but
no longer accepts any orders. This means
that the orders already in the system can be
processed and the messaging server runs
empty. Not accepting orders means:

- incoming calls are rejected (SIP error
code Service Temporarily Unavailable),

- Exchange mailboxes are no longer
queried, orders accumulate there.

- SMTPRX no longer accepts
connections.

However, the outgoing function is not
affected by this, outgoing calls can still be
made and messages can be delivered to
users or their mailboxes.

The maintenance state (drain mode) can be
triggered manually in the messaging server
configuration in the “Extras > Maintenance
mode” menu. Then you should give the
system time to process all orders. As soon as
the job status is empty, the system can be
stopped.

There is another use case for the
maintenance status or drain mode. If failure
redundancy is to be achieved through the
parallel operation of two messaging servers
(active/active with e.g. each with their own
SIP trunks), it does not make sense to
continue to forward jobs to this system if
one SIP trunk fails. It can then be configured
that the failure (alarm) of the SIP component
automatically puts the messaging server into
maintenance mode (drain mode). From this
moment on, only orders are routed via the
other system and no jobs accumulate in the
failed system.

In  normal operation with only one
messaging server, the automatic drain mode
can be helpful if you want the jobs to
accumulate in front of the messaging server

and not in its queue.

In  the standard  configuration, no

maintenance state is automatically adopted.
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3.7. Cloud Relay on NGDX transmission

With the OfficeMaster Suite Version 7 the
NGDX procedures were published for the first
time (NGDX - next generation document
exchange). Version 8 now adds Cloud Relay
as a new NGDX method. The key exchange
(via telephone line) is separated from the
file transfer (Internet) in order to achieve
greater security and higher transfer speeds.

The process is as follows:

1. Sender/Telephony: call
2. Recipient/telephony: call acceptance,
NSF CSI DIS
3. Sender/Telephony: checks receiver
capabilities (ECM, BFT, IP)
4. Sender/IP: starts uploading, to that
o Split documents into 256KB
pieces (shards)
o Generate and record AES key
o Encrypt shards
o Make a note of the download
URL
5. Sender/Telephony: Fax retrieval of the
recipient’s X.509 certificate via T.434
6. Sender/Telephony: Certificate check
7. Sender/IP: Upload complete?
o If not: Sender/Telephony: RNR
o Otherwise: transmitter/
telephony: MCF
8. Sender/Telephony: Send T.434 stream,
to do this
o Encrypt JSON document with
URLs and keys of the shards
o Encrypt the AES key of the JSON
document with RSA4096 (public

key from the recipient’s
certificate).
9. Receiver/Telephony: Receive and
extract T.434 stream
o Extract URL list with private key
AES Key and decrypt the list
10. Receiver/IP: Begin downloading shards
11. Receiver/Telephony: As long as the
download persists, send RNR
12. Receiver/IP: decrypt shards, assemble
documents, check hash
13. Recipient/Telephony: If hashes are
correct, confirm documents (MCF)
14. Sender/Telephony: Create feedback for
successful sending

Understanding the process is only necessary
if you want to evaluate the security of the
procedure yourself. The user does not notice
anything about this process, for her it is a
normal (albeit faster) document dispatch. In
particular, users are not burdened with key
management tasks.

The advantages of the cloud relay method
are higher security and higher transmission
speed. The security results from the fact that
a different medium (telephony) is used for
key exchange than for data exchange (IP). An
attacker would have to listen to both media
at the same time. Furthermore, the
document transmission via HTTPS s
transport-encrypted with TLS and the
individual shards are each encrypted with
their own AES256 keys.

The speed gain is significant. A 10 MB PDF
file is transmitted in about 100 minutes via
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fax modem (without using T.38 acceleration),
with Cloud Relay in about 80 seconds (even
without using T.38 acceleration).

A disadvantage of the cloud relay method is
that the messaging server has to establish a
client connection to the cloud relay server
(to the Internet). Some messaging servers

are operated without IP routing to the public
network and cannot then use the method.

The cloud relay server is resolved via an SRV
record (_ngdx._tlsferrari-electronic.de) in
the DNS domain ferrari-electronic. This also
provides scalability and load balancing.
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3.8. Browser-based configuration interface

The browser-based configuration interface was created for easier administration in cloud
environments. This includes the subset of the functionality of the classic messaging server
configuration program that is relevant for operation in cloud environments. Setting up ISDN,
Notes and SAP is not included. The Configuration programs chapter explains how the
configuration interface is opened in the browser.

Note!

At the time OfficeMaster Suite 8.0 was released, the web-based configuration
interface was a technical preview. It is only available in English and does not yet
allow apps to be registered in Azure AD. To register apps the use of the MS
Exchange Online Connector installation wizard in the classic configuration program
is recommended until further notice.

The advantages of the browser-based user interface are operating system independence and
simplification of setup by eliminating the need to install a configuration program.
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3.9. Tesseract OCR engine support

The OfficeMaster Suite has supported OCR
for a long time, but this was associated with
license costs due to the OCR engine used. In
projects, however, it was also possible, for
example, to recognize forms in order to be
able to initiate automated processes. This
paid OCR engine from B&L is still available
for such projects.

With Tesseract, however, all users now have
a license-free alternative. Tesseract was
developed at Hewlett Packard between 1984
and 1994 for use with scanner products, but
never shipped. The code was given to the
University of Nevada, Las Vegas in 2005. The
former developer was working at Google at
the time. Upon request, the code was
updated and placed under an Apache
license by Google. Since 2006, the program
has been further developed as the basis of
Google Books (collection of retro-digitized
books). Google uses Tesseract for text
recognition on mobile devices, in videos and
Images.

When Tesseract is installed, OCR is used to
add a text layer to the PDF documents of

incoming faxes. This makes it possible for
users to copy text from incoming documents
via cut & paste or to initiate processes via
text extraction (e.g. with PDFium) (e.g. via file
gateway or Web-API).

The Tesseract Engine is not a product of
Ferrari electronic AG. If there are problems
with the quality of the recognition, there can
be  improvements  through  adjusted
parameters when calling the OCR engine.
From version 4, Tesseract supports both
classic pattern recognition and a recognizer
based on neural networks. The recognition is
language dependent and supported by
dictionaries. If the language is sometimes
incorrectly recognized in mixed-language
texts, the wrong dictionary is used. It
therefore makes sense to contact Ferrari
electronic support with an example file so
that the problem can be analyzed and the
parameters can be adjusted if necessary.

In the case of NGDX, it is assumed that the
documents are synthetic PDFs and already
contain text. However, if there are scanned
documents, they may not be subjected to
the OCR.
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3.10. Remote fipMedia server

310.1. What do you need a remote fipMedia server for?

When using an OfficeMaster gate, this could be placed close to the telephone connection (e.g. in
a branch) and controlled by a messaging server in a data center or, for example, from the
central office. First, a file transfer took place in the OfficeMaster Gate, which then carried out the
fax dispatch locally. The connection via VPN can have different quality of service. In particular,
the latency or the round-trip delay sometimes exceeds 100ms, which means that the conditions
for RTP transmission are poor.

The networks and VPNs have gotten better in recent years. However, there are still use cases
where the quality of the VPNs is not sufficient to send RTP streams from a central messaging
server to remote locations. Before OfficeMaster Suite 8, there was no good solution for this with
DirectSIP; a physical or virtualized OfficeMaster Gate with ISDN controller components had to be
used.

The remote fipMedia server brings the fax protocol stack from DirectSIP to an OfficeMaster Gate
or a Windows system outside of the messaging server. The document transfer takes place via
Websocket file transfer to the fipMedia server - network latency is not important for the fax
transfer. The fax protocol is then run on a machine close to the telephone connection/SIP trunk
and the RTP stream is terminated.

Who needs a remote fipMedia server? Most customers have simple installations with one or two
(with redundancy) SIP trunks and a messaging server. These users do not benefit from the
remote fipMedia server. But there are use cases that can only be solved in this way. On the one
hand, there are customers whose locations are distributed over a large geographical area
(international corporations) and are connected via VPN. A central messaging server with several
SIP components should connect the SIP trunks on different continents, for example. On the
other hand, there are customers who want to connect many locations with a central messaging
server, but either the messaging server is not sufficiently scaled, the quality of service of the
VPN (typically latency) is insufficient, or the bandwidth is too low for the RTP streams of all
locations . In those cases, OfficeMaster Suite 8 can be used to calculate the media path of the
fax transmission in the locations, but the SIP signaling, routing and IT connection are carried
out centrally with a messaging server.

310.2. What steps are required for setup?

To set up a remote fipMedia server, you need a physical (OfficeMaster Gate Advanced) or virtual
machine for each location. This can be installed with the OfficeMaster Gate Firmware 5.1 image.
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The SBC function of the firmware can, but does not have to be used. The optional fipMedia
server can be integrated into the firmware (TAR file to be installed). It also contains the Ferrari
IP Media process for fax transmission.

After installation, an APl key must be created. This is later entered in the messaging server and
is used to authenticate the messaging server against the fipMedia server (not everyone is
allowed to control fax operations). The API key can either be created via ssh and the command
line tool omgFmsApiKey or set up with the OfficeMaster Gate Config for firmware 51 (older
versions are not suitable) on a tab in the certificate management dialog.

omgFmsApiKey -user <any name>
omgFmsApiKey -1list

As a next step, the name of the process to be executed in the Comptab must be changed for the
SIP component that wants to use the remote fipMedia server (fsip to fsip2). The easiest way to
do this is to edit the properties of the SIP component and change the name of the file to be
executed (executable) to fsip2 (the component must be stopped for this). This also changes the
configuration interface in the messaging server configuration and the host name of the
fipMedia server and the API key can now also be stored on the “Advanced” tab. One fipMedia
server can be configured for each SIP trunk or DirectSIP component.

General SIP Header Fax and NGDX SMS Inbound Routing Outbound Routing Fallback Advanced

Network

Interface [0.0.0.0 |
Public Interface Address | I
Voice Server Address | I
Distributed IP-Media Server

Host | |
Port

APIKey |

Note!

If the remote fipMedia server is used, only fax communication (and landline SMS)
improves. When using voice mail, the voice server must also be moved to the LAN
close to the SIP trunk. With version 8.0, OfficeMaster Suite 8 does not yet support a
remote voice server.
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The descriptions stored in this chapter will only name the necessary steps to be taken and will
not go into configuration details. The configuration options for the individual components are
described in detail below

The table below provides a brief overview of the required access rights for the respective
connectors and their Installation.

Environment | use case Permission Type
Exchange . o .
Installation Account | local or organization administrator
(local, AD)
Exchange Service Account . :
i _ local administrator, Public Folder Management
(local, AD) (simple, delivery)
Service Account o )
Exchange local administrator, public folder management,
(Full, Extract, Mark, .
(local, AD) authenticated user
Delete)
Exchange . _ .
. Installation Account | local or Microsoft 365 administrator
(hybrid, AD)
Exchange Service Account .
‘ i ) local admin
(hybrid, AD) (simple, delivery)
Service Account o )
Exchange Local Administrator, (OfficeMaster Voice Access)
. (Full, Extract, Mark,
(hybrid, AD) Database Access
Delete)
Exchange . . .
online Installation Account |local or Microsoft 365 administrator
Exchange Service Account
. . ) Cloud Users
Online (simple, delivery)
Exchange Service Account Cloud User, OfficeMaster Voice Access (new
online & (Full, Extract, Mark, Management Role Assignment, created by setup
Delete) wizard)
Notes Installation Account |local admin
Service Account Notes ID without password, read permission on
Notes
(Fax) address book
) Notes ID without password, read, write and delete
Service Account . ) . .
Notes , permissions on mailboxes, read and write permissions
(Voice) . . .
on voice address book (possibly voice.nsf)
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Environment use case Permission Type
WebConnector/ Client | Installation ,
local admin
Gateway Account
WebConnector/ Client | Service local administrator, if necessary read and write rights
Gateway Account to the database of the external SQL server
, Installation .
SMTP/Mail Gateway local admin
Account
Service local system, if necessary LDAP reading rights,
SMTP/Mail Gateway Account changing the VoicePIN requires additional writing
rights
SAP Installation local administrator and CPIC user SAP-Con
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41. Activation of the Products

To activate the delivered license key, start the Office Master configuration.

Login to the configuration interface requires username and Password, the first time you log in
with the user “admin”, you must also change the password.

The initial password for the “admin” user is: OfficeMaster!
Then call up the license management via View > License status or via the license status.

Initially you don't see any licenses in the overview, so go ahead first to Manage Licenses

{54 Messaging Server Config - O X
Fle Edit View Tools Help >
Quicklaunch x |Actions
Search Components de vour Office . > o [ Manage Licenses I 2
v System A
= 5vs £3 Refresh
Compenent Tatle No license available
> %] Undeliverable
Transfer DB Follow the activation wizard instructions to install your license key or obtain a trial license for your system
> [0 converter
v Telephony
v X sPTrunk % Manage Licenses
D sipo
v E-Mail
> B Receiving
> B> Sending
> &) LDAP/SMTP Connector
v SMS
@ SMS via IP-Provider (... Help 8 x
[©) sMsviaussModem [Search Help
] Component Status... License status
£2 b stats... Activation of the
= products
°§ License Status... 1 .
To activate the delivered license
I key, start the OfficeMaster
@ LogFiles... configuration.
. The login to the configuration
.tl? Job Routing... interface requires a username and
@ Administrator () Nolicense il localhost

Figure 4.1: Starting the license dialog
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IF License Management Assistant

Welcome
you have acquired.

(® Manage automatically using the Internet (recommended)
Needs an active internet connection

(O offiine

Manage licenses manually without the Internet

Click next to continue.

This process validates the license and ensures that it is not used on more systems than allowed by the license option

<gack [ Next> || cancel

Figure 4.2: License Management Assistant

In the subsequent question, you decide how to activate the license. Online, or you log into the

portal and load the generated licenses down.

Please enter your portal account now, or create a new one.

Once you have successfully logged in, you have the following activation options:
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W License Management Assistant

Product Activation
Select one of the following options

(® Activate Product
Enter a license activation code

(O My Products
Select this option if you have an existing license

(O Get a Test License

Renew License

Expand your trial period

Register Only

Register your software and hardware

Select this option if you would like to try out the products full functionality for 30 days.

<Back | [ Next> || Cancel

Figure 4.3: select type of license

For a fresh installation, use a trial license (A Trial License received) or activate your license key

(Activate product).

You can activate multiple keys during activation. To do this, simply copy the sent keys into the

Input box.

WF License Management Assistant

Product Activation
Add one or more product keys

Product key:

: ] - - A | addtolist

Product Activation List:

OfficeMaster Suite 8 (10 Users)
==  g/n:  VKOFM8300390081
limits:  Office 365, HWID: SH2653363, 2022-12-10

<Back | [ commit || cancel
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Figure 4.4: product activation

After you have imported the licenses, you will be returned directly to the now filled license

overview.

&4 Messaging Server Configuration - a X
File Edit View Tools Help >
Quicklaunch X B A | |Actions
| License Status
[search Components | Manage your OfficeMaster system licenses Manage Licenses
v System o
=5 £3 Refresh
Component Table Basic i
> %] Undeliverable
Product: OfficeMaster Suite 8 (licensed users: 10)
[ Transfer DB .
Expiration date: 10.12.2022
> [ converter Version: 8.0
v [3 Telephony Lines: 2 (Gateway/B-Channels), 2 (VoIP)
v X sPTrunk Services: Fax, SMS
D sipo Hardware ID: SH2653363
D swr2 Type: OFM.38010
v E-Mail License Files
> B3 Receiving Serial codes: [ VKOFMB0090081 OfficeMaster Suite 8 (expires on: 10.12.2022)
> P> sending
> LDAP/SMTP Connector Modules
v 3 sms Available: Feature Components Lines
@ SMS via IP-Provider (... 7% Common/Global
@ SMS via USB Modem © Messaging Server oo oo
¥ SMS Submission via U
~ @ Transfer Protocol Database L 0/1 ] oo
P o
* SMSReception via ... © SMTP Transnitter Agent T S oo
> 0 Exchange © SMTP Receiver Agent oo oo [Heb 8 x
> [ Notes 3 OCR
- |Search Help
> D © File Gateway I T/ S oo .
> [ WebjFies Services © Wai Archiver | License status
> [ print/OCR P
> B3 voice v 7} Microsoft Exchange (On-Premises) Activation of the
7 Microsoft Exchange (Hybrid) products
E] component status... © office 365 o1 oo To activate the delivered license
£ Notes key, start the OfficeMaster
@ Job Status... o . configuration.
+_! Mail Gate
N sl Gatenay The login to the configuration
0§ License Status... "~ Web Connector interface requires a username and
password. When logging in for the
£ Connector for SAP first time after the setup has been
E Log Files... installed, the user is "admin™
. and the initial password for the
_ © Lines/B-Channels oo e ] user "admin”is: OfficeMaster!,
v Job Routing... After entering the initial
7 A_surwssaill b &

b
@ Administrator 10.12.2022 gl localhost .

Figure 4.5: License overview

Note!

If you do not have direct access to the internet, the dialog allows you to save the
created license information on a separate data carrier and transfer it from another

computer. Please follow the specified steps in the license dialog

Portal page for license key activation: https://service.ferrari-electronic.de
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4.2. Request a support number

4.21. Support with the installation and use of Ferrari
electronic AG products

Since the commissioning and use of technically more demanding quality products in a complex
environment of networks, operating systems, and telecommunications interfaces, Ferrari
Electronic can help you if there are any start-up difficulties. Ferrari electronic with its support
department provides an efficient support when problems arise. To help you as efficient as
possible, we ask that you follow the instructions below:

1. The purchase of our products entitles you for a period of one month from the date of
registration, to direct technical questions to our support department, which will respond
with in a response time of 24 hours at most on normal working days (usually on the same
day) either by writing (fax/e-mail) or by calling back.

2. After the end of the month is further support chargeable. You can choose either a 2-week
limited support ticket or sign up for a one-year support contract with us.

3. To contact our support department you need a valid support number, we will provide you
with this after the complete activation of your products. The condition for this is that your
Account has to be verified accordingly in the service portal. The status of activation can
be seen in the service portal and the configuration program.

° You can reach the support department at:
m Fax: +49 3328 455 962
m Email: support@ferrari-electronic.de
o To make it easier for you to describe your technical problem, we have prepared a
support request form, which you can find in the service portal under Technical
Support.
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4.3. Quick start with Microsoft Exchange

An Exchange connector is set up using the following steps:

Note!
For the installation of the Exchange Connector use an account with the following

rights:

- Domain administrator or authenticated user with the rights in the domain
- Exchange organization administrator (full)

This account is only needed temporarily for the installation and possibly for the
configuration, but it is not the same as the Service Account.

4.31. Preparation

- The Connector component accesses the mailbox of the service account or the transfer

mailbox. This leads to editing emails. To prevent and avoid the loss of important personal
mailbox content the service account used should never be an existing personal user.

- Via the user administration or the Microsoft Exchange System Administration Console a

user account is created, which is a member of the domain users. This account needs its
own mailbox.

- The mailbox must not be suppressed in the global address list.
- The account gets full read permissions of the Exchange Organization through the

membership in the group Public Folder Management.

- The account needs to be added to the local administrator’'s group in the computer where

the installation took place.

- When using voicemail, the following additional permissions are required:

o When using voicemail, the service account for the Exchange Connector must have
write rights to the user object so that, for example, the PIN can be changed

remotely.
o For a remote query of the voice mailboxes via the Exchange Connector the read and

write access to the corresponding mailboxes is necessary.

In Exchange 2013/2016/2019, the following command is used in the Exchange Management Shell
to set access permissions to mailboxes:

new managementRoleAssignment “OfficeMasterVoiceAccess”-user
“Domain\Account”-Role Applicationimpersonation
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4.3.2. Installation

Install OfficeMaster Suite by running OfficeMaster Suite-8.x.y-z.exe.

4.3.3. Configuration

- Grant the service account full access to the directory %ProgramData%\ffums.
- Configure the SIP component to connect to a SIP trunk, an IP-TK or an SBC.

- Install the Microsoft Exchange Connector via the integrated installation wizard. During the
installation deposit the service account.

4.3.4. Exchange Connector installation wizard

Receive Connector

It is recommended to create a receive connector, the corresponding option is preselected.

Note!
A receive connector is created with the following properties:

- Name: Connector for UMS (ExchangeServer-MessagingServer)

- Configuration of reception only via the specified port

- N0 anonymous authentication

- NTLM authentication is enabled

- Service account is activated specifically for this connector

- Communication to this connector is only from the IP address of the
Messaging Servers allowed

Send Connector

A send connector is always created.

Note!
In addition, the following send connector is installed:

- Name: Connector for UMS (Exchange Server - Messaging Server)

- SMTP port 25

- No outgoing authentication enabled

- The sending server (local bridgehead) is the selected Exchange server
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- Receiving server (smarthost) is the specified messaging server that houses
the component of the connector

License Group

With the user-limited versions of the OfficeMaster Suite, a License group specified to manage
authorized users will. By default, the license group is automatically in the container Users
created in Active Directory. There can also be alternative groups be specified.

Service Account

The previously prepared account will appear in the service account input field entered in the
component msx2kgate. The account will be specially authorized to access the connector.

Important decision on the type of installation of the configuration
object!

Install base configuration object globally (recommended)

The global user settings are used as a template for all Users that are not administered directly.
This Settings are stored in an object that is central replicated and made available across the
organization. This Setting is the default for organizations with a single administrative group or
only one routing group.

Install base configuration object domain wide

In larger organizations, the corresponding service account or the installation account of the
domain does not have the right to store the global settings organization-wide. In this case, the
settings can be written to the current domain object. All other sites should perform the
installation form in this way as well. In each site (or domain) will be applyed different global
settings.

4.3.5. Starting the Component

Finally, start the component msx2kgate of OfficeMaster Suite.
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4.4. Quickstart with Exchange Online -
Microsoft 365 (with on-premises AD, hybrid
mode)

This is the correct mode if you want to read the messages while in the cloud, but still have a
local Active Directory for the user management.

The hybrid installation assumes that user-specific values can be stored in Microsoft Active
Directory. One of the the main purpose of this type of installation is the migration of a local
Exchange installation to the Microsoft 365 cloud. The local Active Directory remains, which uses
the existing schema extension of the Exchange organization. In the user objects are then, the
required attribute fields (proxyAddresses, extensionAttribute15) available.

The connector requires an access to the Exchange Online server internet connection. Outgoing
fax messages must be routed directly to the transfer mailbox without further processing such as

signing.
4.41. Administrative account to set up

- Sign in to Microsoft 365 with an organization admin
- local domain user Microsoft 365 service account

This service account can be used as a

- “Shared Mailbox” (no license costs, but requires a password(!), our recommendation) or
as
- normal user mailbox.

Other features of this account:

- Member of the domain users group
- local administrator of the installation computer
- The following authorizations are also required for Voicemail:
o When using voicemail, the service account for the Exchange Connector needs write
access to the user object, so that e.g. the PIN can be changed remotely.
o For remote querying of the voice mailboxes via the Exchange connector are read
and write access to the corresponding mailboxes necessary.
o It should be removed from the Microsoft 365 password rotation
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4.4.2. Microsoft 365 service transfer account (the service
account may also be used here)

In this mailbox, the outgoing messages will be temporary buffered before the OfficeMaster Suite
picks them up. For this, the size limit of this mailbox should be adjusted accordingly

Installation

- Install OfficeMaster Suite and insert a new component for Exchange Hybrid mode

- Now log in using the wizard and the one before described administrative account to the
Microsoft 365 organization

- Message transfer: we recommend the service transfer mode

- Enter transfer domains: e.g. “fax.company.net”, “fax.local” (Separation with comma or
semicolon) - Enter service account

- Select license group to manage authorized users (only for versions with user limit)

- Specification of the storage location for user data (AD or user mailbox)
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4.5. Quickstart with Exchange Online -
Microsoft 365 (Azure AD, online mode)

This connection to Microsoft 365 does not require Active Directory. The user-specific settings are
saved directly in the mailbox of the corresponding user. The connector asks for these values
when sending or receiving documents. With this connection, all unified messaging services that
are supported are also available with a normal Exchange Connector.

The connector requires internet connection to access the Microsoft 365 server.Qutgoing fax
messages must be routed directly to the transfer mailbox without further processing such as

signing.
4.51.Sign In to Microsoft 365 with an organization admin

A Microsoft 365 sign-in is performed during the installation. This login refers to an
administrative account that contains the necessary rights to create, objects in the Microsoft 365
Exchange area (Organization Administrator).

4.5.2. Microsoft 365 service account to access address books

A separate service account or account is required to operate the connector, more precisely a
mailbox is required. This mailbox should work as a normal user mailbox and needs to be
created manually beforehand. The mailbox is used to access the public address book of the
Microsoft 365 installation and it is store in the connector.

This service account can be used as a

- “Shared Mailbox” (without license costs, but requires a password(!), our recommendation)
or as
- normal user mailbox.

Other features of this account are:

- For remote querying of the voice mailboxes via the Exchange connector are read and
write access necessary for the corresponding mailboxes.
- It should be removed from the Microsoft 365 password rotation.
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4.5.3. Microsoft 365 service transfer account (the service
account may also be used here)

In this mailbox, the outgoing messages will be temporary buffered before the OfficeMaster Suite
picks them up. For that it should be adjusted the size limit of this mailbox accordingly.

454, Installation

- Install the OfficeMaster Suite

- Insert a new component for online mode

- Now log in using the wizard and the one before described administrative account to the
Microsoft 365 organization

- Message transfer: we recommend the service transfer mode

- enter transfer domains: e.g. “fax.company.net” “fax.local” (Separation with comma or
semicolon) - Enter service account

- Select license group to manage authorized users (only for versions with user limit)

- Specify the storage location for user data (AD or user mailbox)
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4.6. Quick start with Notes

4.6.1. Preparation

- Create a service account and add it to the local Administrators on the operating system of
the future fax server. Create a Notes user without a password.

- Furthermore, the Notes user ID requires unrestricted access to the Notes mailboxes of the
users who want to retrieve voicemails via phone call. The reception of voicemails is also
possible without this full access

Note!

Notes users ID cannot save password in name and address book. When registering
the Notes user ID, the storage in the Name and address book should be
deactivated.

- Create a “foreign domain” FAX in the Domino address book and let these point to the mail
database of the created user.

- Install the Notes client in standalone mode and set it up. Enter it with the Notes ID you
created.

- Install the programs required for conversion - Start installed programs using the service
account.

User mailbox of the Notes user ID as transfer database

By default, the Notes Connector of the OfficeMaster Suite uses the User mailbox of the Notes
user ID as transfer database. Thereby no special access permissions need to be configured.
However, test faxes and SMS must always be sent from a workstation computer with its own
user ID

Separate mailbox as transfer database

As an alternative to the user mailbox of the Notes user ID, a separate Mailbox can be created as
a transfer database. This has to be done manually on the Domino server responsible for
NOTESCONN. The default name of the separate mailbox is ffax.box.

Note!
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To avoid permission conflicts, it's a good idea to create the mailbox with the Notes
client from the OfficeMaster Messaging Server. To do this, select in Notes the menu
sequence File > Database > New ENG: (File > Applications > New).

4.6.2. Installation

Then install the OfficeMaster Suite.

4.6.3. Configuration

- Grant the service account full access to the directory %ProgramData%\ffums.

- Configure the SIP/ISDN component OfficeMaster Gate Controller (omcums0) or the SIP
Trunk (sipO0).

- Configure the Notes Connector.
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4.7. Quickstart with WebConnector

4.71. Preparation

- Create a service account and add it to the local Administrators on the operating system of
the future fax server. The service account must later become the database administrator.

- Install the programs required for conversion, such as Libreoffice or Microsoft Office
(without Outlook!).

- Start the installed programs with the service account.

4.72. Installation

Install OfficeMaster Suite.

4.7.3. Configuration

- Grant the service account full access to the directory %ProgramData%\ffums.

- Configure the SIP/ISDN component OfficeMaster Gate Controller (omcums0) or the SIP
Trunk (sip0).

- Install a new component of type clientgw and select during the installation wizard, the
desired data storage.

- New SQL Server instance; this is followed by an automatic installation process of a
SQLServer 2014 Express.

- Selection of an existing SQL server in your environment.

- Enter the service account to be used.
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4.8. Quickstart with SMTP mail server

4.81. Preparation

- Create a service account and add it to the local Administrators on the operating system of
the future fax server.
- Install the programs required for conversion, such as LibreOffice or Microsoft Office.

4.8.2. Installation

- Start the installed programs with the service account.
- Install the OfficeMaster Suite.

4.8.3. Configuration

- Grant the service account full access to the directory %ProgramData%\ffums.

- Configure the SIP/ISDN component OfficeMaster Gate Controller (omcums0) or the SIP
Trunk (sip0).

- Configure the pre-installed SMTP connector (mailgw0) that connects to the mail server
and the user data storage.
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4.9, Quick start with SAP

4.91. Preparation

- Create a service account and add it to the local administrators group on the operating
system of the future fax.
- Install the programs required for conversion, such as LibreOffice or Microsoft Office.

49.2. Installation

Start the installed programs with the service account.

4.9.3. Configuration

- Grant the service account full access to the directory %ProgramData%\ffums.
- Configure the SIP/ISDN component OfficeMaster Gate Controller (omcums0) or the SIP
Trunk (sipO0).

Configuration in SAP

- CPIC User

- Node with associated RFC destination (in newer systems, the RFC destination can only be
created in classic mode)

- Jobs

Configuration in OfficeMaster Suite

- Insert a SAP RFC or Unicode via the quick launch bar connector.
- Enter the data previously set up or specified in SAP:

o R3 server

o System number

o Client

o Program ID
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5.1. Overview

Various configuration interfaces can be used to set up the OfficeMaster Suite:

- the classic messaging server configuration program,

- the browser-based messaging server configuration interface,

- the MMC snap-in for the Exchange Server Management Console as well
- the OfficeMaster Gate Config for configuring SBCs and gateways.

The individual configuration tools are briefly introduced in the following sections.
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5.2. Working with the classic messaging
server configuration program

To start up OfficeMaster Messaging Server, Messaging Server Configuration — a program that
runs on both the server as well as installed and used on administrative workstations can be.

The messaging server configuration opens as follows:

Start > Programs > OfficeMaster > Messaging Server Configuration

5.21. configuration interface

&4 Messaging Server Configuration - a X
File Edit View Tools Help >
Quicklaunch X Actions
| Component Status
A
Search Components l Overview about all system components Expand all
Sy po!
v System A
Collapse all
Component Table Available components: 28 L Expand all Groups
N .
Unde':'aue Component Status Current Status A Collapse all Groups
Transfer DB v (@ <Common Profie> [sip0] Running
> [3 converter @ rax Running D start
v (3 Telephony v @ License lines: 0 (32) Running 0 step
> 3 OfficeMaster Gate @ Rec active: 0 (8) Running 1| Pause
v Q sPTrunk @ send active: 0 (8) Running |D> Continue
D spo © msewarTING Running Restart
D swr2 © sms Running -
v B3 el @ vorce Running 13 Refresh
> [ Receiving (© Basic Converter [baseconv] Running D show configuration...
5 B sen ding @ CmdConverter [emdconv0] Running Show log
{} Connector for BCS (FTRAININGO8-VINCIOM22) [m... Stopped
v (& LDAP/SMTP Connector 6 PPe 183 Properties...
v @ Connector for UMS (VINCIMX-VINCIOM22) [msx2k... Running
D maigno > @ C ctor Li Runnif Show All Components
onnet icense nning
v 3 sms i
o~ ) ) > @ Fax-Gateway MSX 2013-2022 Fax-Connector ready Running @ Hide Base Components
@
@ SMS via IP-Provider (... > (@ Information Server MSX 2013-2022 User information server ready Running P
X ow Worl ly
[5) sMs via UsB Modem > @ sms-Gateway MSX 2013-2022 SMS-Connector ready Running
o~ B
‘¥ SMS Submission via U... > @ voice-Gateway MSX 2013-2022 Voice Connector ready Running Group by Type v
o~ o
W@ SMS Reception via U... @ Dateischnittstelle [flegw0] Running |HdD & x
> [ Exchange © E-Mai Receiving [smtprx0] Running [search Help
> B3 Notes @ E-Mail Sending [smtptx0] Running
> B sae @ License check license warning: date limited Running component
> [3 web/Files Services ‘..; Mail Gateway [maiign0] Stopped status
o v @ omcumso [Omcums] Running
> Print/OCR .
intf v > @ officeMaster Gate Channels:2 Running v | | |If the component status is selected, a
T 2 = summary is displayed in the main
panel, giving information about the
@ Component Status... components connected to the
Job Status messaging server.
Job Status... il .
e © 8 [ mmkpns ) s
~ P
i D State C t Send Recei running
°§ License Status... omponen ender eceiver « Stopped
* processing job
Log Files... *starting
E i *error
* cannot start/unknown status
t.’ Job Routing... Q@ % *is not configured

@ Administrator 10.12.2022 il locahost .

Figure 5.1: Distribution of the messaging servers
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The messaging server configuration interface can be divided into the following Divide parts:

- Menu bar (top)

- Quick start (top left)
- Toolbar (bottom left)
- Peloton

- Action field (right)

Note!

The main field always shows the interface that is currently being viewed or edited.
There is a special feature for the items component status and job status. These two
can be displayed in parallel. For the above screenshot, choose one of the both
fields and then click in the main field at the top right “Job Status” or “Component
Status”. The first clicked window is always at the top of the display.

5.2.2. Create / delete components

Creating new components is possible in several ways:

1. Menu bar: New
2. Quick start: Component Table > New Component...
3. Quick Start Area: COMPONENT TYPE
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a Messaging Server Configuration

File Edit View Tools Help

Quicklaunch X

Search Components

v System A
Component Table
> %] Undeliverable
Transfer DB
[ converter
v Telephony
> OfficeMaster Gate
v X sIPTrunk
D sipo
D sr2
v 3 emai
> E3 Receiving

v

> B> Sending
v (&) LDAP/SMTP Connector
D mailgwo

v SMs
¥ SMS via IP-Provider (...
[2) SMs via UsB Modem
@ SMS Submission via U...
'7’..:" SMS Reception via U...

[ Exchange

B3 Notes
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[ web/Files Services

B3 Printjocr

=)

v Vv v v v

@ Component Status...

@ Job Status...
~

Component Table
General overview of all OfficeMaster Suite components

About

The OfficeMaster Suite is a system consisting of a number of basic components that ensure the basic process and operation. The basic components are supplemented
by transmit and receive and connector components according to the acquired licenses.

What's new
Overview
New component... =] Messaging Server Component Wizard X
Available components Component Type i
Po Select from the list the type of messaging server component you wish to create. Fe.' ra '."
- - electronic
me lay name

O cmre Controller

0 up Unique ID Server

D cre Configuration Server Type Basic Converter (BASECONV) v

D snFs Basic Converter (BASECONV) A

. igiseal Conver
o digiSeal Converter (DSCONV)
Dist @ CMD Converter for LibreOffice (CMDCONY)
O split Splitter OLE Cft;nvefter fll)f Ofﬁg 20 &6/20 1:; (OLECONV)
Transfer Protocol Database (LOGDE;

D wa Lua Interpreter Fil Gateway (FILEGW)

[ REQUEUE Requeue component Web-Client (CLIENTGW)
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O mailgwo Mail Gateway

D smtprx0 E-Mail Receiving

D smtptxo E-Mail Sending <Back | [ Next> | I Cancel

M fleawo Dateischnittstelle

Figure 5.2: Creating a new component via the component table

With 1. and 2. a wizard is started, with the help of which the desired component is installed.

Installation variant 3. starts with the selection of whether a custom or a normal installation
should be made. Select the user-defined variant for distributed installations.

The installation is completed with the subsequent dialog. The display name to be is the name
with which the component overview is displayed.

5.2.3. Configure components

The components of the Messaging Server are divided into Configuration (Edit) and Properties.
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Characteristics

Properties include all non-functional settings that are required for the operation of the
component. This can be accessed in various ways:

- Selection of the component in the component status overview, with Right click and select
Properties
- Select in the components table, then Edit

=" Properties of Connector for UMS (VINCIMX... X

Common Log On Advanced

Name msx2kgate0

Display Name Connector for UMS (VINCIMX-VINCIOM22) |

Description
Executable fmsx2kgate
Status Started
Start Stop Pause Continue

Parameters

Figure 5.3: General settings of a component

The General tab will be displayed, when you open the properties of a component.

State

At this point the selected component can be started with Start, Stop, Pause and Resume.

Parameters

The entry of additional start parameters is under Parameter possible.

In some constellations it is necessary to start components under an account that is different
from the system account. The corresponding entered account can be found under the Login tab.
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To adjust logs for analysis purposes, use the Advanced tab.

Log Levels

The level of the log files is set accordingly here.

Note!
Some settings are only possible if the component has been stopped.

Stop Delay

Adjusting the response time of the component to the start and stop of the messaging server
service.

(=" Properties of Connector for UMS (VINCIMX... X

Common Log On Advanced

You can specify the detail level of log file information.

Level Information
~———————————Error

X Warning |
You can specify thym s, iour.

Stop delay
Start attempts
Error time 60 seconds E

You can specify the Drain mode behaviour.

[] start Drain mode on an alarm signal

[ verify component state draining is completed

. ok Cancel | Apply

Figure 5.4: Component Debug Settings

Start attempts

Entry of attempts to restart the component if errors occurred beforehand.
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Error time

Duration between the individual start attempts.

Configuration/Edit

The configuration of a component is displayed via:

- The menu bar of the messaging server configuration by selecting the Component (left
click)

- Via component status and component selection, right click, Select Edit

(= Messaging Server Configuration
File Edit View Tools Help

i s Filesystem Connector
Search Components Dateischnittstelle (filegw0)
> | Undeliverable A

Transfer DB General  Receive
>
[ converter Gateway Mode
v Telephony
> B OfficeMaster Gate Mode AppilCom (OfficeMaster) -
v Qs Trunk
O sipo Working Directories
0 sr2 Jobs [c:\fiegwyiob | =]
v E-Mail Outbound |C:\ﬂegw\out | E]
> E3 Receiving [] Take file or folder name as receipient address
> > Sending
Inbound |C:\ﬁegw\in | E]
v LDAP/SMTP Connector l - - - I
D maigwo Parametrise Inbound Directories...
v SMS Acknowledgement |C:\ﬁegw\ad( | E]
¥ SMS via IP-Provider (... [[] use inbound directory for Acknowledgement
[2) sMs via USB Modem Errors [ci\flegwerr | =]
¥ SMS Submission via U...
o~ Receive File Format / Template
wwn SMS Reception via U...
> [3 Exchange Fax IPCF v |
> B Notes v SMS |150/Windows Western Europe v
Create info fil On off
B2 component status... reateinto e ® O
From template file I v |
@ Job Status... [] Prepend date and called party number
Oﬁ License Status... Status Notification
Mode as File v
@ Log Files... )
Contains no document v
4% Job Routing... Connector <Select...> v

Figure 5.5: Selection of the component to be configured

The configuration steps to be carried out in each case are described in the corresponding
chapters of this documentation.
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5.2.4. Component Status

If the component status is selected, a summary is displayed in the main panel, giving
information about the components connected to the messaging server.

Possible states are:

- running

- stopped

- processing job

- starting

- error

- cannot start/unknown status
- is not configured

5.2.5. Component table

Components which have been configured, are displayed in the component table. The
component name is the unique identifier of the component. The startup type indicates whether
the component should be started automatically when the messaging server starts. The Status
column shows the current status (e.g. running or stopped). Components deliver status
messages when there are status changes. The Status Message column displays the latest of
these messages.

If a component is selected by clicking in the corresponding line, it can be influenced (e.g. startet
or stopped) by clicking on an icon in the Actions panel. System relevant components (e.g. CTRL,
Starter) can't be influenced by the context menu.
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Component Table

General overview of all OfficeMaster Suite components

About

The OfficeMaster Suite is a system consisting of a number of basic components that ensure the basic process and
operation. The basic components are supplemented by transmit and receive and connector components according to the

acquired licenses.

What's new

Overview

New component...

Available components Search... | pe
Name Display name Startup Type Status A
O cmre Controller Enabled

0O uo Unigque ID Server Enabled Running

O cre Configuration Server Enabled Running

O snFs Enabled Running

O pist Enabled Running

D spiit Splitter Enabled Running

D wa Lua Interpreter Enabled Running

) REQUEUE Requeue component Enabled Running

) undeliverable Undeliverable Enabled Running

) cFGPROXY Configuration component Enabled Running

[ GATEKEEPER GateKeeper Enabled Running

O MONITOR Monitor Enabled Running

O cmdconvo CmdConverter Enabled Running

O baseconv Basic Converter Enabled Running

O univoiced Universal Voice Connector Enabled Running

O mailgwo Mail Gateway Enabled Running

O sipo <Allgemeines Profil> Enabled Running

5.2.6. Job Status

The jobs that are currently being processed are displayed in the job status. These can be send
or receive jobs. In addition to the component that is currently processing the job, the

information on the Job ID, Sender and recipient phone number can also be read out here.

In addition, a job in the job status can be aborted or deleted.

Note!

With the F3 key you get more information about the job (e.g. the documents that
belong to the job). The information can then be useful when the job may not be
processed further.
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5.2.7. License status

Activation of the products

To activate the delivered license key, start the OfficeMaster configuration.

The login to the configuration interface requires a username and password. When logging in for
the first time after the setup has been installed, the user is “admin” and the initial password for
this user is: OfficeMaster!. After entering the initial password, you will be prompted to change
the password.

Then call up the license management via View > License - Status or via License Status.

Initially you don't have any licenses in the overview, so go to Manage licenses first.
Start the license dialog

In the subsequent question, you decide how to activate the license.

- Automatic administration via the Internet: Please enter your portal account now, or
create a new one.

Note!
In case you need to create a new account, please fill in all fields.

Once you have successfully logged in, you have the following activation options:
Choose type of license:

For a new installation, use Get a trial license or activate your license keys that were sent to you
via Activate product. You can activate multiple keys during activation. Simply copy the sent key
into the input field. After you have imported the licenses, you return directly to the now filled
license overview.

Under My products you will find the already activated licenses matching your hardware ID of
the messaging server, which can be read “online”.

The hardware ID of the messaging server can be found under Help > About in the menu of the
messaging server configuration

- Offline: If Offline is selected as an option, only licenses that have already been activated
in the Service Portal can be imported.
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License overview

Note!

If you do not have direct access to the Internet, the dialog allows you to save the
license information you have created on a separate data medium and to transfer it
from another computer. To do this, please follow the steps given in the license
dialog.

Portal page for license key activation: https://service.ferrari-electronic.de

5.2.8. log files

The log files of the individual components (including those of the hidden components) can be
viewed in the Log files area in the messaging server configuration.

Several files are created for each component, which differ in their file extension. For example, a
log file from the current day of msx2kgate0 is called msx2kgate0.0. From yesterday it would be
called msx2kgate0.1. In the standard, a maximum of 5 log files are written per component.

Note!
The number of log files (days) to be written can be defined under Extras > System
settings. The current day does not count here.

5.2.9. Job processing

This overview shows the routing rules of the messaging server in their entirety. The settings for
this are made for each individual component.

Outgoing and incoming connections are displayed separately, since they are also separated in
the ruleset and from the routing settings of the components.

The various job types (FAX, SMS, VOICE, SMTP, EPOST, XRECH, ...) and file formats are also
displayed.

The Recalculate job routing button can be used to rebuild the routing in the tables. This is
necessary, for example, when components are stopped so that the jobs are not routed to these
components in the case of orphaned entries and thus get stuck in the job status.
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5.3. Browser-based configuration interface

To open the browser-based configuration interface, the address https://messaging-server/cfg
can be entered in the browser (where messaging-server must be replaced with the name or
address of the real server). The OfficeMaster Suite installs the WebServer role for the Client
Gateway - an IIS which binds port 443 and redirects to https://messaging-server:3216/cfg. The
AuthGateKeeper runs on port 3216 and delivers the frontend to the browser. The communication
between frontend and backend is authenticated via the AuthGateKeeper.

After loading the frontend, the login dialog appears. The same access data apply here as for the
classic messaging server configuration program.

Messaging Server Konfiguration ®

Ferrari electronic AG

Host
10.10.52.34 v

Benutzer
admin

Passwort

Anmeldedaten speichern

The function of the browser-based configuration interface largely corresponds to the classic
messaging server configuration program. Some components cannot be configured, but there is
extended functionality in some areas (e.g. the dashboard).
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Messaging Server Configuration o Administrator
Dashboard = 10.10.52.34
[} Dashboard Component Information v
Components
% Jobs
°e @ started
@ drainmode
Be  Components stopped

@ stopped unexpectedly

*/ Job Routing
5] LogFiles

Administrative
o) »
= Users Show details
Installed Certificate Information <
License Information v

State
Valid

%, System Settings

@ About

Expiration Date

07/01/2025

Lines

32 (Gateway/B-Channels), 32 (VolP)
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5.4. OfficeMaster Exchange Administration

The Microsoft Management Console can be expanded using plugin DLLs (MMC snap-ins). In this
way, functions were added to the Exchange Server Management Console, which contain the

settings on the Exchange Server for the OfficeMaster Suite integration.

® Microsoft Office365™
o Microsoft Exchange Server 2019

a Mirrnenft Fyrhanne Sarver 20116/

Use OfficeMaster Exchange Administration to administer On Premise-Installations and Cloud-
Instaliations as well. Before configuring the target platforms it is required to authenticate via
username and password. Different target installations will be supported:

OfficeMaster Administration - [OfficeMaster Exchange Administration\Connector for BCS (FTRAINING08-VINCIOM22)] - [m] X
File Action View Help
ol ARz ol
gfficeMaster Exchange Administration Q OfficeMaster Administration Actions
v [ Local Exchange Administration
Connector for BCS (FTRAINING08-VINCIOM22) &
ls2. Organization Configuration OfficeMaster
Sz Connector Configuration N View 4
i‘“ Recigi aure . | OfficeMaster for Cloud Solutions
%1 Recipient Configuration Fe1 ra r ﬂ Help
@ Tools : I OfficeMaster Exchange - Administration
viac oy ECSIEIE INCIONE) e | ectronic hitp://www. lects de http://forum f lects de
|s-] Organization Configuration
2., Connector Configuration
2. Recipient Configuration Cloud Tennant Overview
@ Tools
Organization: ~ Connector for BCS (FTRAININGOS-VINCIOM22)
Connection: outlook.office365.com
Al : benutzer8@ftraini icrosoft.com
Basenode: \\VINCIOM22\FFACCESS \connectorconfiguration.cfg
Office for Cloud llation:

Figure 5.6: OfficeMaster Exchange Management

The use of the OfficeMaster Exchange administration is explained in detail in the Connector for
Microsoft Exchange chapter.
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5.5. OfficeMaster Gate configuration
program

With version 8, the OfficeMaster Gate configuration program was removed from the OfficeMaster
Suite installation. For SIP connections of the OfficeMaster Suite, it is not absolutely necessary to
use an SBC or a media gateway (OfficeMaster Gate). If a OfficeMaster Gate is used, the
OfficeMasterr Gate configuration program can be installed. The installer is located in https://
ferrari-electronic.de > Downloads. There select Unified Communications and Software and click
Search. Then select Setup: OfficeMaster Gate configuration, download and install.

The use of the program is explained in the Manual: OfficeMaster Gate Firmware 5.1 (or Manual
for OfficeMaster Gate for the older firmware version 4).


https://ferrari-electronic.de
https://ferrari-electronic.de
https://ferrari-electronic.de
https://ferrari-electronic.de

6. Base Configuration



5.5. OfficeMaster Gate configuration program

This chapter describes basic configuration steps and the creation of some important
components. Other components can be created and configured in a similar way. The

configuration options of all components are presented in the chapter Configuration of the
individual components.
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6.1. Certificate Management

Certificates are stored in various places in the OfficeMaster Suite used to secure
communication. This is how you log in administrators with a secured login, which also
certificates the server with the OfficeMaster Suite. With the installation, OfficeMaster generates
a “self-signed” certificate so that the initial Configuration is possible. A certificate request (CSR)
is also created, which can be signed by a certificate authority (CA) to create a trusted certificate.
This means that the self-signed certificate can then be exchanged.

Additionally, computer certificates may be stored in the following needed locations:

- Receive email messages

- Connection to Microsoft Exchange
- Connection to SMS-IP provider

- SIP connection

- Voicemail configuration web page
- Website for the WebConnector

It is also possible to create a certificate for trustworthy and also to use encrypted
communication via NGDX. However, it does not use computer certificates, but rather certificates
based on phone numbers. Here, a self-signed certificate is initially created, and a certificate
request (CSR) is generated. With the self-signed certificate encrypted, but not authenticated,
communication is possible. Ferrari electronic AG can sign NGDX-CSR (after verifying the fax
number details). The certificates are managed in the configuration via Extras > Certificates...

54 Certificates X

Server Certificate Store
Infrastructure

State: 0
Certificate: Installed view

Certificate Request

The first step needed to get a server certificate is creating a request.
Submit this request to a Certificate Authority.

Install Certificate

The Certificate Authority will generate a certificate response file, which
contains your public key and is digitally signed.

Import ...

Close
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Figure 6.1: Certificate management

By clicking on the Certificate storage tab you can see the Self-signed certificates created during
installation or later your own added.

54 Certificates X

Server Certificate Store

Main
A
& officemaster.crt.pem (vinciom22.valentin.domain, valid to 20
[ officemaster.csr.pem

P officemaster.key.pem
General
<No certificates available >
NGDX (tel URI)
& ferrariNgdxCaChain.crt.pem (NGDX Ferrari electronic interm

< >

AddFile... = X Remove [ Display...

Close

Figure 6.2: Certificate store

If the certification authority used is an Active Directory Domain Controller, the steps in the
following section can be followed.

6.1.1. Generating a certificate with the certification authority of
an Active Directory server

After installation, the OfficeMaster Suite generates a self-signed certificate when starting the
AuthGateKeeper to ensure the initial communication of the configuration programs with the
OfficeMaster Suite. In order to avoid warnings or error messages when accessing the website
and to establish a secure connection between the individual components and the OfficeMaster
Suite’s AuthGateKeeper, your own signed certificates by a certification authority should be
imported into the OfficeMaster Suite.

There are two basic procedures for importing certificates into the OfficeMaster suite:

- Generation of the private key with the OfficeMaster Suite and use of a certificate signing
request (CSR). Generation of a certificate from the CSR by the certification authority and
importing the certificate. The private key never leaves the machine, which is
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advantageous from a security perspective. The private key must not be overstored with
this method, as it is the only one that matches the certificate.

- Generation of private key and certificate by external tools (e.g. openssl) or the
certification authority. With this procedure, both the private key and the certificate must
be imported. Great care must be taken to ensure that the private key is not compromised
when copying between machines.

The method described in these instructions utilizes the first approach, which is the simplest
and most practical option when employing an Active Directory Domain Controller. However, the
sequence of steps is also identical when using another certification authority (CA), with the
exception that the certificate request is forwarded to a specific Certification Body, which then
verifies the accuracy of the data in the certificate.

All subsequent steps require administrative authorizations on the OfficeMaster Suite server and
partly in the Active Directory (certificate request).

Generate certificate request

The certificate request can be started via the messaging server configuration menu “Tools” ->
“Certificates” -> “Create”.

54 Certificates X

Server Certificate Store
Infrastructure
State: 9
Certificate: Installed view

Certificate Request

The first step needed to get a server certificate is creating a request.
Submit this request to a Certificate Authority.

Install Certificate

The Certificate Authority will generate a certificate response file, which
contains your public key and is digitally signed.

Import ...

Close

Figure 6.3: Certificate store
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i54 Certificate Request X

Attributes

Common Name™: II I

E-mail Address: | |

Country Name: |:]

State or Province:

Locality Name:

Organization Name:

|
|
|
Organization Unit: |

Subject Alternate Names:

* Indicates required attribute

Figure 6.4: Certificate request dialog

The full name (fully qualified domain name, FQDN) of the local computer must be used as the
common name (CN). The same applies to the alternative name fields (subject alternative
names, SAN). In the example in the following image, *test.local is the name of the Active
Directory domain. This must be adjusted according to the domain used.
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I Certificate Request X
Attributes
Common Name™: IFaxserver. test.local I
E-mail Address: | Admin@test.local |
Country Name: E
State or Province: |State |
Locality Name: |Loca|itv |
Organization Name: IFerrari Electronic Test AG I
Organization Unit: |Deve|opment |
Subject Alternate Names: e

* Indicates required attribute

Cancel

Figure 6.5: Example of a certificate request

After the certificate request has been created using the “OK” button, it can be accessed using
“View". Now the displayed content can be copied and saved as a certificate request file using
Notepad (or another editor) (saving is optional, often the content can be copied directly into an
input field of the certification authority).

Create certificate

The certificate request must then be passed to a certification authority (CA) so that it can create
and sign a suitable certificate. The example below illustrates this using Active Directory
Certificate Services. To do this, you must use a browser to access the address of the server that
has the Active Directory Certificate Services role installed, e.g. https://servername/certsrv.

After successful authentication, the content of the previously generated certificate request can
now be inserted via “Request a certificate” -> “advanced certificate request”. “Web Server” has
proven to be suitable as a certificate template. The certificate can then be downloaded in
Base64-encoded format (the formats *p7b/PKCS#7 and *cer/DER, which are also offered, are

not suitable for the OfficeMaster Suite without conversion).
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Import certificate into the OfficeMaster Suite

The certificate generated in this way can now be imported into the OfficeMaster Suite
(Messaging Server Configuration->Extras->Certificates->Import):

54 Import certificate X
Files

Method (® Import signed certificate (Default)
(O Import custom generated certificate and private key

Certifikate |C: /Downloads/certnew.p7b |

Figure 6.6: Import certificate

This ensures that when the TLS connection is established, the signature chain of the certificate
can be checked and the connection is therefore authenticated.

Note:
The OfficeMaster Suite expects Base64 encoded PEM files.

When a new certificate is imported into the OfficeMaster Suite, AuthGateKeeper also creates a
*pfx file. Like the PEM files, this is located in the PKI folder under %PROGRAMDATA%
\FFUMS\fmsrv\data.

Import certificate into the Internet information server

If the web interface for voicemail or webfax (Clientgw) is also used, the certificate must also be
imported into the Internet Information Server (11S). To do this, the certificate must be available
in the PKCS#12 file format as a *pfx file (including the private key). A *pfx file is automatically
created by AuthGateKeeper when importing the PEM file.

This certificate (*pfx file) must then be imported into the Internet Information Server on the
OfficeMaster Suite server and configured as the standard certificate for https connections. To do
this, start the 1IS manager on the OfficeMaster Suite server and switch to the localhost address:

Figure 6.7: Internet Information Services Manager

By double-clicking on “Server Certificates” you can access the locally existing certificates. The
default self-signed certificate “OfficeMaster.UmsSite” can be seen there. The previously created
certificate (*pfx file) can be imported using “Import” in the action panel. During the import
process, “Web Server” or “Web Hosting” should be selected as the certificate store instead of
Personal.
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Import Certificate ?

Certificate file (.pfx):

| CA\Users\Administrator. TESTMARKUS\Downloads'\xca l

Password:

Select Certificate Store:

Web Hosting

Allow this certificate to be exported

Figure 6.8: Certificate import dialog

After the certificate has been imported, it still needs to be defined as the standard for https
access. To do this, click on the “Default Web Site” in the IIS Manager and select the previously
imported certificate in the action panel via “Bindings”.

Figure 6.9: Dialog Edit Site Bindings

If necessary, all existing website connections should then be reset or restarted using “lisreset”
from the command line. During this process, all locally hosted websites will be temporarily

unavailable.

The correct installation of the certificate can be checked by visiting the website in a browser
(https://FQDN of the computer/fax). If the existing lock is closed, the certificate was installed

correctly:

2 D Do x +

OfficeMaster PR
UMS

Figure 6.10: OfficeMaster UMS page with accepted certificate
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Certificate file format conversion

ASN.1 (Abstract Syntax Notation One) is defined in the ITU standard X.680fF and is also used by
the ISO. The ITU standards X.690ff define encoding rules for ASN.1 descriptions. Common ones
are BER (basic encoding rules), PER (packed encoding rules), CER (canonical encoding rules) and
DER (distinguished encoding rules). To put it simply, ASN1 is a description language for data
objects or structures and the encoding rules define how binary data streams are created.

PKCS (Public Key Cryptography Standards) are a series of standards that describe the encoding
of cryptographic keys. PKCS#1 (RFC8017) is from/for RSA, PKCS#8 (RFC 5958) also supports other
cryptographic methods. Both use ASN.1/DER to encode the keys.

The structure of public key certificates is defined in the ITU standard X.509 as an ASN
description. DER is commonly used for certificates and keys.

Different file formats are used for certificates, CSRs and keys. The following list provides a brief
overview:

- PEM files: These are the most commonly used on the web because OpenSSL uses this
format. They are Base64 files that encode certificates, certificate requirements or private
or public keys in DER format as a text file. A text header or footer around a Base64 block
shows whether it is a certificate, a certificate request or a private or public key (optionally
encrypted with a password). Chaining these Base64 blocks together is also permitted, for
example to be able to save a certificate chain.

- DER files: These are binary files which can contain all forms of certificates and keys in DER
format. The file extension is *der or *cer. Its use is widespread in the Java environment.

- P7B files: These are Base64 files of certificates or certificate chains based on PKCSH#7.
Private keys are not included in P7B files. PKCS#7 forms the basis for S/MIME (RFC5652).

- PFX files: PFX files use PKCS#12 (RFC 7292) and contain both private key and certificate.
This means that PFX files must be treated confidentially and can be protected with a
password. PFX is a binary format used on Windows platforms (e.g. by the Internet
Information Server).

Conversion of certificate files is currently not easily possible using Windows on-board
resources. If you are familiar with external tools such as openssl, you are welcome to use this to
convert certificate files. To simplify the conversion, reference is made to the third-party tool xca
(http://hohnstaedt.de/xca).

Note:

Any software that reads the private key should be subject to a trust check
beforehand. The private keys must be protected. Simply converting public keys or
their certificates is usually not a problem.
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aaaaaaaaaaaaaaaaaaaaaa

Import PKCS#12

Database: Cilnstallixca_dbxdb

Figure 6.11: xca

After the software has been installed with standard settings on the OfficeMaster server, the first
step is to create a new database (File->New Database). The previously created *cer can then be
imported via the “Certificates” -> “Import” tab:

In addition, the private key must be imported (“Private Key”> “Import”).

Info:

For security reasons, the private key should not be copied between machines, i.e.
not leave the OfficeMaster server. That's why in this example the xca software is
also running on the OfficeMaster server.

By default, the private key of the OfficeMaster suite is available in the C
\ProgramData\FFUMS\fmsrv\data\pki\ directory as officemasterkey.pem in *pem format. After
successful import of the private key, the certificate can be exported via “Certificates”>"Export” as
an encrypted PKCS#12 file in *pfx format:

** X Certificate and Key management X
Certificate export }i&} )
Name  xmarkus-om3.testmarkus.local
Filename ‘C:\Downlnadsb(markus-omS.testmarkus.local.pfx ‘
Export Format

The certificate and the private key as encrypted PKCS#12 file
PKCS #12 (*.pfx) N
Export comment into PEM file
OK Cancel Help

Figure 6.12: Certificate export

The conversion to PFX format shown in this example is carried out automatically by the
OfficeMaster Suite when importing PEM files and is therefore not necessary in practice.
Depending on the certification authority, however, different certificate formats can be delivered,
which then have to be converted to PEM for the OfficeMaster Suite. In the standard process
described above with a domain controller certification authority, no conversion is required.
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6.2. DirectSIP

To connect to SIP trunks and IP telephone systems, you can use the Component SIP available.
To configure, open the OfficeMaster Suite configuration and choose from the quick launch bar
DirectSIP.

6.21. Create new component

On a newly installed system there are not yet created SIP components. To create a new
component chooce add component. After that a installation wizard will show up.

After you have configured or adjust the default settings, such as component name, Displayname
and Server , the special wizard for the SIP component will start.

i51 Messaging Server Component Wizard -

Type of controller -
Please select on of the options below Fe1 ra rl
electronic

(@ SIP Provider
Choose a predefined profile for a SIP provider

(O PBX or other VoIP System
Choose a predefined profile for a PBX or enter the VoIP connection parameters manually

Figure 6.13: select type of connection

In the first step, select the type of connection to be used. This preselection forms the following
dialog with the current predefined remote stations clearer.
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ﬁ Messaging Server Component Wizard

Select profile
Select your VoIP environment

X

Ferari

electronic

Select the environment for the new controller to operate in. If the list below does not contain your SIP
Trunk provider you should select a compatible or the generic environment.

BroadWorks

Deutsche Telefon (registry necessary)
Deutsche Telekom CompanyFlex
Deutsche Telekom Consumer SIP
Deutsche Telekom DeutschlandLAN
ecotel

equada

Flowroute

HFO NGN Connect

Interoute

Neotel

NFON

peoplefone

Plusnet IPfonie extended

Next>

Figure 6.14: list of remote stations with template

The templates are constantly being expanded and updated accordingly. If the remote station

you are using is not listed, select General profile and continue to follow the wizard.

{54 Messaging Server Component Wizard

Connection parameters

Provide the hostname or the ip address of the VoIP remote peer

X

Ferrari

electronic

Please provide the hostname or the ip address of the voice-over-ip remote peer that should be used.

Host: | tel.t-online.de|
Port: 5060 i+]
Protocol: ILDP v |

Register Required:

SIP Proxy: tel.t-online.de

<Back | [ next> || cancel
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Figure 6.15: connection settings

Enter the connection information here, such as the IP address and port remote station.

=" Messaging Server Component Wizard X
Common settings -
Select the number of lines to use Fe1 rari
electronic

Please select the number of lines should be available for services. Please note that the effective number
of available channels depends on the installed license.

Channels Total:
Senc

<Back | [ Next> || cancel

Figure 6.16: line configuration

Depending on the available licenses and the desired prioritization of incoming and outgoing
messages, you can here configure the available lines.

Finally, when using the Fax function, enter the basic information for fax communication.
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a Messaging Server Component Wizard

Fax parameters
Select the basic fax parameters

Ferrari

electronic

X

Please provide the called subscriber identification (CSID) and the fax header text to insert at the top of

the page.
CSID: | +493328455960
Headline: |Ferrari Electronic AG

<Back | [ Next> || cancel

Figure 6.17: Fax settings

After going through the wizard, you will see the new created component (in this case sip2) in
the overview of available SIP components.

File Edit View Tools Help

a Messaging Server Configuration

Quicklaunch

| Search Components

> % undeliverable
[ Transfer DB
> [ converter
v Telephony
> OfficeMaster Gate
v X sIPTrunk
D spo
D swe2
D sp1
v 3 emai
> B3 Receiving
> B> sending
v {E) LDAP/SMTP Connector
(] mailgw0
v 3 sms
@+ SMS via IP-Provider (...
[2) M via UsB Modem
@Y SMS Submission via U...
@ SMS Reception via U...
> [ Exchange

2] component Status...

@ Job Status...

° .
£ License Status...
E Log Files...

4% Job Routing...

>

- [m] X
>
X A | |Actions
| SIP Trunk (SIP)
| Product/License: IP Lines & New...
A
[ Edit...
AbOUt Remove Component...
The SIP component enables connections to various SIP-enabled remote stations (SIP trunk, IP-PBX). One SIP component is required per remote D Start
peer.
O Stop
What's new
|| Pause
Overview [P Continue
New SIP Trunk component... Restart
£3 Refresh
Available SIP Trunk components bl
183 Properties...
Name Display name Startup Type Status Status Message
DO sipo <Common Profile> Enabled Running
D sipt Deutsche Telekom Consumer SIP Disabled
O sip2 equada Disabled
|Help 8 x
< > |Search Help
~
| i » | [SIPtrunk
D ~ State Component Sender Receiver The SIP component is available for

v

connection to SIP trunks and IP
telephone systems. Fax and NGDX
transmission, landline SMS and
voicemail are supported via the
SIP trunk.

For configuration, open the
OfficeMaster Suite configuration
and select Telephony > SIP Trunk
from the quick launch bar.

Create new v

@ Administrator 10.12.2022 il localhost .
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Figure 6.18: Newly created SIP component

The complete setting options for the connection can be reached by left-clicking on the
component in the quick start bar or by right-clicking from the main field from the main field.

At this point, you can change further settings, e.g. for NGDX or the routing based on the dialed

phone numbers.

a Messaging Server Configuration

File Edit View Tools Help

Quicklaunch

Search Components

> ] Undeliverable A
Transfer DB
[ converter
v (3 Telephony
> (B OfficeMaster Gate
v X s Trunk
D sipo
D sr2
O sp1
v 3 Email
> B Receiving

v

> B> sending
v [E) LDAP/SMTP Connector
(] mailgw0
v SMs
@ SMS via IP-Provider (...
[2) M via USB Modem
@ SMS Submission via U...
¥ SMS Reception via U...
> [0 Exchange v

& component status...

@ Job Status...

°$ License Status...
B vLogFies...

4% JobRouting...

B <1p Trunk

~
| Deutsche Telekom Consumer SIP (sip1)

General  SIP Header

Trunk Settings

Port

Register

Proxy

Username
Authentication Username
Password

Registration Expires

Certificate FriendlyName

Options
Local port
Priority
Codecs

SRTP Mode
Send SIP OPTIONS
SIP OPTIONS Interval

RTP Port Range

Fax and NGDX SMS

Inbound Routing Outbound Routing

Falback  Advanced

Domain (IP Addess/Hostname) |te|.tm|ine.de

Transport Protocol
@on O off

|he|-t.on|ine‘de |
' |

L

|Ioginname | @ SIP username is used when empty.

480 [ sec

5060

!EEJ

M G.711a (aHaw) T
™ G6.711u (udaw)

&

50000
9

g

iIiDi
8
ROgROD

=3

E

Number of lines to use
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@ Administrator 10.12.2022 4l localhost .

Figure 6.19: Complete configuration of the component

Note!

Have you had to make an adjustment for an existing profile, or a connection which
is not yet listed? We would be pleased to receive your feedback and will be happy
to add this for upcoming OfficeMaster Suite releases.
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6.3. ISDN controller

The ISDN interface is controlled by the component OMCUMS.

Note!

The ISDN controller is only included to maintain backwards compatibility. For new
setups, we recommend (where possible) using DirectSIP. The public ISDN
connections have already been almost completely converted to SIP. However, ISDN
still exists as an internal connection on private telephone systems.

To configure the OfficeMaster Gate, open the OfficeMaster Suite Configuration and then click on
Edit > OfficeMaster Gate... and follow the menu sequence. A dialog will pop up and on the left
side under Name all ISDN cards, virtual cards and already added OfficeMaster Gate names that
were found by OMCUMS at the startup will be displayed.

a Messaging Server Configuration

File Edit View Tools Help

Quicklaunch X
OfficeMaster Gate
Search Components OfficeMaster Gate
> %] Undeliverable A

Transfer DB DY@ PIE @ Controle:
> D Converter ISDN  Fax Voice SMS  InboundService Selecton  OutboundRouting  Falback  Message Waiing  Advanced Se' ¢ (¥ |
v Telephony

o OfficeMaster Gate [ Use the interface
[ OfficeMaster Gate Originator Address Digit (OAD) Number of lines to use
v o
w gp Trunk Originator address I Total
sip0
Job specific Send
D swe2 e o en
D sp1 Base number Receive
v 3 i
EMai Dispatch Reception
> B3 Receiving I
" Dial prefix
> P> Sending P DID-Prefix
v (&) LDAP/SMTP Connector Enable for number length from chars
D mailgwo
Type of connection
v 3 sms

@ SMS via P-Provider (. O Point-to-Multipoint (@) Point-to-Point [ qsi6

[2) sMS via USB Modem

'5':' SMS Submission via U... @ Autoreceive after DID digits Base number I

@ SMS Reception via U... (O Autoreceive depending on first DID digit
> [3 Exchange 1 (3|2 33 3|4 35 3|6 3|7 3|8 39 3(0 |3
> [ Notes

The OfficeMaster Gate seems to be in Gateway / Mixed Mode. The ISDN settings
> O sap v don't take effect, please use the OfficeMaster Gate Confiquration instead.

Figure 6.20: Hardware settings

At the top right, select the controller to which the listed gates and cards are assigned.

Note!
if it's about CAPI cards or XCAPI, the JCISDN component will be required.
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If OfficeMaster Gate is connected to the network, it can be added to the OfficeMaster Suite. The
available ISDN hardware is displayed in the left dialog box. OfficeMaster Gate carries the Prefix
omg followed by the serial number. CAPI cards found are marked with the prefix capi. If
necessary, the hardware used can also be given a suitable name subsequently. This is especially
usefull in distributed installations. To do this, select the hardware and press F2. The
configuration shown in the dialog box on the right always refers to the Hardware selected on
the left.

If the Use ISDN interface check box is checked, the configuration tabs will be accessible. When
the configuration is finished, press OK to save the settings and to apply them to the current
operation of OMCUMS.

Note!
Before starting the initial configuration, the component OMCUMS should be
stopped and should only be started after the settings have been accepted.
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6.4. Voicemail server

With the extension for voicemail, the functions of the Voicemail server included in OfficeMaster
Suite is unlocked. The general interrelationships are explained below.

Configurations on the voicemail server

In the quick launch bar, select the area for Voice or Voicemail to create and configure a
component. After creating the component, you have extensive setting options, which are shown
in detail in the chapter Configuration of the individual components.
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Base Settings
Default voice project: | Default Voicemail v|
Voice project (no mailbox): | Hang up the call v |
Spedific Voice Path: I | IE
Cut records by: | 500 @l (msec)
Delay record by: |0 @] (msec)
Recording timeout: | 180 @l (seconds)
Enable MP3 conversion:
mp3 to wav |lame —decode "%s" "%s” |
wav to mp3 Ilame V9 -—resample 8 -mm "%s” "%s"
Access authorization mode: IPIN or OAD v ‘
Default PIN: [esee |
[] dynamic default PIN processing
[[] user PIN notification via email
[] user PIN notification via SMS
[] user PIN change request if default PIN is set
Minimum PIN length: |4 2]
Maximum PIN length: |6 @l
Max. config PIN attempts: | 3 @l
RTP Port Range: I 50000 E' from
| 50999 2] o ‘Skript Parameters...
Extended Voice
Username login mode: lOnIy PIN v
Website Configuration: [ Open...

Figure 6.21: Configuration of voice server

6.4.1. Overall process of voice communication

Unlike faxes, voice calls must be decided directly when they are accepted, to which user the call
should apply and which behavior should occur. When accepting the call, it must also be decided
which project, which announcement and which language should be used. Accordingly, an
incoming voice call is significantly more time-critical as a fax to which the entire IT
infrastructure must be adapted.
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Sequence of a voice call

- The call is established by a SIP trunk and thus the component SIP or an OfficeMaster Gate
in the direction of the hardware controller of the messaging server.

- The hardware controller or the SIP component determine the voice connector associated
with this call (e.g. msx2kgate) and the corresponding voice server (usually voice0). For this
investigation all transmitted call number elements can be used (called/to, calling/from,
redirected /diversion/history, etc.).

- The voice server establishes a UDP connection to the IPMedia process or OfficeMaster
Gate and takes over the direct communication.

Note!

For the outgoing ones Connection from the voice server may have a corresponding
rule in the Set up Windows Firewall. A clear sign of It is a firewall problem if, during
test calls to fax numbers, the Fax signal can be heard, but not with calls to voice
boxes corresponding standard announcement.

6.4.2. Projects included in the voice system

OfficeMaster provides several projects after the installation that can be used without major
administrative effort that can provide various basic functions. This Projects are stored in “.
\data\voice” of the messaging server in the form of Subfolders created with description file and
LUA script.

The voice system consists of several projects connected in series, between which are constantly
switched. These projects are to be understood like individual states in a state graph. There are
often multiple entry and exit points.

To keep things easily managable, not all projects are selectable as start-up projects. Which
project is loadable is specified in the respective .ini file defined by the loadable flag.

Voicebox via Pilot ID

projectvoxdidcpn

The calling party number is set to the called party number, then the leap into the Extended
Voicemail project takes place (eVoice_projectStart).
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Extended voicemail

If Extended Voicemail is not available for licensing reasons, the system reverts to the Standard
Voicebox described below. The individual projects perform the following tasks:

eVoice_projectStart

Entry point with setting the individual values for the variables.
eVoice_projectrecord

Recording a voice message.

eVoice_projectPlayAudio

If recording is deactivated for a period of time or a voice box, only the desired announcement is
played and then the call is hung up.

eVoice_projectAnnouncementFromPhone

Recording of your own announcements controlled via the web interface.
eVoice_projectAnnouncementToPhone

Playback of your own announcements controlled via the web interface.

Recording function

projectrecordcall

When calling up this project, a short notice is given that the call is recorded and then the
recording is started. After Termination of the call, a message will be send to the user with the
corresponding recording.

For reasons of storage space, it is strongly recommended to enable audio conversion to .mp3!
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Selection of the Voicebox to be called

projectvoxdid, projectdid

The caller is prompted to select which one to use by pressing a key Voicebox he wants to be
connected.

“Recording Studio”

projectrecstudio

Recording an announcement, especially for creating announcements for IVRs. Creates an audio
file in the valid file format for further use in the system.

IVR templates

Example of scripting your own IVR with the most important functions.
ivr xample_start

Entry point with timetable, public holidays, etc.

ivr xample_normal

The company is open, the caller has the choice of connecting to another subscriber or to leave
a message.

ivr xample_closed

The company is closed, the caller gets an announcement played.

6.4.3. WebVoice

Users have the option of setting up their own voice mailbox via the web interface.
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Base configuration

The basics for the interaction between voice server and the Components of the web services
are controlled by the OfficeMaster Suite setup. Here, the Internet Information Service (11S) is
created and activated as a feature of the Windows Server.

The corresponding web pages for the IIS are available under %ProgramFiles%
\FFUMS\fmsrv\Webservice.

To configure the web services, you would normally have to call various configuration files of the
[1S but in OfficeMaster, with the tool FClientGwCfgPrg (callable via the configuration of the VOICE
component), you can access these files in a simplified version.
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Base Settings
Default voice project: I Default Voicemail v |
Voice project (no mailbox): I Hang up the call v I
Spedific Voice Path: | | Lo |
Cut records by: I 500 E' (msec)
Delay record by: Io @] (msec)
Recording timeout: | 180 @l (seconds)
Enable MP3 conversion: ™
mp3 to wav |lame --decode "%s” "%s” |
wav to mp3 |lame -V —resample 8 -mm "%s” "%s” |
Access authorization mode: IPIN or OAD v ‘
Default PIN: (esee |
[[] dynamic default PIN processing
[] user PIN notification via email
[] user PIN notification via SMS
[] user PIN change request if default PIN is set
Minimum PIN length: |4 %l
Maximum PIN length: | 6 @'
Max. config PIN attempts: | 3 g]l
RTP Port Range: | 50000 @l from
| 50993 2] to ‘Skript Parameters...
Extended Voice
Username login mode: Only PIN v
Website Configuration: | Open... }

Figure 6.22: Start of the configuration program

Website address

The address of the website to be configured is entered here. Unless the default address after
installation manually was changed on the IIS, this is either http://SERVERNAME/ ums or http://
SERVERNAME/fax.
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Configuration password

The access to the configuration is protected by the password “OfficeMaster!”.

After successful login to the server, the user will be able to configure the operating mode of the
web page, the voice server and the corresponding connector for the user information.

W ClientGW WebService Configuration = O X
Website Address http:/Aocalhost fax
Configuration password ~ “*"""
’ Connect ‘ ’ Disconnect ‘
\ Website Settings |
| Change Configuration Password |

Service Behavior Contacts Standards Diagnostics

Operation mode IVoicehfo only v |

D VALENTIN

Login Domain

VINCIOM22\OFFICEMASTERSQL

lnetancrae Namea
Instance Name

Database Name OfficeMaster

Messaging Server

Computer Name |127.0.0.1 |
Port 3216 |

I Reset H Save H Close

Figure 6.23: OfficeMaster client website setting
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Operation mode

Voicelnfo only must be selected only for the main connector such as Exchange, Notes or the
SMTP connector.

Login type (from OfficeMaster Suite 6.2)

Here you set the login variant of the users on the web front end.

- Username & Voice PIN
- Voicebox number & PIN
- Email address & Voice PIN

Voice component

Here is the used voice server component of the OfficeMaster stored. In the default case this is
voice0 and does not need to be changed further.

Voice gateway

The voice server requires a component on which the user information can be requested and
messages can be delivered. In Exchange environments this is usually msx2kgate0. In other
environments this is notesvoice0, univoice0 accordingly or clientgwO.

Change configuration password

It is recommended to change the default password so that no unauthorized access to the
system can occur.

Permission levels

While setting up the Voice Server one must also define the authorization level of the user.
Currently the following levels are available (with the permissions listed below):

without voice mail

If a user does not have a VOX number in their user data, it’s Voicemail will be automatically
disabled.
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without extended voice authorization

Once a user is assigned a VOX number, voicemail is activated and the standard project is used.

- Up to OfficeMaster 5.01 this is projectVox, from OfficeMaster 5.0.2 and so on is
eVoice_projectStart used.

- eVoice_projectStart automatically falls back to projectVox, if the license condition is not
met.

- eVoice_projectStart automatically falls back to projectVox, if no personal settings have
been made yet.

extended voice user

A user's personal profile is initially created as soon as the user himself or the administrator
wants to edit the profile for the first time. Through the intelligence of the website, a default
profile is generated. This creates a subfolder on the messaging server based on the the VOX
number from the user, which contains a profile description file.

The user can edit the following attributes:

- Load/edit/save own profile

- Language of automated announcements and telephone menu navigation

- PIN for remote inquiry

- Storage of the query-authorized phone numbers

- Change “To my phone” phone number

- Upload/record/rename/delete own announcements

- Assign action start points to individual days/time periods/weekdays

- Add announcements to action starting points

- Decide whether a message may be left for the action start points or only an
announcement should be made

Administrator for extended voice profiles

The following points are selectable in addition to the normal voice user:

- Load/edit someone else’s profile

- Change the Voice project

- Choose type of action start points between projects (subsequent selection of the target
project) and voicemail
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6.4.4. Audio files

The voice server works with file-level audio files. Here, the processing is project-based. If the
audio file greeting.raw is called in the project ivrExample_normal, the system first looks in the
subfolder ivrExample_normal for this file. If it is not found there, the system searches for it on a
global level in the Audio folder.

This results in the possibility of both different files to maintain various sub-projects on one
level, as well same-named files with different content in each projects to use.
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6.5. Central conversion

One of the most important functions of the OfficeMaster Suite is the central conversion of the
documents on the server. This involves converting documents that are to be sent by calling
third-party software such as Libre Office, Microsoft Word or Adobe Acrobat Reader. This
documents to be sent are converted into a graphic format, but also into PDFs (for NGDX).

If you have Libre Office installed on the server, the central converter will, after the successful
installation of the OfficeMaster Suite, immediately be ready for use and does not need to be
configured further.

If you want to use Microsoft Office instead of LibreOffice, you have to you set up an additional
converter. We recommend the use of the OLE converter.

6.5.1. OLE converter when using Microsoft Office

The OLE converter described below uses the Conversion Microsoft Office. When UAC is on, it can
([Uf.underline}ser [Al{.underline}ccess [Cl{.underline}control) be used.

Creation of the OLE converter

In the quick launch bar of the Messaging Server Configuration, go to Converter > OLE Converter
and then add a new component of this type.

a Messaging Server Configuration

File Edit View Tools Help

Qi Wl OLF Converter (OLECONV)
Search Components

Base component
v System A

Component Table About
> %] Undeliverable
Transfer DB

Optionally enabled component that uses Microsoft Office and ghostscript to convert documents.

v Converter What's new
> [aZ] Base Converter
> [l cmd converter Overview
m OLE Converter New OLE Converter component... I
v Telephony
v OfficeMaster Gate Available OLE Converter components 0
[ oOfficeMaster Gate Name Display name Startup Type Status Status Message

v X SIP Trunk

Figure 6.24: Creating a new OLE converter
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The creation of this new component is accompanied by a wizard, where the question for a
service account takes place.

Warning!
This service account must be a local administrator!

I?J Messaging Server Component Wizard X

Set Credentials M
Specify the account for the OLE usage of the component OLECONV. fleec"trg]nf!

Itis required to use a service account for this component. Specify the account for the OLE usage of the
component OLECONV. The account should be a local administrator of the component's host server. A
mailbox for the account is not required.

User: | | u

Password: | |

Figure 6.25: Entering the service account in the wizard for the OLE converter

The subsequent naming dialogs correspond to the standard wizard and can be implemented
accordingly. After the OLE converter has been successfully created, the general configuration of
the component will be available.
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a Messaging Server Configuration
File Edit View Tools Help

Quicklaunch

ISearch Components

v [3 system
Component Table
> | Undeliverable
Transfer DB
v [3 converter
> @ Base Converter
> Cmd Converter
v B OLE Converter
O oleconvo
v [ Telephony
> OfficeMaster Gate
v Q SIPTrunk
0O sipo
DO swe2
O sipt1
v 3 ewai
> E3 Receiving
> B Sending
v [&) LDAP/SMTP Connector
O mailgwo
v 3 sms
@ SMS via IP-Provider (...
[2) SMS via USB Modem

OLE Converter
OLE Converter (oleconv0)

Common

Internal PDF Conversion

Components:
[] poF Conversion enabled
OLE Office Conversion
Components:
@ [] winword Conversion enabled

[] rRTF Conversion enabled

[C] HTML Conversion enabled

[] Excel Conversion enabled

[] Powerpoint Conversion enabled

[] visio Conversion enabled

[ advanced Processing

Internal Image Conversion

Components:
@ [] T1F Conversion enabled
[] GIF Conversion enabled

[] 3pG Conversion enabled
[C] BMP Conversion enabled

TIF Optimization/Scaling
GIF Optimization/Scaling
JPG Optimization/Scaling
BMP Optimization/Scaling

Figure 6.26: Configuration overview of the OLE converter for Microsoft Office and PDF

Internal PDF conversion

Enable PDF conversion

If the PDF convertion should be done by the OLE converter, the corresponding check mark must

be set here.

OLE Office conversion

The document types for which the converter is to register are selected here. Only if the
registration for a document type is carried out, the document can be converted by OLE

converter into a graphic.
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Internal image converter

If the converter is also to be used for graphic formats, click here to activate the appropriate

format.

Deregistering the default converter for the desired formats

Enter in the configuration of the command line converter to deactivate the (undesirable)

desired formats accordingly.

a Messaging Server Configuration

File Edit View Tools Help

Quicklaunch

ISearch Components

v System
Component Table
> F] Undeliverable
Transfer DB
v Converter
> @ Base Converter
v Cmd Converter
[ cmdconvo
v m OLE Converter
D oleconvo
v Telephony
> OfficeMaster Gate
v Q sPTrunk
0 sipo
O swr2
O sip1
v E-Mail
> 3 Receiving

Figure 6.27: Disable formats in the command line converter

Then restart both converters to achieve correct job processing.

Command Line Converter *** default ***

CmdConverter (cmdconv0)

Common

Basic Conversion

[] pisplay system job id in status line

[] pisable Ms Word Document (DOC, DOCX)

[] pisable MS Excel Document (XLS, XLSX)

[] pisable MS Powerpoint Document (PPT, PPTX)
[[] pisable web page document (HTM/HTML)

[[] pisable Rich Text Format (RTF)

[] pisable Portable Document Format (PDF)

LibreOffice Conversion

[] pisable Rich Text Format (RTF) -> Portable Document Format (PDF)
[] pisable Web page document (HTM/HTML) -> Portable Document Format (PDF)

Command Line Parameters

| —-headless --convert-to pdfiwriter_pdf_Export --outdir "%p™ "%i"

6.5.2. Base converter (BASECONV)

When installing the OfficeMaster Suite, a basic converter is also installed. This is responsible for

converting incoming messages.
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6.6. Automatic printing for received faxes

To print received faxes automatically on network printers, the messaging server has the
PRINTGW component, to which receives call numbers can be assigned. In addition, PRINTGW can
be assigned to print documents by other messaging server components, such as SAPCONN and
Undeliverable (UNDLVRBL). To confgure such thing, go to the quick start bar under Print >
Network Printer. First you need to create a new component and then you can configure it.

{54 Messaging Server Configuration - m} X
File Edit View Tools Help >
Quicklaunch X - Actions
Network Printer
Search Components Fax Printing (printgw0) Apply
v () LDAP/SMTP Connector A
i £ Reload
O mailgwo Settings
v 5 s [ Remove Component...
~ Printer List Restore Defaults
¥ SMS via IP-Provider (... estore Defaut
[2) sMS via USB Modem New... [EEdt.. X Delete 83 Properties...
@ SMS Submission via U... Name Tray Filter First Page Only
¥ SMS Reception via U... \\server\... Lower  .* no
> [3 Exchange
> [3 Notes
> B sap
v Web/Files Services
v 8 Filesystem Connector
O flegwo
@i Web Connector
ePost Connector
XRechnung Connector
Web API |Help B X
v 3 printjocr Default Printer [search Help
v 6 Network Printer Printer name | \\Server Printer (Example) ~] Settings 2
D printgwo v Tray ‘ <Default> v
[ print only the first page Printer fist
El Component Status... N
A Printer
Misct s
Job Status... . . If the PRINTGW is started in the
@ [ print status line component status of the
OfficeMaster Suite configuration,
°§ License Status... Display system jobid in status line it first searches for all printers !
[ pisable printer search on startup available in the network (e.q. all
_ in the Windows domain). One of
@ Log Files. .. Requeue Interval: these printers can then be
assigned in the desired PRINTGW
. component. Alternatively, the
v Job Routing... printer name or IP~Adress_ can v
@ Administrator 10.12.2022 ] localhost

Figure 6.28: Add printer as output for messages

If the printing of received faxes is to take place on several printers distributed in the house, you

can also use descriptive names like printgwSales or printgwFiBu, if each PRINTGW is to serve

only one printer.

Host is usually the IP address or the resolved name of the OfficeMaster Suite Server.
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6.7. Basic or system settings

The settings are divided into the following sub-items:

- General, next section

- Error handling, see call routing section for details
- International, see call routing section for details

- Drain mode, controlled shutdown or idling of the OfficeMaster Suite, details will follow.

6.71. General settings

6.7. Basic or system settings

Here you will find the setting options for the entire OfficeMaster Suite. These settings are cross-

component.

@ System Settings

Common Error Processing International Monitoring Scripts

Language

Specifies the Messaging Server language for status notifications and
@ status messages.

<default> v
Transmission

Q Number of rotated log files to keep 4 ¥
Rotate every day or when file size exceeds
Keep send/receive protocols of the last
[ Enable fallback processing
[] continue aborted faxmessages
Minimum free hard disk space

SMS
E Split short messages with more then 160 characters.
Maximum parts | 10 = Partmarking |n/m <body> ¥

[] send short messages with higher priority than faxes

Figure 6.29: General system settings

Language

With this global language setting you set the language for status messages (to users and

administrators).
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Transmission

Store component log files for

In the delivery state, the log files are saved for 4 days and then overwritten. These are rotating
log files.

Keep send/receive logs for

Leave the value at the default (0 days) if new created daily logs should never be deleted.
However, to request the deletion of the logs in a specific time, please enter the time in days
here.

Enable fallback mechanisms

The messaging server works internally according to defined routing rules. Each sending and
receiving component registers for one certain type of orders. If the transfer of a job transfer is
repeatedly faulty, the job will be transferred to another component that has another registered
component for fallback routing.

Resume abandoned faxes

When using DirectSIP (fsip) it is possible to use this option. In this way, in the event of a fax
transfer being aborted (outgoing), the aborted faxes are “forwarded/resent”. The normal send
retries are taken into account in this case.

Minimum free disk space

If the minimum free memory capacity specified here is reached, the OfficeMaster Suite will no
longer accept messages.

SMS

Here you can set whether short messages with more than 160 characters should to be split and
the maximum number of set text messages for an order.

In addition, SMS can optionally be sent with a higher priority than faxes.



7. Connector for Microsoft Exchange



121 6.7. Basic or system settings

The Exchange Connector in its three forms is used by the majority of messaging server
installations.

{54 Messaging Server Configuration - a X
File Edit View Tools Help >
SEENTS x Component Status ctions

Search Components Overview about all system components Expand all “
v System A

Collapse all

) comporen TP—
B Component Table pon care - Expand all Groups

> % Undeliverable
Transfer DB Component Status " Collapse all Groups
rans @ Basic Converter [baseconv] ctart
> B converter (@) cmdConverter [emdconvo] P star
> [0 Telephony (@ configuration component [CFGPROXY] Port:49004-ocal 0 stop
> B3 Ewmail (@ Configuration Server [CFG] Port:43002-ocal || Pause
s B sms v (@ Connector for BCS (OUTLOOK-OFFICE365-MSX19... > Continue
> [ Exchange v © Connector License Restart
@ Fax 5 Benutzer registriert (Kein Benutzer mehr auf dem Ser
> [ Notes s } £ 3 Refresh
@ SMS 5 Benutzer registriert (Kein Benutzer mehr auf dem Ser =7
> Dswe @ Voice 5 Benutzer registriert (Kein Benutzer mehr auf dem Sel D show configuration...
> [0 web/Files Services > (@ Fax-Gateway Cloud/Online Faxconnector bereit v Show log
> B3 PrintfocrR = = - = : = 1 Propers
roperties...
> [ voice v

@ Component Status... i
® 8 O Available jobs: 0 0 Hide Base Components

@ Job Status... o} State Component Sender Show Working Only v

0 License Status... i =) ¢
£ )

E Log Files...

4% J0b Routing... < 5

@® Administrator 19.08.2022 () Maintenance Mode il localhost .

Figure 71: Configuration of the Exchange Connector

This documentation describes the installation and configuration of the connector for Microsoft
365 on the Version 8.0 of the OfficeMaster Server.
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71. General

711. What is the OfficeMaster Connector for Microsoft 3657

Since OfficeMaster 4.0, an additional Exchange connector for online services has been offered.
This connector is a further development of the proven Exchange connector msx2kgate.

msxbcsgate (Microsoft Exchange Business Communication Services Gateway)
The development of the new connector pursued the following goals:

- Compatibility with previous versions

- Possibility to use an existing Active Directory

- Can also be used in on-premise and hybrid scenarios

- No storage of connector configurations in Active Directory

- Use of the known and proven administration tools

- Bidirectional support of the Exchange Server transmission format (TNEF)

Advantages:

- Easy installation

- No lower permissions required in the Exchange organization

- Can be used for Microsoft 365 (Full Featured)

- No use of MAPI for mailbox access

- Use of existing user configuration in Active Directory for on-premise and hybrid
installations

Particularities:

- SMTP transfer connectors must be created manually for on-premise installations

71.2. Areas of application

The product is an Exchange Connector for fax, SMS and voice mail services. It can connect all
installation forms of Exchange Server-based messaging environments.

- Connection to Microsoft 365

- Connection to Microsoft 365 / Exchange 2019 On-Premise Hybrid
- Connection to Microsoft Exchange Server 2013 On-Premise

- Connection to Microsoft Exchange Server 2016 On-Premise
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71.3. Differences to older previous versions

The previous versions of OfficeMaster Revisions 4 and 5 always required an existing local Active
Directory. The connection of these connectors does not support voice mailboxes. These
shortcomings have been eliminated from version 6 onwards.

71.4. Differences to the pure Exchange Connector MSX2KGATE

The Online Connector msxbcsgate has the following differences to the Exchange Connector
msx2kgate:

- The msx2kgate traditionally requires a Microsoft Active Directory with an intact Exchange
Server organization.

- The Online Connector msxbcsgate always stores its configuration data in a data file. No
node is created in an Active Directory. Therefore the Connector does not necessarily
require an Active Directory.

- The Online Connector msxbcsgate can support the individual user configuration by saving
the values in the Active Directory in a way that is compatible with msx2kgate. However,
this is only a compatibility for migration environments. The msxbcsgate supports the
storage of individual data directly in the Microsoft 365. Therefore, the connector does not
necessarily require an Active Directory here either.

- The online connector msxbcsgate supports mail transfer via a transfer mailbox (service
transfer mode). This can avoid the outbound SMTP transfer over the Internet.

- The Online Connector is optimized to communicate directly with Microsoft's
Mailprotection endpoint.

- The msxbcsgate installation wizard supports direct communication with Microsoft 365.

71.5. General requirements

To use the connector for Microsoft 365, an OfficeMaster installation is required. Ideally, ISDN
hardware or VolP access points should be correctly installed. This means that ideally there
should be a correct hardware connection.

Prerequisites:

- Microsoft Windows Server 2012 (32Bit or 64Bit) or higher
- Microsoft Windows 8 (32Bit or 64Bit) or higher
- Microsoft .Net Framework 4.5 Client Profile



124 71. General

71.6. Modern authentication and communication with
Exchange Online/Azure AD

Secure authentication forms the basis for the installation and administration of the
components in Microsoft 365. In this case, the concept of “modern authentication” refers to
manual login via the web, usually with OAuth 2.0 mechanisms, possibly with multi-factor
authentication, in order to ensure secure interactive login.

Applications/programs that access interfaces of Microsoft 365 (Azure AD, etc.) via the Internet
must also support this “modern authentication”. Older programs designed for on-premises
Exchange Servers can be used to communicate with the interfaces that use basic
authentication. However, since this is less secure, support for this basic authentication in the
cloud will be gradually switched off (MC375736).

The configuration of modern authentication was available for the first time in July 2020 in the
Azure AD portal under the item “Modern Authentication”

Microsoft 365 admin center

Services  Security & privacy ~ Organization profile O Ssearch all settings
( Home
R Users v B
29 items =
2 Groups v
8 Billing v Name T Description
@ Settings AN P"iq Microsoft Planner Choose whether your users can publish plans and assigned tasks to
Domains N . . .
%] Microsoft Teams Manage and update your Microsoft Teams settings.
Microsoft Search
I Org settings 0’ Microsoft To Do Manage and update your To Do settings.
Add-ins L § . |
g Modern authentication Change Exchange Online authentication settings for your ¢
Partner relationships
5 Multi-factor authentication Manage multi-factor authentication settings for your userg
Va Setup
@ MyAnalytics Manage and update MyAnalytics settings.
Admin centers = ~

Figure 7.2: Organization Configuration - Modern Authentication

Up to version 7, the OfficeMaster BCS connector communicated exclusively with Microsoft 365
Exchange Online via the Exchange Web Services. This was changed from version 8.0, as
Microsoft will no longer support the creation of applications for the Exchange Web Services in
the future (MC296195).

As of version 8.0, OfficeMaster will no longer create applications in Azure AD that are based on
Exchange Web Services (EWS). As an alternative, OfficeMaster will create an application based
on the Microsoft Graph interface.
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This way is the official interface that Microsoft mandates and supports for mail-based
applications.

71.7. Existing installations

With a pure update to OfficeMaster Version 8, the form of communication between the
connectors will not change automatically. The pure update only updates the program
components. The cloud installation remains as it was before the installation.

Hybrid Installations

- As long as communication based on Exchange Web Services is technically possible in the
cloud, a connector can communicate with Exchange Online.

- If EWS communication is no longer possible, the connector should be overinstalled and
the communication (see Point 5) changed.

Native installations without local AD

- As long as communication based on Exchange Web Services is technically possible in the
cloud, a connector can communicate with Exchange Online. Then nothing changes.

- If EWS communication is no longer possible, the connector should be overinstalled and
the communication changed.

However, the addressing of the fax addresses will then change.
Notice about native installations!

When changing the communication to the Microsoft Graph interface, the addresses
must be changed. Pure FAX, SMS or VOX address types will then no longer be
recognized or supported!

71.8. New Installations

In the course of future-proof communication to the services of the cloud, access to Exchange
Online should take place with the Microsoft Graph interface. A downgrade to the EWS interface
is not possible. The installation is largely automated. The degree of manual intervention can be
chosen to be minimal during installation.
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7.2. Connection to Microsoft 365 Exchange
Online

7.21. General information

Microsoft Active Directory is not required for the pure connection to a Microsoft 365 service. The
connector only requires an existing internet connection to access the Microsoft 365 server.

Since the connection to Microsoft 365 does not require Active Directory, the user-specific
settings can be saved directly in the corresponding user’s Azure AD (native). However, in a
hybrid scenario, on-premises AD can also be used. This is the preferred installation variant
(hybrid). All Unified Messaging services that are also available with a normal Exchange
Connector are supported with this connection.

The installation wizard carries out all important installation steps in the cloud automatically.
Technically, however, it is also possible to carry out these individual steps using the Microsoft
365 administration console or Exchange Onlineoffice365 PowerShell.

7.2.2. Installation requirements

Sign in to Microsoft 365 with an Organization Administrator account

An internet connection is required to install the connector. A Microsoft 365 sign-in is performed
during the installation. This login refers to an administrative account that contains the
necessary rights to create objects in the Microsoft 365 Exchange area (organization
administrator).

Note!

The installation account is not a service account. This is primarily an administrative
registration for the installation. This account must never be used as a service
account.

Microsoft 365 service transfer account

The Microsoft 365 connector distinguishes between two transmission modes:

1. Service transfer mode
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2. Internet transmission mode

With the service transfer mode, outgoing messages are not sent to the OfficeMaster
Server via the Internet, but are redirected to an internal Microsoft 365 mailbox. This
saves time-consuming administration of the SMTP route to the OfficeMaster Server
(MX record, provider, etc.)

The Internet transmission mode is the classic transmission type of outgoing
messages to the OfficeMaster Server via the Internet. A unique fax and SMS domain
is selected (e.g. fax.domain.de, sms.domain.de), which is then linked to an Internet
provider with a MX record that points to the public Internet address of the
OfficeMaster Servers or an existing frontend server.

In general, a transfer mailbox must always be created, which temporarily buffers the outgoing
messages before the OfficeMaster Server picks them up. For this purpose, the size limit of this
mailbox should be adjusted accordingly in order to be able to handle any bulk faxes.

7.2.3. Installation

® Messaging Server Configuration - a X
File Edit View Tools Help >
Quicklaunch X . A || Actions
| Office 365 / Exchange Online Connector (MSXBCSGATE)
[search Components | Product/License: Connector (NGDX/FAX and Voice) [ New...
v 3 system [ Eit...
Component Table About Remove
> % undeliverable
This connector retrieves user data from the user data of the configured tenant and manages the messages in the mailbox store of the respective D> Start
Transfer DB user account using SMTP and Exchange Web Services.
> [ converter i O Stop
What's new
> [3 Telephony Il Pause
v E-Mail Overview |D> Continue
N - Ry t
9 Rece!vng New Exchange Connector... estar
» Sending {3 Refresh
(&) LDAP/SMTP Connector Available Exchange Connectors pel N .
> B sms £83 Properties...
Name Display name Startup Type Status Status Message
v Exchange
> E:l On-Premises
3 Hybrid / Cloud
C@ Mail Archive
> [ Notes
> O sae
> B3 webjFiles Services < 2
> .
D prmiock Processing Jobs L
> B3 voice -
s B Signature D State Component Sender Receiver
@ Component Status...
£3 10bstatus..
N License Status...
< >
g Log Files...
‘H’ Job Routing... -
Time Status Text | v

@ Administrator 19.08.2021 il localhost .

The connector is installed in the properties of the component administration for the Exchange/
Online services.
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The installation wizard for BCS connectors will be open, when you want to add a new connector
or change the current connector.

® MS Exchange Online Connector Wizard X

Installation Type Selection -
Please select the preferred Type of installation. Fe1 ra rl
electronic

] Office 365

(® Native Microsoft Office365 completely in doud
(O Microsoft Office365 hybrid installation with local Active Directory

Provider: I Microsoft Office365 International (outlook.office365.com) v

@8 Exchange

(O On-Premises Exchange Server

<Back [ Next> || cancel

Figure 7.3: Organization Configuration - Modern Authentication
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@ MS Exchange Online Connector Wizard X

OfficeMaster for MS Exchange Online Services

The wizard will guide you through the installation or the removal of a MS Exchange Server Online Services connector
component.

Please ensure that the component account has appropriate rights for the MS Exchange Server environment.

Installation Options:

(® Install Connector Component

Fe" ra rl O Remove Connector Component
electronic

To continue, dlick Next.

<Back [ Next || cCancel

Figure 74: Installation wizard selection dialog

The figure above shows the selection dialog of the installation wizard. If the Microsoft 365
installations is selected, a login to the Microsoft 365 cloud is then made. Cloud login supports
multi-factor authentication.

Note!

This registration is carried out internally via a remote powershell. Certain
requirements must be met for this:

- Presence of Microsoft Powershell at least version 5.0

- Enhanced security mode for Internet Explorer MUST be disabled. The
Powershell modules work with an internal browser module for the login
dialogs, which cannot work correctly without JavaScript execution and access
to the cloud login endpoints.

Note!

If this login to the cloud is done for the first time by the installing account,
modules may have to be installed later. This can take a moment. A dialog indicates
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the post-installation. After closing this dialog, the display of the login window can
also be delayed by around 30 seconds.

1) OfficeMaster - Advanced Powershell Installation X

Prerequisites

Instzll ExchangeOnline Interface.

Please wait until the installation prereguisites are installed properly.

This will take 2 moment.

After successfully logging into the cloud, you get to the next wizard page. At this point, the
transport is preconfigured. This step does not differ from the previous version.

Note!

- The successful and correct login to the cloud is shown with the correct
display of the name of the organization.

- BCS connectors work in the cloud exclusively in service transfer mode, i.e. the
outgoing messages are collected in a previously created mailbox. This
transfer mailbox can also be a shared folder. The mailbox must first be
created manually. This mailbox cannot be the default recipient! A transfer
mailbox must always be provided!

- The transfer domains are created by default with the name of the
organization. From experience, this should be changed to shorter domains.
These domains do not need to have a DNS mail exchanger record, since the
mails are intercepted by rule.

- The transfer domains should have a vox type to support read receipts for
voice. (Turn off MWI lights when voicemails are read.)

When selecting the transfer mailbox, care must be taken to ensure that this is not an existing
mailbox that a user is using. Incoming e-mails are processed, evaluated and moved. If an
existing user mailbox is used, there could be a corresponding loss of data. The mailbox to be
used is to be used exclusively for transfer purposes.
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% MS Exchange Online Connector Wizard X

Transport Type Selection -
Please select the preferred transport mode. Fe1 rari

electronic

Organization:

Transfer Mode:

Address Spaces:

Messaging Server:

Transfer Domains:

| MSX 19MRCLIENT v

| ferraricloud.onmicrosoft.com

Internet Transfer Mode

(® Service Transfer Mode

| transfer @ferraricdoud. onmicrosoft.com

The transfer mailbox will be accessed by the connector component. The mailbox content may be processed. To prevent loss
of any important user specific mailbox content, please do not use an existing personal user mailbox. In modern
authentication scenarios a transfer mailbox is mandatory.

| fax.local,sms.local,vox.local
FAX
SMS

Help

T e

Messaging Server

The server on which the connector component is ultimately to be executed as an instance, can
be selected in the Messaging Server input field. In the standard case, the field shows the
OfficeMaster server. This field is purely informative.

Organization

In pure Microsoft 365 mode, this field only displays the read name of the organization of the
current Microsoft 365 login. In this case, the field cannot be written on and is also only used for

information.

Transfer mode

At this point the transfer mode can be selected. The mode is set to “Internet transmission

mode” by default. It is generally recommended to change the mode to “Service Transfer Mode”

for convenience.
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Internet transmission mode

The Internet transmission mode is the classic form of transmission of outgoing documents to
the OfficeMaster Server. The term “outgoing” specifies the direction from the mail client to the
fax server. This is traditionally done over the Internet using the SMTP protocol. This form of
transmission has some disadvantages and hurdles:

- In order to configure the OfficeMaster server for SMTP reception from the Internet, the
server or SMTP reception must be accessible over the Internet. This is usually
accomplished by front-end servers or by your own port forwarding scenarios. However,
the OfficeMaster Server can now be reached from the Internet. The OfficeMaster Server
has no SPAM or malware protection mechanisms. These would have to be additionally
installed as third-party software if required.

- In order to correctly transport an e-mail with a domain specification, the selected domain
(transport domain) must be linked to the IP address of the OfficeMaster. This means that
the sending server (Microsoft 365) uses the domain to determine the address of the
OfficeMaster computer. Such a configuration is made via a MX record, which is usually
entered by an Internet provider in a global DNS server.

These configurations must always be made manually for the Internet transport of outgoing
messages.

Service transfer mode

The service transfer mode uses a dedicated mailbox for outgoing message transport that is
addressed by msxbcsgate. The contained e-mails, which are exclusively outgoing messages, are
then processed and deleted. This method has advantages, but also disadvantages:

Advantages:

- FAX and SMS addresses can be used without restrictions. There is no
obligation to use fax domains or SMS domains.

- Any values can be configured as transfer domains.

- Transfer SMTP domains do not have to be entered in global MX records.

- The OfficeMaster server does not have to be available as an SMTP server on
the Internet. Administration as an SMTP server is not required.

- A transfer of outgoing messages via SMTP via the Internet is no longer
necessary.

Cons:

- The transfer mailbox must have sufficient capacity to process any bulk
mailings.
- The transfer mailbox must always be accessible from the OfficeMaster server.
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- The transfer mailbox should be excluded from the password rotation.

The general recommendation is to use the service transfer mode, since this mode achieves
greater flexibility in transporting the messages. FAX and SMS address spaces can be used
without restrictions using this method.

Transfer Domains

Despite the possibility that the address spaces FAX and SMS are available in the service transfer
mode, transfer domains should definitely be specified. Transfer domains are SMTP domain
details that are used as fax or SMS sending domains. This domain information is also used for
incoming messages. The sender can then send his outgoing documents to fax
number@domain. By default, domains should be specified with the subdomain prefixes “fax”
and “sms”.

- e.g. fax.exampledomain.de, sms.exampledomain.de
The domains can be separated with a comma or a semicolon.
Note!

In the service transfer mode, the information can be any domain information.
With the Internet transfer mode, these domains must be known on the Internet via
an MX record. This information is then no longer arbitrary.

Address spaces

If the address spaces are activated, the traditional address spaces for FAX and SMS can be used
in the same way as the local Exchange Connector installations.

In addition to transfer domain addresses, users can use addressing like follow:

- [FAX:fax number]
- [SMS:Smsnumber]

Likewise, when activating the FAX address space, the local Outlook fax contacts can be used
without having to explicitly convert them to SMTP addresses.

Note!

Address spaces can only be activated in service transfer mode. In Internet transfer
mode, addressing is mandatory via transfer domains.
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% MS Exchange Online Connector Wizard X

Service Account Settings :
Please provide the service account for the connector. Fe1 ra '."
electronic

Existing registered application id, which is granted to access Office365 cloud and performs voice services and address book resolution:
Tenant Id:
Client Id: S Secret:
Obtain Client-Id and Client-Secret automatically via Azure AD
Use modern application authentication (only doud services)

Enable account for mandatory user configuration tasks

Existing local service account for direct access to the local Microsoft Active Directory:

Domain\Username: 4 Password:

Use cloud service account as Active Directory service account

OfficeMaster License Group which inherits all users, they are allowed to use the OfficeMaster Unified Messaging Services:
License Group: (® Default OfficeMaster License Group

(O specific Existing Group

r Help » < Back | Next > » Cancel

The next step takes you to the account and security settings.

The installation is designed for “modern authentication” by default. This cannot be changed in
the normal configuration.

The following steps are carried out internally for an application registration:

- The tenant ID (client ID) is determined.
- An application called “OfficeMaster Graph Access” is created in Azure AD.
- A client ID (application ID) and a client secret (secret) with a validity of 24 months are
generated for the “OfficeMaster Graph Access” application.
- The following API permissions are granted for the “OfficeMaster Graph Access”
application:
o Microsoft Graph: Calendars.Read (as application permission)
The permission is used for requests to users’ calendars. This is used for voice
calendar queries to determine automatic free/busy statuses.
o Microsoft Graph: GroupMember.Read.All (as application permission)
The permission is used for requests to user groups. Distribution lists may have to
be broken down for incoming fax or SMS messages. This authorization is also used
for using the OfficeMaster license group.
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o Microsoft Graph: Mail.ReadWrite (as application permission)
This authorization is used for reading the e-mails in the user mailbox. At least this
authorization is required for the transfer mailbox.

o Microsoft Graph: Mail.Send (as application permission)
This authorization is set in order to be able to send e-mails via the users and the
transfer mailbox. The connector uses this technology to carry out LPD mail
dispatches and to be able to send e-mails from the transfer account to users.

o Microsoft Graph: People.Read.All (as application permission)
This permission is used for requests to the cloud address lists.

o Microsoft Graph: User.Read (as delegated permission)
This authorization is set automatically and has no meaning for the connector.

o Microsoft Graph: User.Read.All (as application permission)
This permission is used for requests to the cloud address lists.

o Microsoft Graph: User.ReadWrite.All (as application permission)
This authorization is required if individual user data is to be saved.

If the client ID and the client secret have been created manually beforehand, they can simply
be entered. In this case, the option “Obtain program ID and secret automatically from Azure AD
must be deactivated. The values can then simply be specified.

”

If the tenant ID (client ID) is not known in such case, it can be determined automatically using
the browser button.

The installation offers another option for preconfiguration. In some cases, the application has
already been registered in Azure AD. In this case, perhaps no new application should be
created. If so, a search window for applications can be called up via the browser button of the
client id.
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OfficeMaster - Find registered applications

Find

Search for registered applications.

Search in: lfenaidoud.ouicmwﬂ .com v ]

Name: | | Find
Name Description Location A
E?". OfficeMaster Graph Access Application ferraricloud.onmicrosoft.com

v
< >

create a new client secret for the selected application id

valid until Fretag . 1. November 2024

The special feature of a selected application is that no secret (client secret) can be read out. If
this secret is not known, a new secret can be created during selection. Such secrets have a
specific time limit. This can be set in the dialog.

Note!

Apparently, a special service account is not necessary for access to Exchange
Online with modern authentication with tenant ID, client ID and client secret. In
this case, a transfer mailbox is still required for the outgoing messages. Whether
this mailbox has multi-factor authentication protection is not important and is
irrelevant for the connector.
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Note!

If the check box for using modern authentication is deactivated in the installation
step for the account and security settings, the user name and password of a service
account can be specified as in the previous version. This is no longer generally
recommended or supported.

¥ MS Exchange Online Connector Wizard X

Installation -
The wizard will now install the specified components. Fe1 ra rl
electronic

Informationen

(O] Using logfile: C:\Users\ferrari.MSX 19MRDOM\FerrariLogFiles\finstallhelp.log
® Create application registration in Azure AD.

@ Created application id: b46c8f17-1b62-4deb-add 1-c652475¢ 72 15

(@ Used tenantid: 10511df3-e435-4b2e-92b9-28d4ee9as0cd

@ Created dient secret: Digzl...

@ Installation begins.

@ Base Node will be installed.

(@ Base Node will be installed as file.

(D A license group creation in Active Directory is not required.

@ Active Directory Gateway Node will be created as file.

(O] Existing Gateway Node will be corrected.

@ Configuring transport settings. This may take some time.

(@ The transfer mode connector was successfully created.

@® Anew license group will be created.

@ License group 'OfficeMasterLicenseGroup @ferraricoud.onmicrosoft.com' will be used.
@ A SMTPRX creation is not required.

Installation completed.

Help < Back | Next > | Cancel

With the following installation steps, the connector can be installed as with the previous
version.
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‘é’ MS Exchange Online Connector Wizard X

Installation Parameters

Please provide required parameters to complete the installation. Fe1 ra '."
electronic

Shared configuration file to store connector specific settings. This file must be imported into the OfficeMaster Exchange Administration program.
Filepath: | \WMSX 19MRCLIENT\FFACCESS \connectorconfiguration.cfl | [

Administration storage points to store user spedific settings. If mailbox store is selected and predecessor user settings are stored in Active
Directory user objects, these settings can be migrated to user's mailbox via external administration tools.

User Settings Store: | Azyre AD Open Extension 2
Global Settings Store:  shared Configuration File X
I\\MSX 18MRCLIENT\FFACCESS \connectorconfiguration.cfg | j

Help <Back || Next | Cancel

During the installation of the Azure AD application, a message appears:

‘éf” Installation Information
New created applications must be granted by administrators. Please go to the Azure AD
administration and grant the admin consent for 'OfficeMaster Graph Access'.

[oc ]

This notice relates to APl permissions. For security reasons, automatic confirmation of the
release of APl permissions was deliberately avoided. This must be done by an administrator in
Azure AD after installation. If there are any concerns, the corresponding authorizations should
be subsequently adapted to the (security) needs of the solution.

To do this, log on to the Azure AD of the Microsoft 365 tenant and navigate to the “OfficeMaster
Graph Access” application:
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Azure Active Directory admin center 8]
FERRARI ELECTRONIC AG &P

»

Dashboard > Ferrari electronic AG

1

: Ferrari electronic AG | App registrations  # - X

Azure Active Directory

i

* « -+ New registration i< Endpoints Va Troubleshooting () Refresh L Download
> @ overview -
® Preview features
— o Starting June 30th, 2020 we will no longer add any new features to Azure Active Directory Authentication Library
s K Diagnose and solve problems (ADAL) and Azure AD Graph. We will continue to provide technical support and security updates but we will no
=l longer provide feature updates. Applications will need to be upgraded to Microsoft Authentication Library (MSAL)
and Microsoft Graph. Learn more
Manage
& Users
All applications Owned applications  Deleted applications
& Groups _—
6E External Identities J Start typing a display name or application (client) ID to filter these r... Fy Add filters

&, Roles and administrators

5 applications found -
& Administrative units
ISplay name ication (clien reateda on Ty ertiricates & secrets
Display T Application (client) ID  Created on 1y  Certificates & t:
® Delegated admin partners .
OfficeMaster Fax Options ee9ccSec-5fa9-4fds-9... 11/26/2021 @ current
# Enterprise applications
B8 Devices OfficeMaster Graph Access 16746620-585b-4cbc-... 5/11/2022 @ current

% App registrations

Dashboard » Ferrari electronic AG | App registrations >

[ o
i OfficeMaster Graph Access - X
* | P search | « ] Delete & endpoints [ Preview features
> B overview = -
& & Quickstart . 4?\ . a
e . N ﬂ
= #  Integration assistant > t‘ 5
® .
Manage x
& Branding & rt S . .
fancing & properties Call APIs Sign in users in 5 minutes
D Authentication Build more powerful apps with rich user and Use our SDKSs to sign in users and call APIs in a few
Certificates & secret: business data from Microsoft services and your own steps. Use the guickstarts to start a web app, mobile
ertificates & secrets company's data sources. app, SPA, or daemon app.

m ) .
il Token configuration View API permissions View all quickstart guides

- API permissions

& Expose an AP

§4 App roles

& Owners ®

» Roles and administrators v v

Be

After selecting the application, the API permissions can be listed.

The API permissions must now be confirmed. This step only has to be carried out once for an
application.

Note!

In this step, the authorizations can be redesigned according to customer
requirements. Changing the permissions may have a negative impact on the
productive operation of the connector.
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After releasing the APl permissions, the connector can be put into operation like the previous

version.

re Active Directory admin center

Dashboard » Ferrari electronic AG | App registrations > OfficeMaster Graph Access

FERRARI ELECTRONIC AG

- OfficeMaster Graph Access | API permissions = X
* | P Search | « O Refresh ,6? Got feedback?
4 a -
> B owniew Configured permissions
& & Quickstart Applications are authorized to call APIs when they are granted permissions by users/admins as part of the consent process. The list of
= configured permissions should include all the permissions the application needs. Learn more about permissions and consent
# Integration assistant
-+ Add a permission /' Grant admin consent for Ferrari electronic AG
Manage
) . API / Permissions n... Type Description Admin consent req...  Status
B2 Branding & properties y
Vv Mi ft Graph (6] A
3 Authentication icrosoft Graph (6)
N . CalendarsRead  Application Read calendars in all mailboxes Yes &\ Notgranted for Ferrari ,  +=+
U Certificates & secrets
S GroupMember.Rez Application Read all group memberships Yes A Not granted for Ferrari,,  +*+
Il Token configuration roupliember PP group P g
. MailReadWrite  Application Read and write mail in all mailbo... Yes &\ Not granted for Ferrari | *+*
9~ API permissions
Mail.Send Application  Send mail as any user Yes A Not granted for Ferrari,,  +*+
& Expose an API elleen il Y g
. PeopleReadAll  Application Read all users' relevant people lists Yes A Not granted for Ferrari,, «*+
%4 App roles
User.Read Delegated  Sign in and read user profile No
& Owners st g © P
i, Roles and administrators v v
am ing Server Config - [m] X
File Edit View Tools Help >
Quicklaunch Actions
P — Component Status TN IINGE =
cerch ompens Overview about all system components Restart
(] smtprx0
DO smtprx1 Available components: 30 0 {3 Refresh
v B> Sendi .
- o g Component Status Current Statu A B show configuration...
smiptx0 > E-mail Show log...
v (&) LDAP/SMTP Connector v Microsoft Exchange {82 Propertes
D mailgwo v @ Connector for BCS (FTRAININGOS-VINCIOM2... Running
v SMS > @ Connector License Running Show All Components
@ SMS via IP-Provider (. > @ Fax-Gateway Cloud/Online Fax-Connector ready Running
@ SMS via USB Modem > @ Information Server Cloud/Online User information server ready Running Show Working Only
@ SMS Submission via U... > @ SMS-Gateway Cloud/Online SMS-Connector ready Running
@ SMS Reception via U... > @ Voice-Gateway Cloud/Online Voice Connector ready Running
v Exchange Connector for UMS (VINCIMX-VINCIOM22) [m... Stopped No grouping v
> Miscellaneous Gateways
v E] On-Premises hd > Other v [Heb 8 X
< > | Search Help
@ Component Status...
S component
@ Job Status...
©8 © Ao o |» |status
. ~
oﬁ 2 Stals s D State Component Sender If the component status is
selected, a summary is displayed
E Log Files... in the main panel, giving
information about the
components connected to the
t? Job Routing... messaging server.
< > v
@ Administrator 01.07.2025 1 localhost

After releasing the application permissions, the component can be started and should be ready

to use.
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7.3. Microsoft 365 Exchange Online with on-
premises Active Directory (hybrid)

7.31. General

Another type of installation is the hybrid installation. A local Active Directory is used to store
user information and determine SMTP addresses. The connector only requires an existing
internet connection to access the Microsoft 365 server. A connection to the local Active
Directory is also required.

The installation wizard carries out all important installation steps in the cloud automatically.
Technically, however, it is also possible to carry out these individual steps using the
administration console or PowerShell.

7.3.2. Installation requirements

Login to Microsoft 365 with an organization admin

An internet connection is required to install the connector. A Microsoft 365 sign-in is performed
during the installation. This login refers to an administrative account that contains the
necessary rights to create objects in the Microsoft 365 Exchange area (organization
administrator).

Note!

The installation account is not a service account. This is primarily an administrative
registration for the installation. This account must never be used as a service
account.

Microsoft 365 service transfer account

The Microsoft 365 connector distinguishes between two transmission modes:

- Service transfer mode
- Internet transmission mode

With the service transfer mode, outgoing messages are not sent to the OfficeMaster
Server via the Internet, but are redirected to an internal Microsoft 365 mailbox. This
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saves time-consuming administration of the SMTP route to the OfficeMaster Server
(MX record, provider, etc.)

The Internet transfer mode is the classic type of transfer of outgoing messages to
the OfficeMaster Server via the Internet. A unique fax and SMS domain is selected
(e.g. fax.domain.de, sms.domain.de), which is then linked to an Internet provider
with an MX record that points to the public Internet address of the OfficeMaster
Servers or an existing frontend server is configured.

In general, a transfer mailbox must always be created, which temporarily buffers the outgoing
messages before the OfficeMaster Server picks them up. For this purpose, the size limit of this
mailbox should be adjusted accordingly in order to be able to handle any bulk faxes.

Local Active Directory

The hybrid installation assumes that user-specific values can be stored in Microsoft Active
Directory. The main purpose of this type of installation is to migrate a local Exchange
installation to the Microsoft 365 cloud. The local Active Directory, which has the existing schema
extension of the Exchange organization, remains in place. The required attribute fields
(proxyAddresses, extensionAttributel15) are then available in the user objects.

If these attributes are not present because a new Active Directory was installed during the
migration, or if these attributes were never present because this is a new installation, there are
two ways to proceed.

1. Extension of the schema to the Exchange attributes In this case, such a schema
extension can be made later. With a test version of any Exchange server downloaded from
the Internet, the setup can be called with the following parameter:

Setup/PrepareSchema

Optional: In order to be able to create a global configuration node that is stored in Active
Directory, the following command can create the Active Directory requirements:

Setup/PrepareAD

However, this is usually not necessary, since the global configuration node can be created
using a configuration file. Such a schema extension should therefore be omitted.

2. Installation as a pure Microsoft 365 connection

If a schema extension is not to take place, the installation variant of the pure Microsoft
365 connection can completely ignore the local Active Directory.
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Local service account (access to local Active Directory)

The connector must have minimal access to the on-premises Active Directory to properly
authenticate users. His read permissions in the organizational units of the domains should be
correspondingly high.

There are several reasons for using a service account:

- Reading the configuration data of the connector stored in the Active Directory

- Reading global configuration values

- Resolve domain users and read user values

- Write customer specific values after configuration of voice parameters (own phone
number, voice box pin, etc.)

Such an account should have the following authorization structure:

- Member of the domain users group
- Local administrator of the installation computer
- Read access permissions on the path containing the configuration file
- (Installation option) Global data: Global Active Directory context
In this case, the service account needs organizational permissions (Exchange-ViewOnly-
Administrator). This setting is useful if connectors with this setting already exist.
- (installation option) Global data: Active Directory default context
In this case, the account does not need any additional permissions.
- (Installation option) Global Data: Common Configuration File
In this case, the account does not need any additional permissions.
- (Installation option) User data: Active Directory user object

If voice properties such as PIN or phone number values are also to be changed by
users via remote inquiry or Outlook client with the connector, the account must
have write permissions in the user objects of the connected domains. This is not
necessary if the data is stored in the user mailbox.

7.3.3. Installation

The connector is installed in the properties of the component administration for the Exchange/
Online services.



144

7.3. Microsoft 365 Exchange Online with on-premises Active Directory (hybrid)

@ Messaging Server Configuration
File Edit View Tools Help

Quicklaunch X . A | | Actions
| Office 365 / Exchange Online Connector (MSXBCSGATE)
|Search Components | Product/License: Connector (NGDX/FAX and Voice) New...
v 3 system [ Edt...
Component Table About Remove...
> %] Undeliverable
This connector retrieves user data from the user data of the configured tenant and manages the messages in the mailbox store of the respective D Start
Transfer DB user account using SMTP and Exchange Web Services.
> [3 converter ) O stop
What's new
> B3 Telephony || Pause
v 3 eMail . P Continue
» Overview |
’ E lvng New Exchange Connector... Restart
# Sending 3 Refresh
{£) LDAP/SMTP Connector Available Exchange Connectors pel 5 .
> D sMS @ Toperues...
Name Display name Startup Type Status Status Message
v Exchange
> E:I On-Premises
3 Hybrid / Cloud
C@ Mail Archive
> [ Notes
> O sae
> [3 webjFiles Services S Z
D prntoce Processing Jobs o
> [ voice ~
5 B signature D State Component Sender Receiver
B2 component status...
£3 10bstatus...
N License Status...
< >
a Log Files...
- »
4% Job Routing... -
Time Status Text | v

@ Administrator 19.08.2021 il locahost .

An installation wizard will now appear. The components should only be created and deleted

using this installation wizard.
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® Messaging Server Configuration - a X
File Edit View Tools Help
Quicklaunch X . A | | Actions
| Office 365 / Exchange Online Connector (MSXBCSGATE)
|Search Components | Product/License: Connector (NGDX/FAX and Voice) & New...
v System [ Eit...
Component Table About Remove...
> %] Undeliverable
This connector retrieves user data from the user data of the configured tenant and manages the messages in the mailbox store of the respective D Start
Transfer DB user account using SMTP and Exchange Web Services.
> [3 converter ) O stop
What's new
> B Telephony || Pause
v E-Mail Overview |D> Continue
> o
E Reoervng New Exchange Connector... Restart
# Sending 3 Refresh
LDAP/SMTP Connector Available Exchange Connectors pel
> B3 sms @ Properties...
Name Display name Startup Type Status Status Message
v Exchange
> E:I On-Premises
3 Hybrid / Cloud
C@ Mail Archive
> [ Notes
> O sae
> [3 webjFiles Services S Z
D prntoce Processing Jobs o
> [ voice ~
5 B signature D State Component Sender Receiver
E Component Status...
£3 10bstatus...
N License Status...
< >
E Log Files...
- »
4% Job Routing... -
Time Status Text | v
@® Administrator 19.08.2021 il locahost .

The welcome screen is followed by a dialog for selecting the type of installation. Three
installation forms are available:

1. Microsoft 365 as a full cloud installation
2. Microsoft 365 hybrid installation with on-premises Active Directory
3. Local Exchange Server Installation (On-Premise)

For Microsoft 365 hybrid installations with an on-premises Active Directory, the second type of
installation is used.

For the further creation of installation objects in Microsoft 365, a successful login to the
Microsoft 365 organization is required.
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% MS Exchange Online Connector Wizard X

Installation Type Selection -
Please select the preferred Type of installation. Fe1 rari

electronic
] Office 365
(O Native Microsoft Office365 completely in cloud
(® Microsoft Office365 hybrid installation with local Active Directory
Provider: | Microsoft Office365 International (outlook.office365.com) v

@aExchange

O On-Premises Exchange Server

< Back I Next > l Cancel ‘

This should be done using an administrative account that has appropriate organizational
permissions. The wizard will check the login and only release the next step if the login is
successful.
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% Microsoft
Sign in

Email, phone, or Skype

No account? Create one!

Can't access your account?

Back Next

Q Sign-in options

At this point, logging in with multi-factor authentication is also supported.

In the next step, the transport type is selected. The transport type determines how outgoing
documents are handled.
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% MS Exchange Online Connector Wizard X

Transport Type Selection -
Please select the preferred transport mode. Fe1 ra '."
electronic

Messaging Server: | MSX 19MRCLIENT ™
Organization: | ferraricloud.onmicrosoft.com
Transfer Mode: Internet Transfer Mode

(® Service Transfer Mode

| transfer @ferraricloud.onmicrosoft.com

The transfer mailbox will be accessed by the connector component. The mailbox content may be processed. To prevent loss
of any important user specific mailbox content, please do not use an existing personal user mailbox. In modern
authentication scenarios a transfer mailbox is mandatory.

Transfer Domains: |fax.local,sms.local,vox.local
Address Spaces: FAX
SMS

r Help » < Back | Next > » Cancel

The decision is important with regard to whether the outgoing documents should be
transferred via the Internet, or whether the documents should be collected in a collective
mailbox and then picked up by msxbcsgate.

Messaging Server

The server on which the connector component is ultimately to be executed as an instance can
be selected in the Messaging Server input field. The field has a purely informative character.

Organization

This field is the display of the parsed name of the organization of the current Microsoft 365
login. In this case, the field cannot be written on and is only used for information. If there is no
registration, the name of an organization or a main suffix of a domain can be entered here. This
information can serve as a template for the transfer domains.
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Transfer mode

At this point the transfer mode can be selected. The mode is set to “Internet transmission
mode” by default. It is generally recommended to change the mode to “Service Transfer Mode”
for convenience.

Internet transmission mode**

The Internet transmission mode is the classic form of transmission of outgoing documents to
the OfficeMaster Server. “Outgoing” here means the direction from the mail client to the fax
server. This is traditionally done over the Internet using the SMTP protocol. This form of
transmission has some disadvantages and hurdles:

- In order to configure the OfficeMaster server for SMTP reception from the Internet, the
server or SMTP reception must be accessible over the Internet. This is usually
accomplished by front-end servers or by your own port forwarding scenarios. However,
the OfficeMaster Server can now be reached from the Internet. The OfficeMaster Server
has no SPAM or malware protection mechanisms. These would have to be additionally
installed as third-party software if required.

- In order to correctly transport an e-mail with a domain specification, the selected domain
(transport domain) must be linked to the IP address of the OfficeMaster. i.e. based on the
domain, the sending server (Microsoft 365) the address of the OfficeMaster computer.
Such a configuration is made via an MX record, which is usually entered by an Internet
provider in a global DNS server.

These configurations must always be made manually for the Internet transport of outgoing
messages.

Service transfer mode

The service transfer mode uses a dedicated mailbox for outgoing message transport that is
addressed by msxbcsgate. The contained e-mails, which are exclusively outgoing messages, are
then processed and deleted. This method has advantages, but also disadvantages:

Advantages:

- FAX and SMS addresses can be used without restrictions. There is no obligation to use fax
domains or SMS domains.

- Any values can be configured as transfer domains.

- Transfer SMTP domains do not have to be entered in global MX records.
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- The OfficeMaster server does not have to be available as an SMTP server on the Internet.
Administration as an SMTP server is not required.
- There is no transfer of outgoing messages via SMTP via the Internet.

Disadvantages:

- The transfer mailbox must have sufficient capacity to process any bulk mailings.
- The transfer mailbox must always be accessible from the OfficeMaster server.
- The transfer mailbox should be excluded from password rotation.

The general recommendation is to use the service transfer mode, since this mode achieves
greater flexibility in transporting the messages. FAX and SMS address spaces can be used
without restrictions using this method.

Transfer Domains

Despite the possibility that the address spaces FAX and SMS are available in the service transfer
mode, transfer domains should definitely be specified. Transfer domains are SMTP domain
details that are used as fax, SMS or voice sending domains. This domain information is also
used for incoming messages. The sender can then send his outgoing documents to fax
number@domain. By default, domains should be specified with the subdomain prefixes “fax”
and “sms”. If MWI lamps are also to be switched off via read mail items, a “vox” domain should
also be specified.

E.g. fax.exampledomain.de, sms.exampledomain.de, vox.exampledomain.de
The domains can be separated with a comma or a semicolon.

Note!

In the service transfer mode, the information can be any domain information.

With the Internet transfer mode, these domains must be known on the Internet via
an MX record. This information is then no longer arbitrary.

Address spaces

By activating the address spaces, the traditional address spaces for FAX and SMS can be used in
the same way as the local Exchange Connector installations.

In addition to transfer domain addresses, users can then use follow addressings:

- [FAX:fax number]
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- [SMS:SMS number]

Likewise, by activating the FAX address space, the local Outlook fax contacts can be used
without having to explicitly convert them to SMTP addresses.

Note!

Address spaces can only be activated in service transfer mode. In the Internet
transfer mode, addressing is mandatory via transfer domains.

In the following step, the service account for access to Microsoft 365 and the local domain is
specified.

‘%’ MS Exchange Online Connector Wizard X

Service Account Settings :
Please provide the service account for the connector. Fe1 ra rl
electronic

Existing registered application id, which is granted to access Office365 coud and performs voice services and address book resolution:
Tenant Id:
Client Id: 2 Secret:
Obtain Client-Id and Client-Secret automatically via Azure AD
Use modern application authentication (only doud services)

Enable doud service account for OfficeMaster Voice Access

Existing local service account for direct access to the local Microsoft Active Directory:

Domain\Username: MSX 1SMRDOM \ferrari | l sos ‘ Password: (eeesssssssee

Use doud service account as Active Directory service account

OfficeMaster License Group which inherits all users, they are allowed to use the OfficeMaster Unified Messaging Services:
License Group: (® Default OfficeMaster License Group

(O Specific Existing Group

» Help | < Back | Next > » Cancel

At this point the service account can be selected. The available account selection dialog shows
all available mailboxes in the Microsoft 365 tenant that can be used as a service mailbox.

The service account of the current domain can also be specified here, which is used to access
the local Active Directory.

The installation is designed for “modern authentication” by default. This cannot be changed in
the normal configuration.
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The following steps are carried out internally for an application registration:

- The tenant ID (client ID) is determined.

- An application called “OfficeMaster Graph Access” is created in Azure AD.

- A client ID (application ID) and a client secret (secret) with a validity of 24 months are
generated for the “OfficeMaster Graph Access” application.

- The following API permissions are granted for the “OfficeMaster Graph Access”
application:

o Microsoft Graph: Calendars.Read (as application permission) The permission is used
for requests to users’ calendars. This is used for voice calendar queries to
determine automatic free/busy statuses.

o Microsoft Graph: GroupMember.Read.All (as application permission)

The permission is used for requests to user groups. For incoming fax or SMS
messages, distribution lists may have to be resolved. This authorization is also used
for using the OfficeMaster license group.

o Microsoft Graph: Mail.ReadWrite (as application permission)

This authorization is used for reading the e-mails in the user mailbox. At least this
authorization is required for the transfer mailbox.

o Microsoft Graph: Mail.Send (as application permission)

This authorization is set in order to be able to send e-mails via the users and the
transfer mailbox. The connector uses this technology to carry out LPD mail
dispatches and to be able to send e-mails from the transfer account to users.

o Microsoft Graph: People.Read.All (as application permission)

This permission is used for requests to the cloud address lists.

o Microsoft Graph: User.Read (as delegated permission)

This authorization is set automatically and has no meaning for the connector.

o Microsoft Graph: User.Read.All (as application permission)

This permission is used for requests to the cloud address lists.
o Microsoft Graph: User.ReadWrite.All (as application permission)
This authorization is required if individual user data is to be saved.

If the client ID and the client secret have been created manually beforehand, they can simply
be entered. In this case, the option “Obtain program ID and secret automatically from Azure AD”
must be deactivated. The values can then simply be specified.

If the tenant ID (client ID) is not known in such a case, it can be determined automatically using
the browser button.

The installation offers another option for preconfiguration. In some cases, the application has
already been registered in Azure AD. In this case, perhaps no new application should be
created. If so, a search window for applications can be called up via the browser button of the
client id.
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OfficeMaster - Find registered applications

Find

Search for registered applications.

Search in: ferraricloud .onmicrosoft.com . ‘

Name: | Find
Name Description Location A
£8% OfficeMaster Graph Access Application ferraricloud.onmicrosoft.com

v
< >

create a new client secret for the selected application id

valid until | 1year v Fretag . 1. November 2024
oK | Cancel

The special feature of a selected application is that no secret (client secret) can be read out. If
this secret is not known, a new secret can be created during selection. Such secrets have a
specific time limit. This can be set in the dialog.

Note!

Apparently, a special service account is not necessary for access to Exchange
Online with modern authentication with tenant ID, client ID and client secret. In
this case, a transfer mailbox is still required for the outgoing messages. Whether
this mailbox has multi-factor authentication protection is not important and is
irrelevant for the connector.

Note!

If the check box for using modern authentication is deactivated in the installation
step for the account and security settings, the user name and password of a service
account can be specified as in the previous version. This is no longer generally
recommended or supported.
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Local service account with access permissions to on-premises Active Directory

At this point, the service account should be selected to access the on-premises Active Directory.
No Microsoft 365 mailbox can be specified here. The specification relates solely to local access
to the current domain.

OfficeMaster license group

In the field of the license group, for the Small Business variants (e.g. OfficeMaster 250 for MS
Exchange), the license group is specified in which the licensed users must be entered. By
default, the license group is created automatically and is named “OfficeMaster License Group”.
This entry point is not accessible for unlimited OfficeMaster versions. In the hybrid installation
variant, this group is stored in the Active Directory.

In the next installation step, the local configuration points are specified in which the connector
configuration is saved.

? MS Exchange Online Connector Wizard X

Installation Parameters H
Please provide required parameters to complete the installation. !:Ieec.!(roan'l‘g

Shared configuration file to store connector specific settings. This file must be imported into the OfficeMaster Exchange Administration program.
Flepath: | \WSX 19MRCLIENT\FFACCESS \connectorconfiguration. cfg | ]

Administration storage points to store user spedific settings. If mailbox store is selected and predecessor user settings are stored in Active
Directory user objects, these settings can be migrated to user's mailbox via external administration tools.

User Settings Store: | Active Directory User Object =

Global Settings Store: |shared Configuration File v

l \\MSX 19MRCLIENT\FFACCESS \connectorconfiguration.cfg

Help < Back Next Cancel
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File path

The general configuration of the msxbcsgate component is traditionally administered via MMC
configuration snap-ins. With this type of connector, the configuration data is always saved in a
configuration file. The path of this file can be specified here. By default, a file that is in the
OfficeMaster release FFACCESS is suggested here.

User data management

In the hybrid installation variant, there are two installation options available:

Active Directory user object

This is the recommended default if the current Active Directory can accommodate the user-
specific values.

User mailbox

Alternatively, the user-specific values can also be saved in the user’'s mailbox. This is useful if
the current Active Directory does not have an Exchange schema extension or if the local Active
Directory is to be removed in the future.

Note!

If a previous version of the exchange gateways from Ferrari electronic AG was used
and the user-specific values are already available in the Active Directory, they can
continue to be used in a compatible manner. If the user management mode is then
switched to user mailbox, these values must be migrated from the Active Directory
to the Microsoft 365 mailboxes using special tools, otherwise the Active Directory
will no longer be accessed.

Global user data

Global user data is the template data that applies to all users for whom other values have not
been explicitly specified (fax ID, header, cover sheet, etc.). In the pure Microsoft 365 installation
variant, these global specifications can only be saved in a configuration file. At this point, it
makes sense to use the same file that contains the connector configuration data. The default
setting is that the values are written globally to the existing Active Directory. This default setting
is only set for compatibility with the previous version. This makes sense if such a global
configuration node has already been installed from the previous product.
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Note!

If there is no global configuration node yet, installation in a shared configuration
file is recommended.

The necessary parameters for installing the connector are now known. The connector can now
be created in the next installation steps.

¥ MS Exchange Online Connector Wizard X

Installation -
The wizard will now install the specified components. Fe1 ra rl
electronic

Informationen

(O] Using logfile: C:\Users\ferrari.MSX 19MRDOM\FerrariLogFiles\finstallhelp.log
® Create application registration in Azure AD.

@ Created application id: b46c8f17-1b62-4deb-add 1-c652475e 7e 15

(@ Used tenantid: 10511df3-e435-4b2e-92b9-28d4ee9as0cd

@ Created dient secret: Digz...

@ Installation begins.

(@ Base Node will be installed.

(@ Base Node will be installed as file.

(D A license group creation in Active Directory is not required.

@ Active Directory Gateway Node will be created as file.

(O] Existing Gateway Node will be corrected.

@ Configuring transport settings. This may take some time.

(@ The transfer mode connector was successfully created.

@® Anew license group will be created.

@ License group 'OfficeMasterLicenseGroup @ferraricloud.onmicrosoft.com' will be used.
@ A SMTPRX creation is not required.

Installation completed.

Help < Back | Next > | Cancel

During the installation of the Azure AD application, a message appears:

% Installation Information
New created applications must be granted by administrators. Please go to the Azure AD
administration and grant the admin consent for 'OfficeMaster Graph Access'.

[ ]

This notice relates to APl permissions. For security reasons, automatic confirmation of the
release of APl permissions was deliberately avoided. This must be done by an administrator in
Azure AD after installation. If there are any concerns, the corresponding authorizations should
be subsequently adapted to the (security) needs of the solution.
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To do this, log on to the Azure AD of the Microsoft 365 tenant and navigate to the “OfficeMaster
Graph Access” application:

o]
FERRARI ELECTRONIC AG &P

Azure Active Directory admin center

»

Dashboard > Ferrari electronic AG

. Ferrari electronic AG | App registrations % - X

Azure Active Directory

* « -+ New registration i< Endpoeints VA Troubleshooting O Refresh Y Download
> © overview =
a Preview features X
@ Starting June 30th, 2020 we will no longer add any new features to Azure Active Directory Authentication Library
A X Diagnose and solve problems (ADAL) and Azure AD Graph. We will continue to provide technical support and security updates but we will no
=l longer provide feature updates. Applications will need to be upgraded to Microsoft Authentication Library (MSAL)
and Microsoft Graph. Learn more
Manage
& Users
All applications Owned applications  Deleted applications
& Groups  ——
6E External Identities J Start typing a display name or application (client) ID to filter these r... +7 Add filters

&, Roles and administrators

o ) 5 applications found -

& Administrative units . . e
Display name T Application (client) ID  Created on Ty  Certificates & secrets
% Delegated admin partners . )
OfficeMaster Fax Options ee9ccSec-5f20-4fd8-0...  11/26/2021 @ Current

# Enterprise applications

) Wl OfficeMaster Graph Access A - - 1"
08 Devices . 16746620-585b-4cbc 5/11/2022 @ cCurrent

% App registrations

Azure Active Directory admin center

Dashboard » Ferrari electronic AG | App registrations >

g3 OfficeMaster Graph Access = X
"

|/O Search | « [i] Delete @ Endpoints Preview features

- a

B overview

& Quickstart =, 4"\ [ (£
P @ o ‘

#  Integration assistant b |
® .

Manage e

B2 Branding & properties S . .

g & prop Call APIs Sign in users in 5 minutes
D Authentication Build more powerful apps with rich user and Use our SDKSs to sign in users and call APIs in a few
. business data from Microsoft services and your own steps. Use the guickstarts to start a3 web app, mobile
Certificates & secrets N

company's data sources. app, SPA, or daemon app.

I . .
{I! Token configuration View API permissions View all quickstart guides

- API permissions
& Expose an AP

# App roles

e
.

& Owners ®

4, Roles and administrators - v

After selecting the application, the API permissions can be listed.

The API permissions must now be confirmed. This step only has to be carried out once for an
application.

Note!
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In this step, the authorizations can be redesigned according to customer
requirements. Changing the permissions may have a negative impact on the
productive operation of the connector.

After the APl permissions have been released, the connector can be put into operation like the
previous version.

Azure Active Directory admin center

FERRARI ELECTRONIC AG

Dashboard » Ferrari electronic AG | App registrations > OfficeMaster Graph Access

el . ..
- OfficeMaster Graph Access | APl permissions = - X
* | P Search | « O Refresh F'{j Got feedback?
4 a -
> # overview Configured permissions
& & Quickstart Applications are authorized to call APIs when they are granted permissions by users/admins as part of the consent process. The list of
= configured permissions should include all the permissions the application needs. Learn more about permissions and consent
# Integration assistant
-+ Add a permission /' Grant admin consent for Ferrari electronic AG
Manage
) . APl / Permissions n... Type Description Admin consent req...  Status
B2 Branding & properties w
Vv Mi ft Graph (6] A
2D Authentication icrosoft Graph (6)
N ) CalendarsRead  Application Read calendars in all mailboxes Yes &\ Notgranted for Ferrari ,  +=*
| Certificates & secrets
- GroupMemberRez Application Read all group memberships Yes &\ Not granted for Ferrari | +*
Il Token configuration roupMemberRez ApP group P g
o Mail.ReadWrite  Application Read and write mail in all mailbo... Yes &\ Notgranted for Ferrari ,  +=+
- API permissions
Mail.Send Application  Send mail as any user Yes &\ Not granted for Ferrari | ++
& Expose an API elleen il Y g
- PeopleRead.All  Application Read all users' relevant people lists Yes & Not granted for Ferrari,, «*+
%4 Approles
User.Read Delegated  Sign in and read user profile No
& Owners sertes g ¢ P
&, Roles and administrators v v
am ing Server Configurati - O X
File Edit View Tools Help >
Quicklaunch Actions
p— . Component Status T =
cerch Lompenen Overview about all system components Restart
(] smtprx0
D smiprx1 Available components: 30 0 {3 Refresh
v - S d
& >ending Component Status Current Statu A D show configuration...
O smtptxo > E-mail Show log...
v (&) LDAP/SMTP Connector v Microsoft Exchange &8 Properties
D mailgwo v @ Connector for BCS (FTRAININGOS-VINCIOM2... Running
v SMS > @ connector License Running Show All Components
@ SMS via IP-Provider (. > @ Fax-Gateway Cloud/Online Fax-Connector ready Running
@ SMS via USB Modem > @ Information Server Cloud/Online User information server ready Running Show Working Only
@ SMS Submission via U... > @ SMS-Gateway Cloud/Online SMS-Connector ready Running
@ SMS Reception via U... > @ Voice-Gateway Cloud/Online Voice Connector ready Running
v Exchange . Connector for UMS (VINCIMX-VINCIOM22) [m... Stopped No grouping v
> Miscellaneous Gateways
v (@1 on-remises YIS other v| [[Hep 8 X
< > | Search Help
@ Component Status...
e component
@ Job Status...
©8 © Ao o |» |status
. ~
oﬁ 2 Staks D State Component Sender If the component status is
selected, a summary is displayed
E Log Files... in the main panel, giving
information about the
components connected to the
'RT Job Routing... e 5 messaging server. v
® Administrator 01.07.2025 41 localhost

After releasing the application permissions, the component can be started and should be ready
to use.
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7.4. Local Exchange Server installation

741. General

A special type of installation is the local Exchange Server installation (on-premise). This form is
similar to installing the Exchange Gateway msx2kgate. A local Active Directory is used to store
user information and determine SMTP addresses. The connector only requires a LAN connection
to access the local Exchange server.

Local installation is usually supported by the default exchange gateway msx2kgate. However,
when the previous product was installed, there were local environments in which the gateway
msxbcsgate had to be used. The reasons for this were usually access problems via MAPI
(Message Application Programmers Interface) and rights problems with Active Directory
(configuration nodes could not be created due to missing authorizations). For compatibility with
these installations, the installation variant of the local Exchange Server installations is also
supported by msxbcsgate.

The installation wizard carries out all important installation steps automatically. After the
installation, however, a manual adjustment to the Exchange Server is necessary. No objects are
created automatically in the Exchange Server organization.

Attention!

The installation is based on bidirectional e-mail transmission. For this reason, the
installation wizard installs its own SMTP server and opens port 25 by default. For
this reason, such an installation should not take place on an Exchange server itself.
An Exchange Server itself maintains a binding to the port 25. The installation of an
OfficeMaster server with a local installation variant of msxbcsgate should always
take place on a dedicated server.

If this is not possible, an alternative port must be configured for the smtprx
component, to which the Exchange Server can then deliver the documents.
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74.2. Installation requirements

Service account to access address books and the local Active
Directory

A separate service account or mailbox is required to operate the connector. This service account
should be created manually as a normal user mailbox beforehand. The mailbox is used to
access the public address book of the Exchange Server and is stored in the connector.

Local service account (accessed from local Active Directory)

The connector must have minimal access to the on-premises Active Directory to properly
authenticate users. His read permissions in the organizational units of the domains should be
correspondingly high.

There are several reasons for using a service account:

- Reading the configuration data of the connector stored in the Active Directory

- Reading global configuration values

- Resolve domain users and read user values

- Writing user-specific values after configuring voice parameters (own phone number, voice
box pin, etc.)

Such an account should have the following authorization structure:

- Member of the domain users group

- Local administrator of the installation computer

- Read access permissions on the path containing the configuration file

- (Insinstallation option) Global data: Global Active Directory context
In this case, the service account needs organization permissions (Exchange-Viewonly-
Administrator). This setting is useful if connectors with this setting already exist. As of
Exchange 2010, the organization can only have read permissions for Active Directory via
membership of the Exchange Public Folder Administration group.

- (installation option) Global data: Active Directory default context
In this case, the account does not need any additional permissions.

- (installation option) Global Data: Common Configuration File
In this case, the account does not need any additional permissions.

- (installation option) user data: Active Directory user object
If the connector should also be used to change voice properties such as PIN or phone
number values by users via remote inquiry or Outlook client, the account must have write
permissions in the user objects of the connected domains.
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74.3. Installation

The connector is installed in the properties of the component administration for the Exchange/
Online services.

® Messaging Server Configuration - a X
File Edit View Tools Help >
Qui ; Al -
x| Office 365 / Exchange Online Connector (MSXBCSGATE)
|Seard'| Components | Product/License: Connector (NGDX/FAX and Voice) [ New...
v 3 System D dit...
Component Table About Remove...
> % Undeliverable
This connector retrieves user data from the user data of the configured tenant and manages the messages in the mailbox store of the respective D Start
3] Transfer DB user account using SMTP and Exchange Web Services.
> B3 converter O Stop
What's new
> B3 Telephony || Pause
v 3 il . Continue
B Overview >
’ 9 Recervng New Exchange Connector... Restart
# Sending 3 Refresh
{£) LDAP/SMTP Connector Available Exchange Connectors p
> B sMs 83 Properties...
Name Display name Startup Type Status Status Message
v Exchange
> E] On-Premises
1 Hybrid / Cloud
C@ Mail Archive
> [ Notes
> [ sap
> B3 web/Files Services < 2
> .
2 rock pacessng s o
> [ voice <
5 B3 signature D State Component Sender Receiver

E Component Status...

£3 10bstatus...

Oﬁ License Status...
< >
@ Log Files...
A o
Job Routing... -
hd Time Status Text | v

@ Administrator 19.08.2021 il localhost .

An installation wizard will now appear. The components should only be created and deleted
using this installation wizard.
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@ Messaging Server Configuration
File Edit View Tools Help

Quicklaunch x

|Search Components

v System
Component Table
> | Undeliverable
Transfer DB
[ converter
> [3 Telephony
=13
> E3 Receiving
> Sending
(E) LDAP/SMTP Connector
> O sms
v Exchange
> E:I On-Premises
3 Hybrid / Cloud
C@ Mail Archive
[ Notes
0O sap
3 web/Files Services
B3 print/oCR
3 voice
B2 signature

v

>
>
>
>
>
>

B2 component status...

£3 10bstatus...

Oﬁ License Status...
g Log Files...

4% Job Routing...

- [m] X
>
. A | | Actions
Office 365 / Exchange Online Connector (MSXBCSGATE)
Product/License: Connector (NGDX/FAX and Voice) [ New...
[ Eit...
About N
EmMoVe...
This connector retrieves user data from the user data of the configured tenant and manages the messages in the mailbox store of the respective D Start
user account using SMTP and Exchange Web Services.
O stop
What's new
|| Pause
. P> Continue
Overview |
New Exchange Connector... Restart
£3 Refresh
Available Exchange Connectors pel
@ Properties...
Name Display name Startup Type Status Status Message
< >
procsang »
D - State Component Sender Receiver
< >
- »
Time Status Text | v
@ Administrator 19.08.2021 il locahost .

The welcome screen is followed by a dialog for selecting the type of installation.

Three installation forms are available:

1. Exchange Online/Microsoft 365 as full cloud installation
2. Exchange Online/Microsoft 365 as a hybrid installation with on-premises Active Directory
3. Local Exchange Server Installation (On-Premise)

The third type of installation is used for local installations.
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% MS Exchange Online Connector Wizard X

Installation Type Selection -
Please select the preferred Type of installation. Fe1 ra '."
electronic

] Office 365

(O Native Microsoft Office365 completely in cdloud
(O Microsoft Office365 hybrid installation with local Active Directory

Provider: Microsoft Office365 International (outiook.office365.com)

@&Exchange

@ On-Premises Exchange Server

e o> ] [ cone

No explicit login to the Exchange Server is necessary.

In the next step, the transport type is selected. The transport type usually determines how
outbound documents are handled.
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‘é’ MS Exchange Online Connector Wizard X

Transport Type Selection -
Please select the preferred transport mode. Fe1 rari

electronic
Messaging Server: | MSX 19MRCLIENT ™
Exchange Server: |MSX 19MRDC I [:
Transfer Mode: (® SMTP Transfer Mode

Service Transfer Mode

The transfer mailbox will be accessed by the connector component. The mailbox content may be processed. To prevent loss
of any important user specific mailbox content, please do not use an existing personal user mailbox. In modern
authentication scenarios a transfer mailbox is mandatory.

Transfer Domains: fax.local,sms.local,vox.local
Address Spaces: FAX
SMS

Help < Back I Next > l Cancel

In the local Exchange Server installation variant, no other transport variant is available than the
SMTP transmission mode. No transport to an intermediate mailbox is required in the local
network.

Messaging Server

In the Messaging Server input field, the server can be selected on which the Connector
component will eventually run as an instance. The field shows in the main messaging server by
default. It is also possible to specify here another messaging secondary server. If the list is not
complete because the configuration program cannot fully access some of the slave servers, the
desired name of the slave server can also be entered manually.

Exchange Server

For communication with an Exchange Server, this must be entered as the default
communication partner. A fully qualified domain name (FQDN) or a NetBIOS name can be
specified here. IP addresses should not be specified, as a display name is created from this
specification.
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Transfer mode

No further transfer mode can be selected at this point. The installation form only supports the
SMTP transmission mode.

Transfer Domains

Despite the possibility that the address spaces FAX and SMS are available in the service transfer
mode, transfer domains should definitely be specified. Transfer domains are SMTP domain
details that are used as fax, SMS or voice sending domains. This domain information is also
used for incoming messages. The sender can then send his outgoing documents to fax
number@domain. By default, domains should be specified with the subdomain prefixes “fax”
and “sms”. If MWI lamps are also to be switched off via read mail items, a “vox” domain should
also be specified.

E.g. faxexampledomain.de, sms.exampledomain.de, vox.exampledomain.de
Note!

The domains are separated with a comma or a semicolon when they are specified.
The transfer domains are given here purely for registration purposes. Whether the
e-mails from the Exchange Server also reach the OfficeMaster Server with this
domain specification depends on the manual administration of the Exchange
Server.

Address spaces
Although the installation supports the use of address spaces, these are not stored here.
Address spaces cannot be influenced during installation.

In the next step, the service account for access to the Exchange Server and the local domain is
specified.



166 74. Local Exchange Server installation

® Ms Exchange Online Connector Wizard X
Service Account Settings :
Please provide the service account for the connector. Fe1 ra '."
electronic

Existing service account, which accesses the Office365 doud and performs voice services and address book resolution services:

Tenant Id:

Cloud Service Account: MSX 19MRDOM \ferrari [-.. Password: |eesessssssss

Obtain Client-Id and Client-Secret automatically via Azure AD
Use modern application authentication (only doud services)

Enable doud service account for OfficeMaster Voice Access

The service account's mailbox will be accessed by the connector component. The mailbox content may be processed.
To prevent loss of any important user specific mailbox content, please do not use an existing personal user mailbox.

Existing local service account for direct access to the local Microsoft Active Directory:

Domain\Username: MSX 19MRDOM \ferrari - Password: eessssssssse

Use EWS service account as Active Directory service account

OfficeMaster License Group which inherits all users, they are allowed to use the OfficeMaster Unified Messaging Services:
License Group: (® Default OfficeMaster License Group

(O Sspecific Existing Group

Help < Back Cancel

At this point the service account can be selected. Different service accounts can be specified for
Exchange Server access (Exchange Web Services) and access to the local Active Directory.
However, this is optional. It is recommended to use the same account for both accesses.

Authorize service account for voicemail services

This function is not available in this installation variant. The account for the OfficeMaster

language services may have to be activated manually if language services are to be used.

To perform this step manually, this can also be done with the Exchange PowerShell:
New-ManagementRoleAssignment OfficeMasterVoiceAccess

-Role ApplicationImpersonation -User \<Service AccountEmailAddress\>

Local service account with access permissions to on-premises Active
Directory

At this point, a separate account can be specified for access to the Active Directory.
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Use EWS service account as Active Directory access account
When activating this function, the values of the Exchange access account (EWS service account)
are copied into the input fields for the Active Directory service account.

Note!

It is generally recommended to use the same service account for access to the
Exchange Server (Exchange Web Services) and to the Active Directory.

OfficeMaster license group

In the field of the license group, for the Small Business variants (e.g. OfficeMaster 250 for MS
Exchange), the license group is specified in which the licensed users must be entered. By
default, the license group is created automatically and is named “OfficeMaster License Group”.
This entry point is not accessible for unlimited OfficeMaster versions.

In the next installation step, the local configuration points are specified in which the connector
configuration is saved.

? MS Exchange Online Connector Wizard

Installation Parameters -
Please provide required parameters to complete the installation. Fe1 ra rl
electronic

Shared configuration file to store connector specific settings. This file must be imported into the OfficeMaster Exchange Administration program.

Filepath: I \\MSX 19MRCLIENT\FFACCESS \connectorconfiguration.cfg I 2

Administration storage points to store user specific settings. If mailbox store is selected and predecessor user settings are stored in Active
Directory user objects, these settings can be migrated to user's mailbox via external administration tools.

User Settings Store: | Active Directory User Object v

Global Settings Store: | shared Configuration File v

I \\MSX 19MRCLIENT \FFACCESS \connectorconfiguration.cfg

Help < Back Cancel
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File path

The general configuration of the msxbcsgate component is traditionally administered via MMC
configuration snap-ins. With this type of connector, the configuration data is always saved in a
configuration file. The path of this file can be specified here. By default, a file that is in the
OfficeMaster release FFACCESS is suggested here.

User data management

In the local Exchange Server installation variant, there are two installation options available:

Active Directory user object

This is the recommended default.

User mailbox

Alternatively, the user-specific values can also be saved in the user mailbox. This does not
make sense in the local installation variant.

Note!

If a previous version of the exchange gateways from Ferrari electronic AG was used
and the user-specific values are already available in the Active Directory, they can
continue to be used in a compatible manner. If the user management mode is then
switched to user mailbox (not recommended), these values must be migrated from
the Active Directory to the Microsoft 365 mailboxes using special tools, otherwise
the Active Directory will no longer be accessed.

Global user data

Global user data is the template data that applies to all users for whom other values have not
been explicitly specified (fax ID, header, cover sheet, etc.). These global specifications found in
the Microsoft 365 only installation variant can only be saved in a configuration file. At this point,
it makes sense to use the same file that contains the connector configuration data. The default
setting is that the values are written globally to the existing Active Directory. This default setting
is only set for compatibility with the previous version. This makes sense if such a global
configuration node has already been installed from the previous product.

Note!
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If there is no global configuration node yet, installation in a shared configuration
file is recommended.

% MS Exchange Online Connector Wizard

OfficeMaster for MS Exchange Online Services

The installation was successfully finished.

Feirari

electronic

<Back | [ Fnmsh || cancel




170 74. Local Exchange Server installation

¥ MS Exchange Online Connector Wizard

Installation -
The wizard will now install the specified components. Fe1 ra |.'|
electronic

Informationen

@ Using logfile: C:\Users\ferrari.MSX 1SMRDOM FerrariLogFiles\finstallhelp.log
@ Installation begins.

(@ Base Node will be installed.

@ Base Node will be installed as file.

@ The Licensegroup was successfully created.

@ Active Directory Gateway Node will be created as file.

® Existing Gateway Node will be corrected.

® Component 'smtprx0' will be configured.

Installation completed.

<gack [ Next> || cancel

The necessary parameters for installing the connector are now known. The connector can now
be created in the next installation steps.

am ing Server Configurati - [m] X
File Edit View Tools Help >
Quick s
Component Status e T
~
Search Components Overview about all system components Restart
O smtprxo
D smiprx1 Available components: 30 0 £3 Refresh
- .
v # Sendng Component Status Current Statu A O show configuraton...
D smtptxd > E-mail Show log...
v (&) LDAP/SMTP Connector v Microsoft Exchange 183 Propertes
D maigwo v (@ Connector for BCS (FTRAININGOS-VINCIOMZ... Running
v SMs > @ Connector License Running Show All Components
-:n"- SMS via IP-Provider (... > @ Fax-Gateway Cloud/Online Fax-Connector ready Running
[® sMs via Us Modem > (@ Information Server Cloud/Online User information server ready Running Show Working Only
,:,,:,, SMS Submission via U... > @ SMS-Gateway Cloud/Online SMS-Connector ready Running
@ sms Reception via U... > @ Voice-Gateway Cloud/Online Voice Connector ready Running
v Exchange s — Conncht:;' for UMS (VINCIMX-VINCIOM22) [m... Stopped No grouping v
iscellaneous Gateways
v E] On-Premises v > Other v ‘Heb g X
< > | Search Help
] component status...
component
£3 10 status...
©8 O s EE—lE T
d . ~
Bp\License Status e D State Component Sender If the component status is
selected, a summary is displayed
E Log Files... in the main panel, giving
information about the
components connected to the
v Job Routing... messaging server.
< > v
@ Administrator 01.07.2025 gl localhost

After installation, the component should start immediately and be ready for use.
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74.4. Objects to be created manually in a local Exchange
environment

If the connector is to be installed in a local Exchange Server environment, it must be ensured
that outgoing emails are routed directly to the messaging server. This is usually regulated by a
send connector or an SMTP connector. The following basic values can be configured:

Object: SMTP send connector

Type: SMTP Smarthostcommunication

Sending server: Exchange server to send from. (Source Server, Local Bridgehead)
Smarthost: IP address, name or FQDN of the OfficeMaster server

Such a send connector can then include the desired transfer domains in its address spaces. It is
also possible to configure the FAX and SMS address space there. The creation of the send
connector should be briefly addressed using an Exchange Server 2016 example.

new send connector

A send connector can route mail directly through DNS or redirect it to a
smart host. Learn more...

*Network settings:
Specify how to send mail with this connector.

MX record associated with recipient domain
@ Route mail through smart hosts

+ /-

SMART HOST

(O Use the external DNS lookup settings on servers with

transnort roles
Back Next Cancel
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new send connector

Create a Send connector.

There are four types of send connectors. Each connector has different
permissions and network settings. Learn more...

*Name:

Connector for BCS (Exchange-OfficeMaster)

Type:
O Custom (For example, to send mail to other non-Exchange
servers)

@ Internal (For example, to send intranet mail)
O Internet (For example, to send internet mail)

O Partner (For example, to route mail to trusted third-party
servers)

No authentication needs to be specified for communication with an OfficeMaster server. (The
name OfficeMasterServer as smart host is only an example. The correct name or IP address of
the server should be used!)

new send connector

A Send connector routes mail to a specified list of domains. These domains
can be an SMTP address space or a custom type. Learn more...

*Address space:
Specify the address space or spaces to which this connector will route mail.

+ 7 -
TYPE DOMAIN COST
SMTP faxlocal 1 -
SMTP sms.local 1
SMTP vox.local 1

_v

O Scoped send connector
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new send connector

Configure smart host authentication. Learn more...

Smart host authentication:
@® None
O Basic authentication

Offer basic authentication only after starting TLS
*User name:

*Password:

Note: all smart hosts must accept the same username and password.
O Exchange Server authentication
O Externally secured (for example, with IPsec)

The last step is to add the source server. The Exchange Server can now send documents to the
OfficeMaster.

new send connector

A send connector sends mail from a list of servers with transport roles or
Edge Subscriptions. Learn more...

*Source server:
Associate this connector with the following servers containing transport
roles. You can also add Edge Subscriptions to this list.

SERVER SITE ROLE

MSX19MR... msx19mrdom.ferrari-electronic.de/Confi... Mailbox

Since the OfficeMaster also sends documents to the Exchange Server, a corresponding receive
connector must be available. The msxbcsgate component does not use authentication by
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default, which is why either the standard SMTP receive connector should be activated for
anonymous receipt, or a separate connector should be created.
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7.5. Configuration

7.51. Messaging server configuration

Microsoft Active Directory is not required for the pure connection to a Microsoft 365 service. The
connector only requires a working connection to Microsoft 365 via the Internet.

Although the connectors store all relevant settings in a configuration file in order to integrate
the components into the Exchange Server environment, the individual components also have

basic settings in the messaging server configuration that ensure smooth operation of the
components.

{54 Messaging Server Configuration - a X
File Edit View Tools Help >
Quicklaunch X A | |Actions
Office 365 / Exchange Online Connector
Search Components Connector for BCS (FTRAINING0S-VINCIOM22) (msxbcsgate0) Apply
v B3 sms A
= ~ £3 Reload
vk SMS via IP-Provide... Connector Configuration Receive
[2) sMs via USB Modem @ Remove Component..
Exchange Connector Parameters
@ SMS Submission via... Restore Defaults
& SMS Receptionvia . E MS Exchange Connector: [connector for BCs (FTRAININGOS-VINCIOM22) ] 3 Propertes...
v Exchange Related MS Exchange Server: Iouﬂook.ofﬁoeaes.oom I
v E] On-Premises Connector Administration Point: I\\VFFUMS‘FFACCESS‘mnnectormnﬁguraﬁon.cfg I |
O msxkgated Global Administration Point: ‘Conﬁguraﬁon File v ‘
v 13 Hybrid / Cloud | | =
IMS\FFACCESS \connectorconfiguration.
D mexbesgateo \\FFUMSFF \co fig: cfg
C@ Mail Archive MS Active Directory Binding
> [ Notes Username: I I e |
> Dsep Password: I I
v Web/Files Services
v 8 Filesystem Connec... Metacache Replication: ‘ Replicate Metacache Now
D flegwo |Heb 8 X
@ web Connector Connector for Fax, SMS and Voice Services XSEarch Help
ePost Connector v % Notify Component: |<Select > v Connector 2
i Options: configuration
@ Component Status... Notify Options: O Notifications for SAP via User Address entry 9
- . Although the Exchange
@ o (® Notifications for SAP via User Name entry connectors store all relevant
[ suppress mail notifications settings in the OfficeMaster
° Exchange Administration in order
License Status... to integrate the components into
5 ) Requeue Interval: the Exchange Server
. . environment, the individual
E Log Files... Maximum concurrent job count: 10 @ components also have basic
settings in the messaging server
figuration that the
‘QF Job Routing... Transfer Log: [] optimize file format for spreadsheet tools . gznrgog;:pggﬁ; :F ;'uere < .
@ Administrator 01.07.2025 gl localhost

The basic settings are on the Exchange connector parameters tab.

Exchange connector parameters

These settings are set by the installation wizard. They include the connector name, target server
FQDN, configuration file path, and more.
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Note!

Although the basic settings can be configured in expert mode, manual
administration is not recommended. The basic parameters should only be set by
the installer. Manual changes can severely disrupt the correct operation of the
components.

MS Exchange Connector

The name of the connector component is displayed in this field. This field cannot be changed
and is provided for information only.

MS Exchange Server

The field cannot be changed either and contains the selected server for information.

Connector administration point

The connector administration point is the configuration file in which the connector expects its
actual configuration. This entry can be changed or restored accordingly. A change in this
parameter is only available for restore purposes and should not be changed without the
installation wizard.

Global administration point

The global administration point is the storage location for the global user preferences. One can
only set the general access mode here.

- Microsoft Active Directory

In this mode the connector looks for the global point in the configured Active Directory
- configuration file

In this case, the connector uses the specified file to read out the global user values.

The entries can be changed or restored accordingly. A change in this parameter is only available
for restore purposes and should not be changed without the installation wizard.
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MS Active Directory connection

A user name and a password can be stored in the Active Directory connection fields, with which
the connector accesses the configured Active Directory. With a pure Microsoft 365 connection,
these entries are empty.

Metacache replication

There is a button in the configuration that can be used to trigger metacache replication outside
of the set intervals. This option is only implemented for test purposes.

Status component

A status component is an additional component that is informed about the status of the sent
fax document or the sent SMS. Here, for example, archive gateways can be specified.

Status options

The status options are used to optimize and customize the interaction with other components.

- Status messages for SAP based on the user address field
If the msxbcsgate connector is used by an SAP gateway as a status component, there are
various ways in which the SAP connector stores the sender in the order. The internal field
UserAddress is used as a criterion for the sender.

- Status messages for SAP based on the user name
The internal field UserName is used as a criterion for the sender.

- Suppress email status feedback
If the msxbcsgate connector is operated with a filegw component (file interface) or a lpd
component (printer component), the connector can print the document autonomously if
an e-mail address is specified send via SMTP. This sending is carried out via the
connected Exchange Server. With this transmission (exchange relay), the connector
receives a report from the sending server as to whether the e-mail was accepted by the
server. Since this report does not provide any real information as to whether the e-mail
actually arrived at the recipient, but is only an indication that the e-mail was received by
another part of a process chain, many users want to ignore this transmission report. This
can be done by activating the function.
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Requeue interval

If the msxbcsgate connector cannot deliver the messages to the target systems (maintenance
intervals, converter problems, printing problems), the order will be delivered again. The time
delay of this new delivery (requeue) can be specified here in minutes.

Simultaneous order processing

The connector is able to process several orders at the same time. The maximum number of
simultaneous jobs to be processed can be specified here.

Note!

It should be mentioned that a number greater than 10 does not result in a greater
increase in performance. The optimum number for current computers is 10. This is
also the default. The value can be reduced to 1 to force sequential processing of
the orders. This should only be done for testing purposes. It is recommended to
enter a value between 5 and 10.

Transfer log file / Optimized for spreadsheet programs

The msxbcsgate component writes a file with the orders that have been processed for each day.
Telephone numbers in E164 format are also written to this file. It was often found that
spreadsheet programs convert this notation (e.g. +49332845590) into a floating point
representation (+49332845590 becomes 4.93E+10). Leading zeros are also mostly removed by the
program. To mark these entries as text, the entry can be preceded by a single quote. Modern
spreadsheet programs then interpret this data as unchangeable character strings and leave the
display unchanged.

Reception tab

The “Receive” tab has a direct influence on the incoming documents. The phone numbers
(Called Party Number) from the receiving processes intended for the Exchange Connector can
be entered as an address filter for fax or SMS.

With the default setting (*), all received faxes or short messages are forwarded to the Exchange
connector. A change is only required if received messages are to be distributed to different
gateways such as SAPCONN or FILEGW.



179

75. Configuration

[=RY] ing Server Config - a X
File Edit View Tools Help >
LI &l Office 365 / Exchange Online Connector ctions
Search Components Connector for BCS (FTRAINING0S-VINCIOM22) (msxbcsgateD) Apply
v 3 A
TS £3 Reload
ek SMS via IP-Provide... Connector Configuration Receive
(2 sMs via USB Modem [@ Remove Component...
[] Fax Reception enabled
@y SMS Submission via... Restore Defauits
o~ o Address Filter: [, = ]
@* SMS Reception via ... 83 Properties...
v Exchange
v @] on-premises
O msx2kgated
v 13 Hybrid / Cloud
[ msxbcsgated <
C@ Mail Archive
> [ Notes
> B sap
v Web/Files Services
v 8 Filesystem Connec...
D flegno |Heip 8 x
@ Web Connector |Search Help
ePost Connector Reception »
[] sMs Reception enabled
Component Status... The Reception tab has a direct
E - D Address Filter: | = impact on the incoming
documents. The telephone
@ Job Status... numbers (Called Party Number)
intended for the Exchange
d . Connector can be entered as an
R Licnse Shahs..., address filter for faxes or SMS.
With the default setting (.*), all
@ {oc Els received faxes or short messages
°g are forwarded to the Exchange
P connector.
v 200 Routing. v | | A change is only necessary if v
@ Administrator 01.07.2025 1l localhost

7.5.2. OfficeMaster Exchange administration

v Lokale Exchange-Administration

. Organi k
Sz Connectorkenfiguration
&1 Empfangerkonfiguration
i Tools

- .
iguration

Ferari
electronic

http://www ferrari-electronic de

1| B OfficeMaster Administration |Akﬁ°“°"
OfficeM

OfficeMaster fiir MS Exchange Server

OfficeMaster Exchange - Administration

http://forum ferrari-electronic. de

OfficeMaster Administration - [OfficeMaster Exchange Administration] - m] X
Datei Aktion Ansicht 2

@@

OfF« M. Exchange Admini:

% Hinzufiigen...

Entfemen, bearbeiten oder fligen Sie neue On-Premise-Organisationen der Verwaltung hinzu.
/ Bearbeiten... X

<

On-Premise Organisation

Server

Administratives Konto

>
[ Lokale Exchange-Verwaltung anzeigen
Entfemen, bearbeiten oder figen Sie neue Exchange Server basierte Cloud-Installationen hinzu.
s Hinzufigen... ~ Bearbeiten...
Cloud-Organisation Server Administratives Konto
< >

Ansicht
Hilfe
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If during the installation of the OfficeMaster Suite the setup option OfficeMaster for Exchange/
Exchange Online-Connector was selected, the OfficeMaster Exchange management console is
available on the system. At the time, this console extended the Exchange Server 2010
management console and can also represent its own management node. The structure of the
current version has not changed compared to the OfficeMaster 7 predecessor. After starting the
console from the available program icons, the following view appears:

Traditionally, OfficeMaster Exchange Connectors are configured via MMC Snaplns, which may
also be integrated into existing Exchange Server administration tools or into Active Directory
administrations.

With the OfficeMaster Exchange administration, individual user settings and connector settings
can be conveniently configured.

Datei Aktion Ansicht 2
il
CT T T oo Admssion [T

4 Local Exchange Adr
1s25. Organisationskonfiguration OfficeMaster I

Ansicht 4

i E°"’f‘f‘t°";°"ff',9“”tt'_°" . | OfficeMaster fiir MS Exchange Server B
mpfangerkonfiguration A Hilfe
i@ Tools Fe1 ra rl OfficeMaster Exchange - Administration
electronic o o
http://www ferrari-electronic de  http://forum femrari-electronic de

Entfemen, bearbeiten oder figen Sie neue On-Premise-Organisationen der Verwaltung hinzu.
e Hinzufigen... / Bearbeiten... X
On-Premise Organisation Server Administratives Konto

<] [ >

[] Lokale Exchange-Verwaltung anzeigen

Entfemen, bearbeiten oder fligen Sie neue Exchange Server basierte Cloud-Installationen hinzu.
b Hinzufigen...  Bearbeiten..
Cloud-Organisation Server Administratives Konto

< m >

The areas of administration have the following meaning:

- OfficeMaster base configuration node
The OfficeMaster base configuration node is the highest level of OfficeMaster Exchange
administration. When you click on this node in the area window (left side, Scope Panel),
the central administration dialog for adding the configurable clients appears in the result
area (middle, Result Panel).

- Configuration of a local Exchange Server installation
The local Exchange Server installation area is the local Exchange organization’s
traditional display of the current user logon to Windows. The display of the local
administration can be switched off in the local client area.
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- Local client area
On-premises Exchange organizations can be added using the local tenant area. The
console will then connect to the added Active Directory.

- Cloud/Microsoft 365 Organization Panel
Installed Cloud/Microsoft 365 organizations can be added in the Cloud/Microsoft 365
organization area. Added organizations are displayed in the area window (left side) as an
additional main node, on a par with the local Exchange Server Administration.

7.5.3. Configuration of a Microsoft 365 installation without on-
premises Active Directory

OfficeMaster Administration - [OfficeMaster Exchange Administration] = m] X
Datei Aktion Ansicht 2
|5

OfficeMaster Exchange Administrati ﬂ OfficeMaster Administration Aktionen

v [ Lokale Exchange-Administration OfficeMaster OfficeMaster Exchange Administration N

Ansi
OfficeMaster fiir MS Exchange Server nsicht »

., Empfangerkonfiguration 1 i
£z Empféng g Hilfe
ke, et Fevrari

.\ OfficeMaster Exchange - Administration
electronic

ls2;. Organisationskenfiguration
Sz Connectorkenfiguration

http://www ferrarielectronic.de  http://forum ferari-electronic de

Entfemen, bearbeiten oder fligen Sie neue On-Premise-Organisationen der Verwaltung hinzu.
P Hinzufigen... . Bearbeiten...

On-Premise Organisation Server Administratives Konto

< >

Lokale Exchange-Verwaltung anzeigen

Entfemen, bearbeiten oder fligen Sie neue Exchange Server basierte Cloud-Installationen hinzu.
E& Hinzufigen... Bearbeiten...

Cloud-Organisation Server Administratives Konto

Since a pure Microsoft 365 installation does not have a local Active Directory, local
administration should be switched off by ticking the local client area. The nodes are then
removed from the range window. In order to then configure Microsoft 365 connectors, a new
organization in the Cloud/Microsoft 365 organization area should be now added.

After clicking the “Add” button, a wizard opens with the parameters of the new organization. At
this point, an adequate display name for the organization should be assigned. Likeweise, the
default user name for access to Microsoft 365 is also stored here. The password can be
specified here at this point, but would then be stored in a configuration table. This is a security
concern, so it is not recommended. The password field can remain empty. Then follows the
possibility to specify the connector configuration file.
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11 OfficeMaster Exchange - Add Office365 Organiz...  — X

Connector Configuration File:

[ | =
[] Active Directory / Office 365 Cloud - Hybrid Installation
Use Active Directory Basenode

Basenode Configuration File:

Use Local Active Directory
User configuration is based on Microsoft Active Directory

<Back || Net> | Cancel

1 OfficeMaster Exchange - Add Office365 Organiz...  — X

n | New Office 365 Organization |

The administrative account (Organization Administrator) is necessary to access the
organization.

Usemame: I I

Password: | |

It is not recommended to store the password. The field can be left blank.

< Back . Net> || Cancel

After selecting the common connector configuration file that was specified during the
connector installation, a window opens in which the responsible connector should be selected.
Since the file can contain several connectors, the correct connector should be selected here.

1) OfficeMaster Exchange - Add Office365 Organiz...  — X

Connector Configuration File: Connector for BCS (FTRAININGD8-VINCIOM22)
IC:\ProgramData\FFUMS\fmsrv\dala\exd'lange\connectorconﬁguration.cfg | ‘ |
[ Active Directory / Office 365 Cloud - Hybrid Installation

Use Active Directory Basenode

Basenode Configuration File:
\\VINCIOM22\FFACCESS\connectorconfiguration.cfg| |

Use Local Active Directory
User configuration is based on Microsoft Active Directory

<Back || Net> || Cancel
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=1 BCS Connector - Selection - O X
= Select a connector which schould be added to the configuration.
&4 (C:\ProgramData\FFUMS\fmsrv\data‘\exchange'\connectorconfiguration.cfg)
Name Mail Server Messaging Server
gIConnedorfor BCS (FTRAININGOS-VINCI... outlook .office365.com VINCIOM22
O ngonnedorfor BCS (VINCIMX2-VINCIOM22) VINCIMX2 VINCIOM22
==

After selecting the connector, the configuration dialog should fill in automatically. If necessary,
the entered values and checked fields should be checked for correctness.

Connector configuration file

The configuration file is here specified, which was specified during the connector installation.

Active Directory / Microsoft 365 Cloud hybrid installation

If this option is enabled, the administration is prepared for access to an Active Directory. With a
pure Microsoft 365 installation, this option is not active.

OfficeMaster base node is located in Active Directory

At this point it is specified where the global user data is located. When the feature is enabled,
the data resides in an Active Directory node. If the option remains inactive, a configuration file
that houses the global user data must be specified.

Base node configuration file

If it was specified during the connector installation that the global user data is in a
configuration file, then this should be specified here. As a rule, this field will change itself
automatically after selecting the connector configuration file.
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Use local credentials for Active Directory access

As a rule, a server and an access account can be specified for access to an Active Directory.
However, if this option is enabled, the optional user data are omitted. In this case, the Windows
login account is used to access the Active Directory.

As a rule, this field will be filled in automatically after selecting the connector configuration file.

User configuration based on Active Directory entries

In order to be able to administer the OfficeMaster user properties correctly, the administration
must know how the properties are saved. If the option is activated, the data is read and saved
in the user object of the user to be administered in Active Directory. If the option remains
inactive, the properties are read from the user mailbox and also saved in the user mailbox.

As a rule, this field will be filled in automatically after selecting the connector configuration file.

In the next step, login data for logging into an Active Directory can be specified. In a pure
Microsoft 365 installation, these fields remain empty.

1) OfficeMaster Exchange - Add Office365 Organiz.. — X
The advanced configuration is intended for maintenance services.
Please be careful changing the values.

Connection URI: |out|ook.office365.com {Microsoft intemational)| v

Connection Port: E}

Use Socket Secure Layer Connection (SSL)
[J Verify Connection Certificate

Set Default Values

< Back Finish Cancel
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1) OfficeMaster Exchange - Add Office365 Organiz...  — X

Add, remove or edit Microsoft Active Directory™ domain controllers and specify the
connection credentials for contacting the extemal organization.

&P Add... / Edit.. X

Domain Controller

Usemame: I I

Password: | |

Bk

Extended parameters are requested in the last step of the assistant. These should not be

changed. The parameters form the basis for the basic connection to Microsoft 365.

After completing the wizard for adding the organization, a new organization is added in the area
window (left side). With a click on the node Registration, the corresponding authentication to
Microsoft 365 can be carried out.

File Action View Help

OfficeMaster Administration - [OfficeMaster Exchange Administration]

&= T HE

OfficeMaster Exchange Administration
> Local Exchange Administration

T\ Authentication
@ Tools

v} Connector for BCS (FTRAINING0S-VINCIOM22)

B OfficeMaster Administration | Actions

OfficeMaster
. . View
OfficeMaster fiir MS Exchange Server @
* Help
Fe1 ra rl OfficeMaster Exchange - Administration
e | ectronic http://www ferari-electronic.de  http://forum femrari-electronic de

Add, remove or edit Microsoft Exchange Server Organizations based on On-Premised installations.
e Add... / Edit.. X

On-Premise Organization Server Administrative Account

[ Show local Exchange Server Installation

Add, remove or edit Microsoft Exchange Server Organizations based on cloud installations.
el Add... / Edit.. X

Administrative Account
benutzer8@ftraining08.on...

Cloud Organization Server
¥ Connectorfor BCS (FTRAININGOS-... outlook office365.com

The added organization can be edited or removed in the Cloud/Microsoft 365 organization area.
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g Add..

Add, remove or edit Microsoft Exchange Server Organizations based on cloud installations.
. Edit.. X

Cloud Organization Server Administrative Account
¥ Connector for BCS (FTRAININGOS-... outlook .office365.com

benutzer8@ftraining08.on...

File Action View Help

= 7w | E

OfficeMaster Exchange Administration

> @ Local Exchange Administration

v 1} Connector for BCS (FTRAINING0S-VINCIOM22)
?\ Authentication
@ Tools

OfficeMaster Administration - [OfficeMaster Exchange Administration\Connector for BCS (FTRAINING08-VINCIOM22)\Authentication]

0. Organization Login Actions

OfficeMaster

credentials to connect to Office 365 cloud server. Please provide
credentials to log on.

Usemame: |benmzer8@ﬂrainingl)8.onmiaosoﬂ .com

enable Multi Factor Authentication support

Access Type: ‘ None (Default) v ‘

=

The selected mode of organization access requires authentication
Help

Each organization added provides for an interactive registration.

Options

Since the login to Microsoft 365 is done in the background with a Powershell connection, it may
be necessary to choose a local proxy configuration. These settings depend on the configuration
of the computer environment, and questions about the need for the setting can usually be

answered by the responsible administrator. The following selection can be made:

- No proxy configuration (default)
In this case, no proxy configuration is accessed from a powershell session. This
corresponds to the command “new-PsSessionOption -ProxyAccessType None”.

- I[EConfig (Internet Explorer proxy configuration)
The IEConfig setting reads the current user’s proxy configuration that the user made in
the Internet Explorer settings. This corresponds to the command:

new-PsSessionOption -ProxyAccessType IEConfig

- WinHttpConfig (WinHttp configuration via ProxyCfg tool)
The WinHttpConfig setting uses the proxy configuration that the user created using
Microsoft's ProxyCfg.Exe tool. This corresponds to the command:
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new-PsSessionOption -ProxyAccessType WinHttpConfig

- Automatic proxy configuration
The automatic determination tries to determine the proxy configuration automatically
without further information. This does not always lead to success. This corresponds to the

command:

new-PsSessionOption -ProxyAccessType AutoDetect

- No proxy server

This option excludes the use of a proxy server and all resolutions are done locally. This

corresponds to the command:

new-PsSessionOption -ProxyAccessType NoProxyServer

After a successful login, the area nodes for organization configuration, connector configuration
and recipient configuration also become available for the cloud installations.

OfficeMaster Administration - [OfficeMaster Exchange Administration\Connector for BCS (FTRAINING08-VINCIOM22)] - a X
File Action View Help
% zmH
OfficeMaster Exchange Administration B OfficeMaster Administration Actions
> [F Local Exchange Administration OfficeMaster Garo for BCS. E“N'm -
~ I} Connector for BCS (FTRAINING0S-VINCIOM22)
ls-| Organization Configuration . View 4
3 X . - OfficeMaster for Cloud Solutions
., Connector Configuration F ﬂ Help
L Recipient Configuration |e1t ra rl OfficeMaster Exchange - Administration
& Tools electronic http://www ferrari-electronic.de  http://forum ferrari-electronic.de
Cloud Tennant Overview
Organization: ~ Connector for BCS (FTRAININGO8-VINCIOM22)
Connection: outlook.office365.com
Authentication: benutzer8@ftraining08.onmicrosoft.com
Basenode: \\VINCIOM22\FFACCESS \connectorconfiguration.cfg
Officel for Cloud ion: A
Use OfficeMaster Exchange Administration to administer On Premise-Instalations and Cloud-
Installations as well. Before configuring the target platforms it is required to authenticate via
username and password. Different target installations will be supported: v
< >

The configuration of the connector and the user can now be made. The added configuration is
visible to all user logins on the local computer.
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7.5.4. Configuration of a Microsoft 365 on-premises hybrid
Installation

OfficeMaster Administration - [OfficeMaster Exchange Administration] - m] X
Datei Aktion Ansicht 2

=@ HE

OfficeMaster Exchange Administratic | 2.0 o 0= 2 o 0 T Akti

v i Lﬂokale Exc_har_mge-Adm_lnlstra_tlon OfficeMaster OfficeMaster Exchange Administration v
is55. Organisationskonfiguration

Zz1 Connectorkonfiguration

Ansich
OfficeMaster fiir MS Exchange Server nsicht »

2., Empfangerkonfiguration H i
£z Empféng g Hilfe
ke, et Fevrari

. OfficeMaster Exchange - Administration
electronic

http://www ferrarielectronic.de  http://forum ferari-electronic .de

Entfemen, bearbeiten oder fligen Sie neue On-Premise-Organisationen der Verwaltung hinzu.
&P Hinzufigen... Bearbeiten...

On-Premise Organisation Server Administratives Konto

< >

Lokale Exchange-Verwaltung anzeigen

Entfemen, bearbeiten oder fligen Sie neue Exchange Server basierte Cloud-Installationen hinzu.
g Hinzufagen... Bearbeiten...

Cloud-Organisation Server Administratives Konto

The Microsoft 365 on-premises hybrid installation uses an on-premises Active Directory, but a
Microsoft 365 login may be required. This is decided based on the location of the custom
properties. The local administration should therefore be switched off with a tick in the local
client area. The nodes are then removed from the range window. To then make a configuration,
you now add a new organization in the Cloud/Microsoft 365 organization area.

After clicking the “Add” button, a wizard opens with the parameters of the new organization. At
this point, an adequate display name for the organization should be assigned. Likeweise, the
default user name for access to Microsoft 365 is also stored here. The password can be
specified here at this point, but would then be stored in a configuration table. This is a security
concern, so it is not recommended. The password field can remain empty. Then follows the
possibility to specify the connector configuration file.



189 7.5. Configuration

11 OfficeMaster Exchange - Add Office365 Organiz...  — X

Connector Configuration File:

[ | =
[] Active Directory / Office 365 Cloud - Hybrid Installation
Use Active Directory Basenode

Basenode Configuration File:

Use Local Active Directory
User configuration is based on Microsoft Active Directory

<Back || Net> | Cancel

1 OfficeMaster Exchange - Add Office365 Organiz...  — X

n | New Office 365 Organization |

The administrative account (Organization Administrator) is necessary to access the
organization.

Usemame: I I

Password: | |

It is not recommended to store the password. The field can be left blank.

< Back . Net> || Cancel |

After selecting the common connector configuration file that was specified during connector
installation, a window opens in which the responsible connector should be selected. Since the
file can contain several connectors, the correct connector should be selected here.

1) OfficeMaster Exchange - Add Office365 Organiz..  — X

Connector Configuration File: Connector for BCS (FTRAINING08-VINCIOM22)
|C:\PnogramData\FFUMS\fmsrv\data\exd'lange\connedorconﬁguration.dg | I |
[ Active Directory / Office 365 Cloud - Hybrid Installation

[J Use Active Directory Basenode

Basenode Configuration File:
[\\VINCIOM22\FFACCESS \connectorconfiguration.cfg [ ]

[J Use Local Active Directory
[ User configuration is based on Microsoft Active Directory

<Back ||  Net> || Cancel
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After selecting the connector, the configuration dialog should fill in automatically. If necessary,
the entered values and checked fields should be checked for correctness.

Connector configuration file

The configuration file that was specified during the connector installation is specified here.

Active Directory / Microsoft 365 Cloud hybrid installation

If this option is enabled, the administration is prepared for access to an Active Directory. This is
the default case in a hybrid installation.

OfficeMaster base node is located in Active Directory

At this point it is specified where the global user data is located. When the feature is enabled,
the data resides in an Active Directory node. If the option remains inactive, a configuration file
that houses the global user data must be specified.

Base node configuration file

If it was specified during the connector installation that the global user data is in a
configuration file, then this should be specified here. As a rule, this field will be filled in
automatically after selecting the connector configuration file.

Use local credentials for Active Directory access

As a rule, a server and an access account can be specified for access to an Active Directory.
However, if this option is enabled, the optional user data are omitted. In this case, the Windows
login account is used to access the Active Directory.

As a rule, this field will be filled in automatically after selecting the connector configuration file.

User configuration based on Active Directory entries

In order to be able to administer the OfficeMaster user properties correctly, the administration
must know how the properties are saved. If the option is enabled, the data is read and stored in
the user object of the user to be administered in the Active Directory. If the option remains
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inactive, the properties are read from the user mailbox and also saved in the user mailbox. As a
rule, this field will be filled in automatically after selecting the connector configuration file.

In the next step, login data for logging into an Active Directory can be specified.

1) OfficeMaster Exchange - Add Office365 Organiz...  — X

Add, remove or edit Microsoft Active Directory™ domain controllers and specify the
connection credentials for contacting the extemal organization.

gp Add... / Edit.. X

Domain Controller

Usemame: | |

Password: | |

<Back || Net> || Cancel

List of domain controllers

A list of domain controllers (AD directory service providers) can be stored here for the
connection to an Active Directory. Fully qualified domain names, NetBIOS names and also IP
addresses can be specified. If this list is left empty, the ADSI (Active Directory Service Interface)
tries to automatically determine the next domain controller of the current Windows logon.

Username and Password

The credentials determine the account to log in with. The user name is specified in the notation

DOMAIN\username.

Ports

Communication with the Active Directory is usually via encrypted RPC (Remote Procedure Call)
mechanisms. However, a dedicated communication port for LDAP (Lightweight Directory Access
Protocol Port 389) can also be specified. However, pure communication via LDAP is slower than
the standard connection. To use the default connection, the entry can be empty, or a zero can

be specified.

Extended parameters are requested in the last step of the assistant.
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1) OfficeMaster Exchange - Add Office365 Organiz..  — X
The advanced configuration is intended for maintenance services.
Please be careful changing the values.

Connection URI: |outlook office365.com (Microsoft intemational)| v

Connection Port: |:|

[ Use Socket Secure Layer Connection (SSL)
[] Verify Connection Certificate

| Set Default Values |

| <Bak [ || Cencd |

These should not be changed. The parameters form the basis for the basic connection to

Microsoft 365.

After completing the wizard for adding the organization, a new organization is added in the area
window (left side). With a click on the node Registration, the corresponding authentication to
Microsoft 365 can be carried out.

File Action View Help

OfficeMaster Administration - [OfficeMaster Exchange Administration]

&7 HE

OfficeMaster Exchange Administration
> Local Exchange Administration

T\ Authentication
@ Tools

v 11 Connector for BCS (FTRAININGOS-VINCIOMz2) || OfficeMaster

B OfficeMaster Administration | Actions

OfficeMaster fiir MS Exchange Server o
1 Hel
Fe1 ra rl OfficeMaster Exchange - Administration P

€ | ectronic http://www ferari-electronic.de  http://forum femrari-electronic de

Add, remove or edit Microsoft Exchange Server Organizations based on On-Premised installations.
e Add... / Edit.. X

On-Premise Organization Server Administrative Account

[ Show local Exchange Server Installation

Add, remove or edit Microsoft Exchange Server Organizations based on cloud installations.
gp Add... /" Edit.. X

Cloud Organization Server Administrative Account
1 Connector for BCS (FTRAININGOS-... outlook office 365.com benutzer8@ftraining08.on...

The added organization can be edited or removed in the Cloud/Microsoft 365 organization area.
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5’3 OfficeMaster Administration - [OfficeMaster Exchange Administration\M365 - Ferrari electronic AG\Authentication]

File Action View Help

ks ARl ? Mo

OfficeMaster Exchange Administration °‘ Organization Login Actions
~ ) M365 - Ferrari electronic AG : Authenticati .
T4 Authentication OfficeMaster
@ Tools View »
The selected mode of organization access requires 0
authentication credentials to connect to Office 365 cloud Help
server. Please provide credentials to log on.

Usemame: Iadmin@ferraridoud.onmicrosoﬂ.com

[ enable Mutti Factor Authentication support

Access Type: lNone (Default) v

The selected mode of organization access requires authentication
credentials to connect to the hybrid Microsoft Active Directory. Please
provide credentials to log on.

Usemame: IDOM\admin |

Password: | |

Each organization added provides for an interactive registration.

After a successful login, the area nodes for organization configuration, connector configuration
and recipient configuration also become available for the cloud installations.

OfficeMaster Administration - [OfficeMaster Exchange Administration\Connector for BCS (FTRAINING08-VINCIOM22)] - a X
File Action View Help
LI AN ol
%iceMaster Exchange Administration B OfficeMaster Administration Actions
> Local Exchange Administration
ConnechorforBCS!ﬂﬁNINGOﬂ- -
v 11 Connector for BCS (FTRAININGO8-VINCIOM22) | OfficsMaster :
|s*-| Organization Configuration N View 4
2., Connector Configuration Fe1 ra ri OfficeMaster for Cloud Solutions B Hep
L Recipient Configuration | t 3 OfficeMaster Exchange - Administration
& Tools electronic http://www ferrari-electronic.de  http://forum femari-electronic de

Cloud Tennant Overview

Organization: ~ Connector for BCS (FTRAININGO8-VINCIOM22)
Connection: outlook.office365.com

Authentication: benutzer8 @ftraining08.onmicrosoft.com
Basenode: \\VINCIOM22\FFACCESS \connectorconfiguration.cfg

OfficeMaster for Cloud Installations

Use OfficeMaster Exchange Administration to administer On Premise-Instaliations and Cloud-
Installations as well. Before configuring the target platforms it is required to authenticate via
username and password. Different target installations will be supported: v

The configuration of the connector and the user can now be made. The added configuration is
visible to all user logins on the local computer.
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7.5.5. Configuration of a local Exchange Server installation

The support of a local Exchange Server installation with the msxbcsgate component represents

a special case, since these functionalities are provided with the msx2kgate component. If such

a constellation should nevertheless exist, this type of installation is configured with the local
Exchange Administration. In this case, the Local Exchange Management should remain

activated.

File Action View Help

OfficeMaster Administration - [OfficeMaster Exchange Administration]

= |w B

[54] OfficeMaster Exchange Admini

v Local Exchange Administration
1s25. Organization Configuration

OfficeMaster

Sz Connector Config

2., Recipient Configuration
i Tools

U B OfficeMaster Administration

OfficeMaster fiir MS Exchange Server

-
Fe1 ra rl OfficeMaster Exchange - Administration

electronic | o fersicectronic e

http://forum femari-electronic de

gpAdd... / Edit.. X

Add, remove or edit Microsoft Exchange Server Organizations based on On-Premised installations.

On-Premise Organization Server

Administrative Account

[ Show local Exchange Server Installation

The further management procedure depends on the type of installation. When the connector
was installed, it was determined at which point global user data is saved. If this data is stored
in Active Directory, nothing needs to be added in the organization configuration. The base
nodes in the local Active Directory are automatically displayed. However, if the data is in a

configuration file, this must be added to the configuration.

File Action View Help

| nmE HE

OfficeMaster Exchange Administrati
v Local Exchange Administration
4, Organization Configurati

B Global OfficeMaster Configuration 1 Objec

OfficeMaster

OfficeMaster Administration - [OfficeMaster Exchange Administration\Local Exchange Administration\Organization Configuration]

Sz Connector Configuration
331 Recipient Configuration
@ Tools

Name Funktion

Global Configuration
4 OfficeMaster

Global Basenode (Organization)

Version

View
H Hep

| OfficeMaster

1= Delegate Control

n Help
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Once added, the global user data can be configured.

In order to configure the properties of the connector (msxbcsgate component, “Connector for
BCS"), the configuration file of the connector must be added to the connector configuration.

File Action View Help

e 7E  BE

OfficeMaster Exchange Administratic
v 4] Local Exchange Administration
ls%;. Organization Configuration
Z21 Connector Configuration
2. Recipient Configuration
i Tools

B OfficeMaster Connector Configuration

OfficeMaster Administration - [OfficeMaster Exchange Administration\Local Exchange Administration\Connector Configuration]

Actions

Connector Configuration -

s Add Cloud Configuration File
44 Configure Domain Settings

View 4
Help

Connector for UMS (VINCIMX-VINCIOM... &

I’ Set Filter
Name Function Version
gthmend MS Exchange Server Version 15.2 (Build 30922.7)
ag Frontend MS Exchange Server Version 15.2 (Build 30986.5)
é.g Mailbox Mailbox role Version 15.2 (Build 30922.7)
1 Mailbox Mailbox role Version 15.2 (Build 30986.5)
va1 VINCIMX Hub Transport role, Client Access role (CAS), Mail Version 15.2 (Build 30922.7)
[ Irrerp— Pr—— - P - P P - tm = s mme—- -
1«25, VINCIMX
Exchange Connectors
Name Local Bidgehead =~ Messaging Server
Exchange 2010-2019 Connectors
&1 Connector for UMS (VINCIMX-VINCIOM22) VINCIMX VINCIOM22
l%IConnecmrfor UMS (VINCIMX-VINCIOM) VINCIMX VINCIOM
1 Connector for UMS (VINCIMX-VINCIOM16) VINCIMX VINCIOM16

31 Delegate Configuration Control
L} Delegate Send Connector Control

Help

After adding the configuration, the connector appears in the list of Exchange connectors. The
properties can now be configured.

Configuration files added in the local Exchange configuration are only visible to the logged in

user.

Nothing needs to be done in the user properties node. The user objects are displayed
automatically and can be administered immediately.

7.5.6. Configuration of global user data

The global user data is administered in the organization configuration in the properties of the

base node.
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OfficeMaster Administration - [OfficeMaster Exchange Administration\Local Exchange Administration\Organization Configuration]

- [m] X
File Action View Help
«=| 75|
U EE SRR LR LIl S Clobal OfficeMaster Configuration ¢ | Actions
v Local Exchange Administration
%, Organization Configurati OfficeMaster : onfiguration
Sz Connector Configuration Name Funktion Version ls Add Cloud Cenfiguration File
2., Recipient Configuration Global Configuration View 4
i Tools 9 o
X Remove Del Help
Save As.. |offcMaster .
Recover... |==s Delegate Control
r ?
\s=s Delegate Control Help
ls% Add Cloud Configuration File
Refresh F5
Properties
Help
< >
< >

General settings

ol

Global Directory:
Language:

Message Layout:
HTML Template:

Options:

L';._Z’H Fax Send Defaults:

Coverpage Mode:

91 OfficeMaster - Global Organization Basenode

Global Connector Settings ~ User Defaults (FAX) User Defaults (Voice)
Global Configuration for FAX, SMS and Voice

@\\VINCIOM\FFACCESS\\

|§ German

E HTML - Layout: OfficeMaster

ﬁ <empty>

Resolve sender and recipient

Global Addressbook / Microsoft Active Directory
[] Private Contacts (User-Mail-Profile)

[] Public Folder

Global Fax-Connector-Configuration

[] Send VCARDS as additional fax page
[ Use 64k - connection (G3C) by default

[ ECM (Eror Comection Mode)

[ Enhanced Resolution (200x 200dpi)

@ Suppress on empty body text

Priority controlled send time:

Low Priority:
Normal Priority:
High Priority:

00:00:00 |2 [ asap

] asap
V] asap

00:00:00 '3
00:00:00 <

urgent
[ urgent

[ urgent

0K

Apply




197 7.5. Configuration

At this point, a global general setting can be made, to which all OfficeMaster Exchange
connectors in the organization are based.

Global directory (for cover sheets etc.)

For storing cover sheets, signature files, stationery files and caller images, a global directory
must be specified here as a UNC path that corresponds to the structure of the FFACCESS share.
This means that at this point, the connectors expect subdirectories with the names COVER
(cover sheets), LETTER (letterhead files), SIGN (signatures) and PICTURE (caller pictures).
Administration of these directories only makes sense if there are several OfficeMaster
connectors in an organization. During the installation, this directory may be changed. The
administrator has the option of specifying a base directory in coordination with the operators
of the other connectors. If the saved global settings in the local domain object option is
selected during installation, each location will have its own global directory.

Language

Here you can set whether the notifications that the connectors send to the users should be
generated in German, English, French or Spanish. This setting can be changed for each
individual user in the receiver-specific settings.

Message format

The OfficeMaster connectors are able to generate the feedback as well as the incoming
documents in various graphic adaptations. You can choose between the following internal
options:

Text only

The documents are generated as an e-mail in text format. This setting offers the greatest
compatibility with all user programs that can be connected to the Exchange Server.

HTML layout neutral, OfficeMaster and Outlook

The HTML layouts are graphical message formats. The message is generated as an HTML
message and, in the case of fax documents, contains the first page of the attached documents
as a preview.
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Since replies contain the converted attachment files individually, the first page of each
attachment object is displayed directly in the message. The format of the included preview
graphic (PNG) is independent of the selected format of the actual attachment files. The three
selectable internal layouts contain different colored designs. It is up to the administrator to
select the layout. The OfficeMaster layout is set by default.

HTML template

In addition to the internally implemented HTML format templates, special external format
templates can be loaded for further adjustments. These are generated in a special HTML/XML
variation and can be stored in the global cover directory alongside the normal RTF cover sheets.
These special template files (*HTL) store complete language sets of HTML templates and can
thus have a lasting effect on the appearance of the incoming documents and, if necessary, be
adapted to the corporate design of your own company. The HTL editor program and
documentation for the HTL script language can be found in the directory
<SERVER>\FFACCESS\Redist\Tools.

Determine sender and recipient information

The connectors can resolve incoming and outgoing phone numbers into name information. You
can specify here which databases should be searched by default.

Global Address Book / Microsoft Active Directory**

If this option is enabled, incoming phone numbers and outgoing cover sheet information are
determined from Active Directory user data or Active Directory contact data. This option actually
only ensures that internal phone numbers are resolved, since contact data is generally not
stored in the Active Directory.

Private Contacts (User Email Profile)

“Private contacts” means contact information that is stored in the sender’s mail profile or, in
the case of incoming documents, in the recipient. These are not private folder files (PST files)
that have been included in the mail profile. Only the contact folders of the e-mail profile are
meant here. It should be noted that this function can only be used successfully if the connector
component’s service account has appropriate read rights to the corresponding user’s mailbox
store.
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Public Folders

The address book resolutions of the connectors generally relate to cover sheet fields and
information of the senders of incoming and outgoing documents or messages. Since most
information from such senders is not stored as Active Directory contacts, but is available as
contact items in public folders, such an item can be used as a data source if this function is
activated. The first contact element found applies. Duplicates are delimited by the display
name. However, since no further information can be used to find the data, duplicates are not
recognized as errors. The first entry found is used here.

Note!

The specified searches in private contacts and public folders refer to real-time
searches with these settings. Such search processes can take considerable time. As
an alternative, the metacache database is available to the connectors, which works
independently of these settings.

Shipping specifications

Send business cards (VCARDS) as an additional fax page

In Microsoft® Qutlook it can be set individually whether the Outlook electronic business card is
also sent. This usual option for e-mails can also be used when sending faxes. When this option
is activated, the business card is also converted into the fax as a separate page.

Require connection at 64 kbits/s by default

The OfficeMaster Card supports the fax protocol standard G3C, which allows transmission at 64
kbit/s on ISDN lines within the framework of fax group 3. In this case, when using the
OfficeMaster Card, an attempt is first made to establish a 64 kbit connection to the remote
station and to transmit the fax or file at this speed. If this is successful, significant time and cost
savings become effective. If this attempt fails because the remote station does not have the
corresponding function, a connection must be established again using the standard speeds.
Additional time is required due to the double selection. If the option has been activated, the
individual user has the option of deactivating it for his shipping order as part of the shipping
options.
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Use ECM (Error Correction Mode).

With this option it is determined that the transmission of a fax or a file should take place using
the error correction option if the remote station supports this function. This allows error-free
transmission of the data even with low quality phone lines. The erroneous data block is
recognized and repeated. It is recommended enable the ECM function globally, as it can be
switched off by the users for each job.

Use fine resolution (200 x 200 dpi).

If this option is deactivated, all faxes are transmitted with standard resolution (200 dpi
horizontal, 100 dpi vertical). Compared to fine resolution (200x200 dpi), this saves considerable
transmission time and costs. The individual user has the option of individually specifying the
resolution for his shipping order within the scope of the shipping options.

Cover mode

By default, a cover sheet can be added to a message sent as a fax via Microsoft® Exchange. The
cover sheet or the introductory text can be influenced with the selection field.

Never suppress cover sheet

This option ensures that a cover sheet (if set up) is always sent.

Suppress cover page if message is empty

If the actual message does not contain any text, but only a file attachment, the cover sheet can
be suppressed with this option. If the Subject: field contains data, it will be ignored. Use should
be made of this if the file attachment itself contains relevant information, e.g. a cover sheet
created in a text program.

Suppress cover page if message and subject field are empty

This option suppresses a cover page only if both the message and the subject field are blank. It
should therefore be used if a cover sheet is to be generated in any case if the subject field has
been filled out, as this is typically also integrated into the cover sheet.
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Time and Urgency Control (Send by Email Priority)

With these options, the sending times of fax and SMS documents can be set based on the e-
mail priority. The “prioritized” option can be used to specify whether the documents in the
sending messaging server are also treated with priority within the queues. The “prioritized”
option should only be used with high e-mail priority, since it influences the classification of the
documents in the server queue.

User preferences (Fax)

91 OfficeMaster - Global Organization Basenode — X

Global Connector Settings User Defaults (FAX)  User Defaults (Voice) User Permissions
Initial User Defaults for FAX

L“:] csiD: [@;+49 3328 455 960 V]
Headine: | @, Feran electronic AG| v]
Coverpage Template: |, <cempty> v|
Signature: (@) <empty> v|
Biling Code: | @) <empty> v]
Lettethead Attachment: | <empty> V|

Repeat the last page (of letterhead)
Use only first page of letterhead

Letterhead Covempage: I% <empty> v |

Repeat the last page (of letterhead)
Use only first page of letterhead

Fax-Feedback: |ej positive and negative as mail with attachment v |

[ Muttistatus feedback of bulk faxes

Fax images convert to: IQ:] PDF v |

] PDF with included OCR-Information

Electron. Fax-Signature: |Q:]off v |

A user default can be created here as a global setting, which is automatically assigned to all
users of the organization who are not individually administered. This tab corresponds to the
user administration settings.



202 7.5. Configuration

Identifier

The fax identifier that appears in the header of a sent fax can be set here globally for the users
of the organization. According to the international standard, the information should be given in
the form +country code area code (without the leading 0) phone number extension number.

Example: +49 3328 455 960

By specifying the identifier individually, the sender’s fax number, including extension number, is
transmitted correctly, so that corresponding reply faxes can be addressed directly to him. If the
specification is omitted, the data that was specified when setting up the messaging server is
used.

Header

In this line, a header text can be entered globally for the users of the organization. This can, for
example, be the company name supplemented by the respective department name.

Cover sheet

A cover sheet can be activated at this point. This cover sheet is an RTF file whose name is
entered in the associated field. Cover sheets are stored in the Cover subdirectory, which is
automatically created during installation. The default setting for the cover page is inactive. If a
cover sheet has been activated, this applies to all faxes that are sent via the connectors of this
organization, unless the respective user has the right to switch off the centrally specified cover
sheet or to replace it with their own.

Note!

If Microsoft® Word was used to create a cover sheet, it is strongly recommended to
also use Microsoft® Word for the central conversion of the message. As it creates
RTF files that are used by the internal RTF converter available in Microsoft®
Exchange and are generally not correctly interpreted by Quick View Plus. This is
especially true when using more complex formats such as tables and frames in
Microsoft® Word.

Signature

The name of a signature file can be specified at this point. The default setting is inactive. The
names of all signature files saved in the SIGN subdirectory are displayed. It is also possible to



203 7.5. Configuration

enter another name. In this case, however, it must be ensured that a corresponding cover sheet
file is saved in the SIGN subdirectory before the system is used.

Note!

It is the administrator’s responsibility to correctly assign the signature file to the
individual users. The signature file must be of type RTF so that it can be integrated
into the Microsoft® Exchange message at the right place. It is created by scanning a
signature, storing it in a graphic file, e.g. of the PCX type, and then importing this
file into an RTF file as an object. The internal converter cannot convert objects into
RTF files, so Microsoft® Word or alternatives must be set as converter in this case.

Cost centre

The specification of the cost center refers to an entry in the log file generated by the messaging
server. The specification at this point only makes sense if users do not have any cost center
information and the value should be set to the set value here. A cost center is an identifier with
a maximum of 12 characters that uniquely identifies the user in the log file.

Stationery Attachment

The default setting for this field is standard, i.e. the stationery for attachments centrally set for
the fax connector is used for the user. However, he can set a different stationery. The names of
all letterhead files stored in the LETTER subdirectory are displayed in the combo box. A new
name can be entered if it is ensured that a corresponding letterhead file is saved in the LETTER
subdirectory before the system is put into operation. The use of the stationery file for multi-
page documents is controlled by the checkboxes:

a) Repeat stationery (last page) b) only use the first page of the stationery
There are four possible combinations of options:

1. Both settings off (default setting)
Each page of the letterhead is superimposed on the corresponding page of the cover
sheet or message. If the cover sheet or message has more pages than the stationery, no
deposit is made for the pages of the cover sheet or message for which there is no
stationery.

2. Repeat stationery (last page)
Each page of the letterhead is superimposed on the corresponding page of the cover
sheet or message. If the cover sheet or message has more pages than the stationery, the
last page of the stationery is deposited for the pages of the cover sheet or message for
which there is no stationery.
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3. Use only the first page of the stationery
Only the first page of the stationery is used; it is stored on the first page of the cover
sheet or message. Any subsequent pages of the stationery are not used. All subsequent
pages of the cover sheet or message are not deposited.

4. Repeat stationery (last page), only use the first page of stationery
Only the first page of the stationery is used. This page is deposited on all pages of the
cover sheet or message.

Feedback

Each user who sends a fax can receive a corresponding response as a reaction to the fax being
sent. This feedback can be configured differently according to the possibilities of the Exchange
Server. The feedback provides information as to whether the dispatch could be completed
successfully or not. If a non-delivery notification is requested, the sender receives a non-
delivery notification (Non Delivery Report, NDR) in the event that the fax could not be sent
successfully, which on the one hand describes the cause of the error and on the other hand
allows the fax number to be changed and the process to be repeated.

Positive and negative as mail

Positive and negative feedback is sent to the sender’s mailbox as an email without a converted
fax.

Positive as mail, negative as NDR

The positive feedback is sent to the mailbox as an email, while the negative feedback is
generated as a non-delivery message (NDR - Non Delivery Report). The non-delivery report has
the advantage that you can easily resend the message with a special button.

Only in the negative case, as mail

The feedback will only be sent to the mailbox as an information e-mail if it is negative.

Only in the negative case, as NDR

A response in the form of an NDR is only generated in the event of transmission errors.
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Positive and negative as mail with attachment

In the positive and negative feedback, the fax is included here as a converted attachment for
viewing.

Positive as mail with attachment, negative as NDR

Positive replies are sent as an email with a converted fax, while negative replies are sent to the
mailbox as an undeliverable message.

Only in the negative case, as mail with attachment (recommended)

Normally, after a fax has been sent, the fax connector sends a message to the user informing
them whether the fax was sent successfully or not. In the case of serial faxes in particular, it
does not make sense to also acknowledge all successful fax transmissions with a message. With
the activation of this option, acknowledgment messages are only generated in the case of
incorrect sending.

As an additional option, it can be specified that broadcast faxes (outgoing fax documents with
the same content to several recipients) are only reported with one collective confirmation for
all documents sent without errors and for all documents sent with errors instead of one
confirmation for each outgoing fax. This option does not apply to form letters, which must be
treated as individual orders. A summary of the feedback is not possible for serial letters.

File format

The standard format in which incoming fax documents are delivered as attachments is TIFF/Gé4.
However, the formats displayed in the list can also be selected. Which format should be used
for the attachments depends on which image program is to be used to display the faxes.

As an additional option, it can be specified here that an additional searchable document in PDF
format is attached to the incoming document if the text recognition function is activated on the
messaging server.

Electronic fax signature

At this point it can be specified whether outgoing fax documents should be provided with a
qualified electronic signature. Setting this signature requires that the responsible OfficeMaster
Exchange Connectors have configured a corresponding signature component. Since such
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signatures are usually only used by individuals, they should not be activated at this point, but
in the respective user settings.

User preferences (Voice)

A user specification can be created here as a global setting for the voice services, which is

automatically assigned to all users of the organization who are not individually administered.

Recording

97 OfficeMaster - Global Organization Basenode

Global Connector Settings  User Defaults (FAX) User Defaults (Voice)  User Permissions

Initial User Defaults for Voice

g
@4

Record Mode: |q§a|| calls o |
Audio Directory: |@3Geman v]
Voice Project: |@4eVoice_ProjectStart v]
Voice Picture: | <empty> v|
Message Waing: |3 No Message Waiting Indication v]

Use Read Mail Notification

Voice File Appearance: |%show

Message Behaviour: |t30fﬁoeMaster Default Voicemail

Caller Number Reading: |g3 Report czlling number before message

Callback via Inquiry: | € Enabled

Availabilty Check: | Disabled

Intial PIN: |€,0000

[J Encrypt PIN of user objects

Query Pemission 1:
Query Pemission 2:

Query Pemission 3:

oK || Cancel

| |

Apply

The recording mode distinguishes between the delivery of pure voice messages with a file
attachment (“Voice Messages Only”) and the additional delivery of a notification of the mere

call without a file attachment (“All Calls”), since the caller did not leave a message.
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Language directory

The language directory designates the language tree of the messaging server. Every messaging
server with an installed voice tree contains audio directories in which the voice-related
announcements have been stored. At the time this document went to print, you could choose
between “de” (German) and “en” (English).

Voice project

In this field the voice project of the voice server to be used is specified. The voice project
determines the behavior of the voice server for incoming messages.

Caller picture

The caller picture shows a default picture if no picture was assigned to the user or the incoming
caller could not be resolved. This image is a stored graphic file (PNG or JPG) that must be
located in the global “PICTURE” directory. The graphic should not exceed 160 x 180 pixels (width
x height).

Message waiting

The “message waiting” behavior determines the turning off of a message waiting lamp on the
user's phone. Switching on the lamp is largely determined by the messaging server
configuration and the corresponding control of the message waiting function in the PBX.
Shutdown supports three modes:

- Reset by general remote inquiry
- Reset by listening to at least one message
- Reset by listening to all messages

Show audio file

In the selection field you can specify whether the voice message file (WAV or MP3) is to be
displayed or suppressed in the message. Suppressing it would have the effect that the file can
no longer be played back over the PC speaker, but only over a remote query.
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Initial PIN

Each user who has not been administered directly uses this information from the initial PIN.
When remotely querying a user’s voice box, it makes sense to store a PIN. The initial PIN can be
stored here in order to initially adapt the function sequence to the actual behavior. If the voice
server settings are also to affect the Exchange connectors, this entry must be administered
here <empty>.

Query permission 1-3

Telephone numbers can be specified here, which immediately put the called voice box into
configuration mode when there are calls from these devices. The query permission is only
implemented for the sake of completeness. This feature should only be used for selected
pho